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CChhaapptteerr  11  ::  DDaattaabbaassee  aanndd  IItt’’ss  OObbjjeeccttss  
DDaattaabbaasseess::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
A database is a collection of information that's related to a particular subject or purpose, 
such as tracking customer orders or maintaining a music collection. If your database 
isn't stored on a computer, or only parts of it are, you may be tracking information from a 
variety of sources that you're having to coordinate and organize yourself. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using Microsoft Access, you can manage all your information from a single database 
file. Within the file, divide your data into separate storage containers called tables; view, 
add, and update table data by using online forms; find and retrieve just the data you 
want by using queries; and analyze or print data in a specific layout by using reports. 
Allow users to view, update, or analyze the database's data from the Internet or an 
intranet by creating data access pages. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

To store your data, create one table for each type of information that you track. To bring 
the data from multiple tables together in a query, form, report, or data access page, 
define relationships between the tables. 

 
 
 
 
 
 
 
 
 
 
 

  
TTaabblleess::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
A table is a collection of data about a specific topic, such as products or suppliers. 
Using a separate table for each topic means that you store that data only once, which 
makes your database more efficient, and reduces data-entry errors. 

 
 
 
 
 
 
 
 
 
 
 

Tables organize data into columns (called fields) and rows (called records). 

 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

A common field relates two tables so that Microsoft Access can bring together the data 
from the two tables for viewing, editing, or printing. 

 
 
 
 
 
 
 
 
 
 

In table Design view, you can create an entire table from scratch, or add, delete, or 
customize the fields in an existing table. 

 

 
 
 
 
 
 

In table Datasheet view, you can add, edit, view, or otherwise work with the data in a 
table. You can also display records from tables that are related to the current table by 
displaying subdatasheets within the main datasheet. With some restrictions, you can 
work with the data in subdatasheets in many of the same ways that you work with data 
in the main datasheet. 

 
 
 
 
 
 
 
 
 
 
 
 
 

  
QQuueerriieess::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  



 

 
 

You use queries to view, change, and analyze data in different ways. You can also use 
them as the source of records for forms, reports, and data access pages. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

The most common type of query is a select query. A select query retrieves data from 
one or more tables by using criteria you specify and then displays it in the order you 
want. 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

FFoorrmmss::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  



 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Most of the information in a form comes from an underlying record source. Other 
information in the form is stored in the form's design. 

 
 
 
 
 
 
 
 
 
 
 
 

You create the link between a form and its record source by using graphical objects 
called controls. The most common type of control used to display and enter data is a 
text box. 

 
 
 
 
 
 
 

 

  

RReeppoorrttss  ::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  



 

 
 

A report is an effective way to present your data in a printed format. Because you have 
control over the size and appearance of everything on a report, you can display the 
information the way you want to see it. 

 
 
 
 
 
 
 
 
 
 
 
 

Most of the information in a report comes from an underlying table, query, or SQL 
statement, which is the source of the report's data. Other information in the report is 
stored in the report's design. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

DDaattaa  aacccceessss  ppaaggeess::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  



 

 
 

A data access page is a special type of Web page designed for viewing and working 
with data from an Internet or intranet — data that is stored in a Microsoft Access 
database or a Microsoft SQL Server database. The data access page may also include 
data from other sources, such as Microsoft Excel.  

DDeessiiggnniinngg  ddiiffffeerreenntt  ttyyppeess  ooff  ddaattaa  aacccceessss  ppaaggeess  
You design data access pages in page Design view in Microsoft Access. The page is a 
separate file that is stored outside Microsoft Access; however, when you create the file, 
Microsoft Access automatically adds a shortcut to the file in the Database window. 
Designing a data access page is similar to designing forms and reports — you use a 
field list, the toolbox, controls, the Sorting and Grouping dialog box, and so on. 
However, there are some significant differences in the way that you design and interact 
with data access pages as opposed to forms and reports. How you design the page 
depends on what it will be used for:  

• Interactive reporting   This type of data access page is often used to 
consolidate and group information that is stored in the database, and then 
publish summaries of the data. For example, a page might publish the sales 
performance for each region in which you do business. Using expand indicators, 
you can go from a general summary of the information, such as a list of all the 
regions and their combined sales total, to specific details on individual sales 
within each region. While the data access page may also provide toolbar buttons 
for sorting and filtering the data, you can't edit data on this type of page. See an 
example and learn more about data access pages that group records for 
interactive reporting.  

• Data entry   This type of data access page is used to view, add, and edit 
records. Learn more about data access pages used for data entry. 

• Data analysis   This type of data access page may include a PivotTable list, 
similar to a Microsoft Access PivotTable form or Microsoft Excel PivotTable 
report, that lets you reorganize the data to analyze it in different ways. The page 
might contain a chart that you can use to analyze trends, detect patterns, and 
compare data in your database. Or the page might contain a spreadsheet in 
which you can enter and edit data, and use formulas to calculate as you do in 
Microsoft Excel. See an example of a data access page used for data analysis.  

UUssiinngg  ddaattaa  aacccceessss  ppaaggeess  iinn  IInntteerrnneett  EExxpplloorreerr  
A data access page is connected directly to a database. When users display the data 
access page in Microsoft Internet Explorer, they are viewing their own copy of the page. 
That means any filtering, sorting, and other changes they make to the way the data is 
displayed  — including changes they make within a PivotTable list or spreadsheet  — 
affect only their copy of the data access page. However, changes that they make to the 
data itself  — such as modifying values, and adding or deleting data — are stored in the 
underlying database, and therefore are available to everyone viewing the data access 
page. 



 

 
 

 
Users get Help on how to work with the page in Internet Explorer by clicking the Help 
button on the record navigation toolbar. The Help file that displays is automatically 
included with any data access page that's published with a record navigation toolbar. If 
you delete the record navigation toolbar or if you disable the Help button on it, you 
should provide instructions for those who will use the page. 
 
Note   To view and work with the data access page on the Internet or an intranet, users 
need Microsoft Internet Explorer 5 and a Microsoft Office 2000 license.  
 
UUssiinngg  ddaattaa  aacccceessss  ppaaggeess  iinn  MMiiccrroossoofftt  AAcccceessss  
You can also work with a data access page in Page view in Microsoft Access. Data 
access pages can supplement the forms and reports that you use in your database 
application. When deciding whether to design a data access page, form, or report, 
consider the tasks that you want to perform. 
 
You get Help on how to work with the page in Page view by clicking the Help button on 
the Page View toolbar to display Access Help. Clicking the Help button on a record 
navigation toolbar on the page displays Help for working with the page in Internet 
Explorer. As mentioned previously, this Help file is automatically included with any data 
access page that's published with a record navigation toolbar. You can delete the Help 
button on pages that are used only within Access, or you can modify the button to 
provide custom Help. 

MMaaccrrooss::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
WWhhaatt  iiss  aa  mmaaccrroo??  
A macro is a set of one or more actions that each perform a particular operation, such 
as opening a form or printing a report. Macros can help you to automate common tasks. 
For example, you can run a macro that prints a report when a user clicks a command 
button. 

MMoodduulleess::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
WWhhaatt  iiss  aa  mmoodduullee??  
A module is a collection of Visual Basic for Applications declarations and procedures 
that are stored together as a unit. 
 

AAbboouutt  rreellaattiioonnsshhiippss  iinn  aann  AAcccceessss  ddaattaabbaassee  

WWhhyy  ddeeffiinnee  rreellaattiioonnsshhiippss??  
After you've set up different tables for each subject in your Microsoft Access database, 
you need a way of telling Microsoft Access how to bring that information back together 



 

 
 

again. The first step in this process is to define relationships between your tables. After 
you've done that, you can create queries, forms, and reports to display information from 
several tables at once. For example, this form includes information from five tables: 
  
HHooww  ddoo  rreellaattiioonnsshhiippss  wwoorrkk??  
In the previous example, the fields in five tables must be coordinated so that they show 
information about the same order. This coordination is accomplished with relationships 
between tables. A relationship works by matching data in key fields — usually a field 
with the same name in both tables. In most cases, these matching fields are the primary 
key from one table, which provides a unique identifier for each record, and a foreign key 
in the other table. For example, employees can be associated with orders they're 
responsible for by creating a relationship between the Employees table and the Orders 
table using the EmployeeID fields. 
  
AA  oonnee--ttoo--mmaannyy  rreellaattiioonnsshhiipp  
A one-to-many relationship is the most common type of relationship. In a one-to-many 
relationship, a record in Table A can have many matching records in Table B, but a 
record in Table B has only one matching record in Table A. 
  
AA  mmaannyy--ttoo--mmaannyy  rreellaattiioonnsshhiipp  
In a many-to-many relationship, a record in Table A can have many matching records in 
Table B, and a record in Table B can have many matching records in Table A. This type 
of relationship is only possible by defining a third table (called a junction table) whose 
primary key consists of two fields — the foreign keys from both Tables A and B. A 
many-to-many relationship is really two one-to-many relationships with a third table. For 
example, the Orders table and the Products table have a many-to-many relationship 
that's defined by creating two one-to-many relationships to the Order Details table. 
 
AA  oonnee--ttoo--oonnee  rreellaattiioonnsshhiipp  
In a one-to-one relationship, each record in Table A can have only one matching record 
in Table B, and each record in Table B can have only one matching record in Table A. 
This type of relationship is not common, because most information related in this way 
would be in one table. You might use a one-to-one relationship to divide a table with 
many fields, to isolate part of a table for security reasons, or to store information that 
applies only to a subset of the main table. For example, you might want to create a table 
to track employees participating in a fundraising soccer game. 
DDeeffiinniinngg  rreellaattiioonnsshhiippss  
You define a relationship by adding the tables that you want to relate to the 
Relationships window, and then dragging the key field from one table and dropping it on 
the key field in the other table. You can also define relationships by using the keyboard. 
 
The kind of relationship that Microsoft Access creates depends on how the related fields 
are defined:  



 

 
 

• A one-to-many relationship is created if only one of the related fields is a primary 
key or has a unique index. 

• A one-to-one relationship is created if both of the related fields are primary keys 
or have unique indexes. 

• A many-to-many relationship is really two one-to-many relationships with a third 
table whose primary key consists of two fields — the foreign keys from the two 
other tables.  

Note   If you drag a field that isn't a primary key and doesn't have a unique index to 
another field that isn't a primary key and doesn't have a unique index, an indeterminate 
relationship is created. In queries containing tables with an indeterminate relationship, 
Microsoft Access displays a default join line between the tables, but referential integrity 
won't be enforced, and there's no guarantee that records are unique in either table. 
 

CCrreeaattee  aa  ddaattaabbaassee  

CCrreeaattee  aa  ddaattaabbaassee  uussiinngg  tthhee  DDaattaabbaassee  WWiizzaarrdd  

1. When Microsoft Access first starts up, a dialog box is automatically displayed 
with options to create a new database or open an existing one. If this dialog box 
is displayed, click Database Wizard, and then click OK.  

If you have already opened a database or closed the dialog box that displays 

when Microsoft Access starts up, click New Database on the toolbar.  

2. On the Databases tab, double-click the icon for the kind of database you want to 
create. 

3. Specify a name and location for the database. 

4. Click Create to start defining your new database.  

 
CCrreeaattee  aa  ddaattaabbaassee  wwiitthhoouutt  uussiinngg  aa  wwiizzaarrdd  

1. When Microsoft Access first starts up, a dialog box is automatically displayed 
with options to create a new database or open an existing one. If this dialog box 
is displayed, click Blank Database, and then click OK.  



 

 
 

If you have already opened a database or closed the dialog box that displays 

when Microsoft Access starts up, click New Database on the toolbar, and 
then double-click the Blank Database icon on the General tab.  

2. Specify a name and location for the database and click Create.  

After you create a blank database, you must perform additional steps to define the 
objects that will make up your database. 
 
TThhee  ddiiffffeerreennccee  bbeettwweeeenn  iimmppoorrttiinngg  aanndd  lliinnkkiinngg  
Microsoft Access provides two choices for using data from an external data source. You 
can:  

• Import the data into a new Microsoft Access table, which is a way to convert data 
from a different format and copy it into Microsoft Access. You can also import 
database objects into the current Microsoft Access database or Microsoft Access 
project. 

• Link the data, which is a way to connect to data from another application without 
importing it so that you can view and edit the data in both the original application 
and in an Access database. (In previous versions of Microsoft Access, this 
process was referred to as attaching.)  

IImmppoorrttiinngg  ddaattaa  
Importing data creates a copy of its information in a new table in your Access database 
or Access project. The source table or file is not altered in this process.  
When importing data, you can't append data to existing tables (except when importing 
spreadsheet or text files). However, once you have imported a table, in an Access 
database you can perform an append query or in an Access project you can use a 
stored procedure to add the table's data to another table. 
You can also import database objects other than tables, such as forms or reports, from 
another Access database or Access project. 
  
LLiinnkkiinngg  ddaattaa  
In an Access database, linking data enables you to read and in most cases, update data 
in the external data source without importing. The external data source's format is not 
altered so that you can continue to use the file with the program that originally created it, 
but you can add, delete, or edit its data by using Microsoft Access as well. You can link 
a table only in an Access database, not an Access project. 
Microsoft Access uses different icons to represent linked tables and tables that are 
stored in the current database. If you delete the icon for a linked table, you delete the 
link to the table, not the external table itself. 
  
WWaayyss  ttoo  iimmppoorrtt  aanndd  lliinnkk  ddaattaa  
There are two ways to import or link data:  



 

 
 

• Open or create an Access database or create an Access project to contain the 
imported tables, or linked tables in the case of an Access database, and then use 
the Import or Link Tables commands on the Get External submenu of the File 
menu. 

• In an Access database, Open the external database directly, including dBASE, 
Paradox, Exchange, and any ODBC data source, including Microsoft SQL Server 
and Microsoft Visual FoxPro. Microsoft Access will automatically create a new 
Access database in the same folder as the external database and add links to 
each table in the external database.  

UUssiinngg  OODDBBCC  ddaattaa  ssoouurrcceess  
You can import or link data from ODBC databases, such as Microsoft SQL Server and 
Visual FoxPro, as well as other programs that provide drivers compliant with ODBC 
Level 1 to access their data files. 
 
UUnnssuuppppoorrtteedd  pprrooggrraammss  
If you have a program whose data is not stored in one of the supported external 
database or file formats, but the program can export, convert, or save its data as one of 
these formats, then you can import that data. Additionally, when you import or link an 
external database format, such as dBASE or Paradox, Access usually preserves 
indexes. For example, you can't import or link a Microsoft Works database directly, but 
you can export the data from Microsoft Works to a dBASE IV (.dbf) database file and 
then import that data into Microsoft Access to preserve field names and indexes.  
In general, most unsupported programs, even those on different operating systems, can 
export data to a delimited or fixed-width text file, which you can then import or link from 
Microsoft Access, although you won't preserve indexes. 
  
AAuuttoommaattiinngg  iimmppoorrtt  ooppeerraattiioonnss  
To make frequent import operations more convenient, you can automate them by 
creating a macro or creating a Visual Basic for Applications procedure. This is useful, 
for example, when you import data on a regular schedule or you have unusual or 
complex requirement for importing data. 
 
 
AAbboouutt  ddeessiiggnniinngg  aa  ddaattaabbaassee  

Before you use Microsoft Access to actually build the tables, forms, and other objects 
that will make up your database, it is important to take time to design your database. 
Whether you are using a Microsoft Access database or a Microsoft Access project, 
good database design is the keystone to creating a database that does what you want it 
to do effectively, accurately, and efficiently.  

11    DDeetteerrmmiinnee  tthhee  ppuurrppoossee  ooff  yyoouurr  ddaattaabbaassee  
The first step in designing a database is to determine its purpose and how it's to be 
used. You need to know what information you want from the database. From that, you 



 

 
 

can determine what subjects you need to store facts about (the tables) and what facts 
you need to store about each subject (the fields in the tables). 
Talk to people who will use the database. Brainstorm about the questions you and they 
would like the database to answer. Sketch out the reports you'd like it to produce. 
Gather the forms you currently use to record your data. Examine well-designed 
databases similar to the one you are designing. 
  
22    DDeetteerrmmiinnee  tthhee  ttaabblleess  yyoouu  nneeeedd  
Determining the tables can be the trickiest step in the database design process. That's 
because the results you want from your database — the reports you want to print, the 
forms you want to use, the questions you want answered — don't necessarily provide 
clues about the structure of the tables that produce them. 
You don't need to design your tables using Microsoft Access. In fact, it may be better to 
sketch out and rework your design on paper first. When you design your tables, divide 
up pieces of information by keeping these fundamental design principles in mind:  

• A table should not contain duplicate information, and information should not be 
duplicated between tables. In this respect, a table in a relational database differs 
from a table in a flat-file application such as a spreadsheet.  

When each piece of information is stored in only one table, you update it in one 
place. This is more efficient, and it also eliminates the possibility of duplicate 
entries that contain different information. For example, you would want to store 
each customer address and phone number only once, in one table.  

• Each table should contain information about one subject.  

When each table contains facts about only one subject, you can maintain 
information about each subject independently from other subjects. For example, 
you would store customer addresses in a different table from the customers' 
orders, so that you could delete one order and still maintain the customer 
information.  

33    DDeetteerrmmiinnee  tthhee  ffiieellddss  yyoouu  nneeeedd  
Each table contains information about the same subject, and each field in a table 
contains individual facts about the table's subject. For example, a customer table may 
include company name, address, city, state, and phone number fields. When sketching 
out the fields for each table, keep these tips in mind:  

• Relate each field directly to the subject of the table. 

• Don't include derived or calculated data (data that is the result of an expression). 

• Include all the information you need. 



 

 
 

• Store information in its smallest logical parts (for example, First Name and Last 
Name, rather than Name).  

44    IIddeennttiiffyy  tthhee  ffiieelldd  oorr  ffiieellddss  wwiitthh  uunniiqquuee  vvaalluueess  iinn  eeaacchh  rreeccoorrdd  
In order for Microsoft Access to connect information stored in separate tables — for 
example, to connect a customer with all the customer's orders — each table in your 
database must include a field or set of fields that uniquely identifies each individual 
record in the table. Such a field or set of fields is called a primary key. 
  
55    DDeetteerrmmiinnee  tthhee  rreellaattiioonnsshhiippss  bbeettwweeeenn  ttaabblleess  
Now that you've divided your information into tables and identified primary key fields, 
you need a way to tell Microsoft Access how to bring related information back together 
again in meaningful ways. To do this, you define relationships between tables in a 
Microsoft Access database. 
 
You may find it useful to view the relationships in an existing well-designed database. 
For example, open the Northwind sample database and click Relationships on the 
Tools menu to see the relationships between its tables. Or you may want to view the 
relationships in the Northwind sample Access project and Microsoft SQL Server 
database. 
  
66    RReeffiinnee  yyoouurr  ddeessiiggnn  
After you have designed the tables, fields, and relationships you need, it's time to study 
the design and detect any flaws that might remain. It is easier to change your database 
design now than it will be after you have filled the tables with data. 
Use Microsoft Access to create your tables, specify relationships between the tables, 
and enter enough sample data in your tables so you can test your design. To test the 
relationships in your database, see if you can create queries to get the answers you 
want. Create rough drafts of your forms and reports and see if they show the data you 
expect. Look for unnecessary duplications of data and eliminate them. If you find 
problems, refine the design. 
  
77    EEnntteerr  ddaattaa  aanndd  ccrreeaattee  ootthheerr  ddaattaabbaassee  oobbjjeeccttss  
When you are satisfied that the table structures meet the design principles described 
here, then it's time to go ahead and add all your existing data to the tables. You can 
then create any queries, forms, reports, data access pages, macros, and modules that 
you may want. 
  
88    UUssee  MMiiccrroossoofftt  AAcccceessss  aannaallyyssiiss  ttoooollss  
Microsoft Access includes two tools that can help you to refine the design of your 
Microsoft Access database. The Table Analyzer Wizard can analyze the design of one 
table at a time, can propose new table structures and relationships if appropriate, and 
can divide a table into new related tables if that makes sense  
 



 

 
 

The Performance Analyzer can analyze your entire database and make 
recommendations and suggestions for improving it. The wizard can also implement 
these recommendations and suggestions. For information on using the Performance  
 
For additional ideas on designing a Microsoft Access database, you may want to look at 
the design of the Northwind sample database or of one of the databases that you can 
create with the Database Wizard. For information on using the Database Wizard, click  
 
DDiissppllaayy  oorr  cchhaannggee  tthhee  ggeenneerraall  pprrooppeerrttiieess  ooff  aa  ddaattaabbaassee  oobbjjeecctt  

1. Under Objects in the Database window, click the type of database object whose 
properties you want to change. 

2. Click the database object whose properties you want to change. 

3. Click Properties on the toolbar.  

Notes  

• The content of the Description field in the Properties dialog box is what is 
displayed under Description in the Database window when you click Details on 
the toolbar. 

• In a Microsoft Access project, you cannot change the properties of a table, view, 
database diagram, or stored procedure because these objects reside in the 
Microsoft SQL Server database. However, you can change the properties of a 
form, report, macro, or module, because these objects reside in the Access 
project itself, not in the Microsoft SQL Server database; you can also change the 
properties of a data access page.  

RReennaammee  aann  AAcccceessss  ddaattaabbaassee  oorr  AAcccceessss  pprroojjeecctt  

1. Close the Microsoft Access database or Microsoft Access project. In a multiuser 
environment, confirm that all users have closed the Access database. 

2. Click Open on the toolbar. 

3. In the Open dialog box, locate the Access database or Access project you want 
to rename, and then right-click the file. 

4. On the shortcut menu, click Rename. 

5. Type the new name. Include the .mdb or .adp extension only if you've set up 
Microsoft Windows to display MS-DOS file extensions. Press ENTER.  

The file name can be up to 255 characters, including spaces.  



 

 
 

Note   You can also rename an Access database or Access project from outside 
Access. Close the file, right-click the file in Windows Explorer or My Computer, and then 
click Rename on the shortcut menu. 
 
DDeelleettee  aann  AAcccceessss  ddaattaabbaassee  oorr  AAcccceessss  pprroojjeecctt  

1. Close the Microsoft Access database or Microsoft Access project. In a multiuser 
environment, confirm that all users have closed the Access database. 

2. Click Open on the toolbar. 

3. In the Open dialog box, locate the Access database or Access project you want 
to delete, and then right-click the file. 

4. On the shortcut menu, click Delete.  

Notes  

• If you want to get your file back, look in the Recycle Bin. Your deleted file will 
remain in the bin until you empty it. 

• When you delete an Access database or Access project that includes data 
access pages, you are not deleting the page HTML files. 

• When you delete an Access project, you are not deleting the Microsoft SQL 
Server database to which the Access project is connected. 

• You can also delete an Access database or Access project from outside Access. 
Close the file, right-click the file in Windows Explorer or My Computer, and then 
click Delete on the shortcut menu.  

CCooppyy  oorr  mmoovvee  aann  AAcccceessss  ddaattaabbaassee  oorr  AAcccceessss  pprroojjeecctt  

1. Close the Microsoft Access database or Microsoft Access project. In a multiuser 
environment, confirm that all users have closed the Access database. 

2. In My Computer or Windows Explorer, find the database (.mdb) or project (.adp) 
file and then click it.  

To select more than one file to copy or move, hold down the CTRL key and click 
each file.  

3. To copy the file, click Copy on the Edit menu.  

To move the file, click Cut on the Edit menu.  

4. Open the folder or disk where you want to put the file. 



 

 
 

5. On the Edit menu, click Paste.  

To undo the paste operation, click Undo Copy or Undo Move on the Edit menu.  

Notes    

• When you copy or move an Access database or Access project that contains 
links to data access pages, Access leaves the pages in their original folder and 
automatically updates links to the pages so they continue to work as before. 

• When you copy or move an Access project file, you are not copying or moving 
the Microsoft SQL Server database to which the Access project is connected.  

Tip   If the destination where you're placing the file is already visible, you can quickly 
move the file by dragging it to the new destination, or you can copy the file by holding 
down the CTRL key while you drag the file. 
 

Important    

• If you rename, delete, copy or move a Microsoft Access database, and another 
database includes links to objects in that database, use the Linked Table 
Manager in the other database to update the link information. Otherwise, Access 
will produce an error when you try to use those linked objects in the other 
database.  

• Links to a data access page need to be updated only if you rename, delete, or 
move the data access page .html files.  

 
OOppeenn  aa  MMiiccrroossoofftt  AAcccceessss  ddaattaabbaassee  

1. On the File menu, click Open . 

2. Click a shortcut in the Places Bar, or, in the Look In box, click the drive or folder 
that contains the Microsoft Access database that you want. 

3. In the folder list, double-click folders until you open the folder that contains the 
database.  

If you can't find the database that you want to open, click Tools and then click 
Find In the Find dialog box, enter additional search criteria. For Help on an 

option, click the question mark and then click the option. Learn more about 
searching for files.  



 

 
 

4. Do one of the following:  
o To open the database for shared access in a multiuser environment, so 

you and other users can read and write to the database, click Open. 

o To open the database with exclusive access, click the arrow next to the 
Open button, and then click Open Exclusive. 

o To open the database for read-only access so that you can view it but 
cannot edit it, click the arrow next to the Open button, and then click Open 
Read–Only.  

o To open the database for read-only access and also prevent other users 
from opening it, click the arrow next to the Open button, and then click 
Open Exclusive Read Only.  

For Help on an option in the dialog box, click the question mark , and then 
click the item.  

Notes  

• To view in the Open dialog box a list of shortcuts to databases that you have 
opened previously, click History on the Places Bar. 

• To open one of the last several databases you had open, click the file name at 
the bottom of the File menu. Microsoft Access opens the database with the same 
option settings it had the last time you opened it. If the list of recently used files 
isn’t displayed, click Options on the Tools menu, click the General tab, and then 
select the Recently used file list check box. 

• Microsoft Access can automatically create a shortcut in the Favorites folder, 
which you can use to open the database directly the next time. For more 

information, click . For information on creating a shortcut manually, click 
. 

• You can directly open a data file in an external file format such as dBASE, 
Paradox, Microsoft Exchange, Microsoft Excel; you can also directly open any 
ODBC data source, such as Microsoft SQL Server or Microsoft FoxPro. Microsoft 
Access automatically creates a new Access database in the same folder as the 
data file and adds links to each table in the external database. Learn more about 
importing and linking data.  

BBaacckk  uupp  aa  ddaattaabbaassee  

1. Close the database. If you are in a multiuser environment, confirm that all users 
have closed the database. 



 

 
 

2. Using the Windows Explorer, My Computer, Microsoft Backup, the MS-DOS 
copy command, or other backup software, copy the database file (an .mdb file) 
to a backup medium of your choice.  

Notes    

• If you are backing up to a floppy disk and your database file exceeds the size of 
the disk, you cannot use Windows Explorer or My Computer to back up your 
database; you must use Microsoft Backup or backup software so that you can 
copy the file over more than one disk. 

• You should also create a backup of the workgroup information file. If this file is 
lost or damaged, you won't be able to start Microsoft Access until you restore or 
rebuild it. 

• You can back up individual database objects by creating a blank database and 
then importing the objects you want from the original database. 

• You can't use the FileCopy statement in a second instance of Microsoft Access 
to back up a database you have open in the first instance of Microsoft Access.  

RReessttoorree  aa  ddaattaabbaassee  ffrroomm  aa  bbaacckkuupp  ccooppyy  

• Depending on what method was used originally to produce the backup copy, use 
the Windows Explorer, My Computer, Microsoft Backup, MS-DOS copy or 
restore commands, or other backup software to copy the backup database file to 
your database folder.  

Caution   If the existing database file in the database folder and the backup copy have 
the same name, restoring the backup copy may replace the existing database file. If you 
want to save the existing file, rename it before you copy the backup file. 

For information on how to rename a database file, click . 

  

  

  



 

 
 

CChhaapptteerr  22  ::  TTaabblleess  
CCrreeaattee  aa  ttaabbllee  
Microsoft Access provides two ways to create a table. You can create a blank (empty) 
table for entering your own data, or you can create a table using existing data from 
another source. 
 
CCrreeaattee  aallll  ttaabblleess,,  ffoorrmmss,,  aanndd  rreeppoorrttss  ffoorr  aa  ddaattaabbaassee  iinn  oonnee  ooppeerraattiioonn  

• Use the Database Wizard to create in one operation all the tables, forms, and 
reports required for an entire database. The Database Wizard creates a new 
database; it can't be used to add new tables, forms, or reports to an existing 
database.  

CCrreeaattee  aa  ttaabbllee  bbyy  uussiinngg  tthhee  TTaabbllee  WWiizzaarrdd  

1. If you haven't already done so, switch to the Database window. You can press 
F11 to switch to the Database window from any other window. 

2. Click Tables under Objects, and then click New on the Database window 
toolbar. 

3. Double-click Table Wizard. 

4. Follow the directions in the Table Wizard dialog boxes.  

Note   If you want to modify or extend the resulting table, you can do so in Design view 
when you have finished using the Table Wizard. 
CCrreeaattee  aa  ttaabbllee  bbyy  eenntteerriinngg  ddaattaa  iinn  aa  ddaattaasshheeeett  

1. If you haven't already done so, switch to the Database window. You can press 
F11 to switch to the Database window from any other window. 

2. Click Tables under Objects, and then click New on the Database window 
toolbar. 

3. Double-click Datasheet View. A blank datasheet is displayed. The default 
column names are Field1, Field2, and so on. 

4. Rename each column you will use: double-click the column name, type a name 
for the column following Microsoft Access object-naming rules and then press 
ENTER. 



 

 
 

5. You can insert additional columns at any time: click in the column to the right of 
where you want to insert a new column, and then on the Insert menu, click 
Column. Rename the column as described in step 4. 

6. Enter your data in the datasheet.  

Enter each kind of data in its own column (each column is called a field in 
Microsoft Access). For example, if you are entering names, enter the first name 
in its own column and the last name in a separate column. If you are entering 
dates, times, or numbers, enter them in a consistent format so that Microsoft 
Access can create an appropriate data type and display format for the column. 
Any columns you leave empty will be deleted when you save the datasheet.  

7. When you've added data to all the columns you want to use, click Save on the 
toolbar to save your datasheet. 

8. Microsoft Access asks you if you want to create a primary key. If you haven't 
entered data that can be used to uniquely identify each row in your table, such as 
part numbers or ID numbers, it's recommended that you click Yes. If you have 
entered data that can uniquely identify each row, you can specify this field as 
your primary key.  

Microsoft Access will assign data types to each field (column) based on the kind of data 
you entered. If you want to customize a field's definition further — for example, to 
change its data type, or define a validation rule, use Design view. 
 
Note   In addition to renaming and inserting columns, you can delete or reorder columns 
at any time, before or after saving your new datasheet. For information on deleting a 
column, 
 
CCrreeaattee  aa  ttaabbllee  oonn  mmyy  oowwnn  
You can use the steps in this topic to guide you through creating a table from start to 
finish. You’ll use many of these steps in creating every table. The others you’ll use when 
you design a table to contain a particular type of data or define how a field appears. You 
need to use only the steps that are relevant to the type of data or field definitions 
specific to the table that you’re creating. For other tasks related to creating tables, ask 
the Answer Wizard. 
 
CCrreeaattee  aa  nneeww  ttaabbllee  ffrroomm  eexxiissttiinngg  ddaattaa  
Microsoft Access provides two ways to create a table from existing data:  

• You can import or link data from another Microsoft Access database or data in a 
variety of file formats from other programs. 

• You can perform a make-table query to create a table based on data in a current 
table. For example, you can use make-table queries to archive old records, to 
make backup copies of your tables, to select a group of records to export to 



 

 
 

another database, or to use as a basis for reports that display data from a 
specific time.  

OOppeenn  aa  ttaabbllee  

1. In the Database window, click Tables under Objects. 

2. Click the name of the table you want to open. 

3. To open the table in Design view, click Design on the Database window toolbar.  

To open the table in Datasheet view, click Open on the Database window 
toolbar.  

Notes    

• After you've opened a table, you can easily switch between the two views by 
clicking the View button on the toolbar. 

• For information about creating a shortcut that opens a table directly from the 
desktop or a folder,  

OOppttiimmiizzee  ggeenneerraall  ttaabbllee  ppeerrffoorrmmaannccee  
There are several things you can do to optimize your tables. In addition to the following 
tips, you can use the Performance Analyzer to analyze specific tables in your database.  
 
Design tables without redundant data   A well-designed database is a prerequisite for 
fast data retrieval and updates. If existing tables contain redundant data, you can use 
the Table Analyzer Wizard to split your tables into related tables to store your data more  
 
Choose appropriate data types for fields   You can save space in your database and 
improve join operations by choosing appropriate data types for fields. When defining a 
field, choose the smallest data type or field size that's appropriate for the data in the  
 
Create indexes for fields you sort, join, or set criteria for   You can make dramatic 
improvements in the speed of queries by indexing fields on both sides of joins, or by 
creating a relationship between those fields and indexing any field used to set criteria 
for the query. Finding records through the Find dialog box is also much faster when 
searching an indexed field. 
Indexes aren't appropriate in all cases, however. Indexes add to the size of the .mdb 
file, reduce concurrency (the ability of more than one user to modify a page at the same 
time) in multiuser applications, and decrease performance when you update data in 
fields that are indexed, or when you add or delete records. It's a good idea to 
experiment to determine which fields should be indexed. Adding an index may speed up 
a query one second, but slow down adding a row of data by two seconds and cause 
locking problems. Or it may add negligible gains depending on which other fields are 



 

 
 

indexed. For example, adding an index to a PostalCode field may provide very little 
performance gain if a CompanyName field and LastName field in the table are already 
indexed. Regardless of the types of queries you create, you should only index fields that 
have mostly unique values. 
  
SSpplliitt  aa  ttaabbllee  iinnttoo  rreellaatteedd  ttaabblleess  uussiinngg  tthhee  TTaabbllee  AAnnaallyyzzeerr  WWiizzaarrdd  
If your Microsoft Access database has a table that contains duplicate information in one 
or more fields, you can use the Table Analyzer Wizard to split the data into related 
tables so that you can store data more efficiently. This process is called normalization.  

1. On the Tools menu, point to Analyze, and then click Table. 

2. Follow the instructions in the steps of the Table Analyzer Wizard.  

You can either specify the tables that you want the wizard to create or have the wizard 
normalize your table for you. After you have defined the proposed new tables, the 
wizard helps you to reconcile data that the original table repeated inconsistently. In the 
last step, you can create a query to view all the information from the split tables in a 
single datasheet that is similar to your original table. 
  
DDeeffiinnee  vvaalliiddaattiioonn  rruulleess  ttoo  ccoonnttrrooll  wwhheenn  aa  rreeccoorrdd  ccaann  bbee  ssaavveedd  

1. Open a table in Design view. 

2. Click Properties on the toolbar to display the table's property sheet. 

3. In the ValidationRule property box, type the validation rule. Or click the Build 
button to create the validation rule using the Expression Builder.  

For example, you could define the validation expression 
"[RequiredDate]<=[OrderDate]+30" to make sure that the date entered into the 
RequiredDate field is within 30 days of the date in the OrderDate field.  

4. In the ValidationText property box, type the message that you want Microsoft 
Access to display when the rule is broken.  

For example, for the validation expression "[RequiredDate]<=[OrderDate]+30," 
you could enter "The required date must be within 30 days of the order date."  

If you set a validation rule in a table that contains data, Microsoft Access will ask 
if you want to apply the new rule to existing data when you save the table.  

Notes  



 

 
 

• You can specify only one validation expression for a table. However, if you want 
to specify more than one rule, you can combine expressions for the 
ValidationRule property setting with the And operator. 

• Record validation rules are enforced whenever you add or edit data, whether it is 
through table Datasheet view, a form bound to the table, an append query, an 
update query, Visual Basic for Applications code, or by importing data from 
another table. 

• You can test to see if the data in a table meets validation rules by right-clicking 
the title bar of table Design view, and then by clicking Test Validation Rules.  

AAdddd  aa  ffiieelldd  ttoo  aa  ttaabbllee  iinn  DDeessiiggnn  vviieeww  

1. Open the table in Design view. 

2. To insert the field within the table, click in the row below where you want to add 
the field, and then click Insert Rows on the toolbar.  

To add the field to the end of the table, click in the first blank row.  

3. Click in the Field Name column and type the name for the field, following 
Microsoft Access object-naming rules. 

4. In the Data Type column, keep the default (Text); or click in the Data Type 
column, click the arrow, and select the data type you want.  

5. In the Description column, type a description of the information this field will 
contain. This description is displayed on the status bar when adding data to the 
field and is included in the Object Definition of the table. The description is 
optional. 

6. If you want, set field properties for the field in the bottom part of the window.  

Note   If this is a linked table, you can't add a new field in the current database. If the 
linked table is a Microsoft Access table, you must open its source database to add a 
field. If the linked table is from another application, you must open the source file with 
that application to add a field. 
 
WWhhaatt  ddaattaa  ttyyppee  sshhoouulldd  II  uussee  ffoorr  aa  ffiieelldd  iinn  mmyy  ttaabbllee??  
Decide what kind of data type to use for a field based on these considerations:  

• What kind of values do you want to allow in the field? For example, you can't 
store text in a field with a Number data type. 

• How much storage space do you want to use for values in the field? 



 

 
 

• What types of operations do you want to perform on the values in the field? For 
example, Microsoft Access can sum values in Number or Currency fields, but not 
values in Text or OLE Object fields. 

• Do you want to sort or index a field? OLE Object fields can't be sorted or 
indexed. 

• Do you want to use a field to group records in queries or reports? OLE Object 
fields can't be used to group records. 

• How do you want to sort values in a field? In a Text field, numbers sort as strings 
of characters (1, 10, 100, 2, 20, 200, and so on), not as numeric values. Use a 
Number or Currency field to sort numbers as numeric values. Also, many date 
formats will not sort properly if entered in a Text field. Use a Date/Time field to 
ensure proper sorting. 

FFiieelldd  ddaattaa  ttyyppeess  aavvaaiillaabbllee  iinn  MMiiccrroossoofftt  AAcccceessss  
The following table summarizes all the field data types available in Microsoft Access, 
their uses, and their storage sizes. 

Data type Use for Size 

Text Text or combinations of text and 
numbers, such as addresses. Also 
numbers that do not require 
calculations, such as phone 
numbers, part numbers, or postal 
codes.  

For more information on defining a 

Text field, click . 

Up to 255 characters.  

Microsoft Access only stores the 
characters entered in a field; it 
does not store space characters 
for unused positions in a Text 
field. To control the maximum 
number of characters that can 
be entered, set the FieldSize 
property. 

Memo Lengthy text and numbers, such as 
notes or descriptions.  

For more information on defining a 

Memo field, click . 

Up to 64,000 characters. 

Number Numeric data to be used for 
mathematical calculations, except 
calculations involving money (use 
Currency type). Set the FieldSize 
property to define the specific 
Number type.  

For more information on defining a

1, 2, 4, or 8 bytes. 16 bytes for 
Replication ID (GUID) only.  

For more information on 
changing Number field sizes, 

click . 



 

 
 

Number field, click . 

Date/Time Dates and times.  

For more information on defining a 

Date/Time field, click . 

8 bytes. 

Currency Currency values. Use the Currency 
data type to prevent rounding off 
during calculations. Accurate to 15 
digits to the left of the decimal point 
and 4 digits to the right.  

For more information on defining a 

Currency field, click . 

8 bytes. 

AutoNumber Unique sequential (incrementing by 
1) or random numbers 
automatically inserted when a 
record is added.  

For more information on defining 

an AutoNumber field, click . 

4 bytes. 16 bytes for Replication 
ID (GUID) only. 

Yes/No Fields that will contain only one of 
two values, such as Yes/No, 
True/False, On/Off.  

For more information on defining a 

Yes/No field, click . 

1 bit. 

OLE Object Objects (such as Microsoft Word 
documents, Microsoft Excel 
spreadsheets, pictures, sounds, or 
other binary data), created in other 
programs using the OLE protocol, 
that can be linked to or embedded 
in a Microsoft Access table. You 
must use a bound object frame in a 
form or report to display the OLE 
object.  

Up to 1 gigabyte (limited by disk 
space). 



 

 
 

For more information on defining 

an OLE Object field, click . 

Hyperlink Field that will store hyperlinks. A 
hyperlink can be a UNC path or a 
URL.  

For more information on defining a 

Hyperlink field, click . 

Up to 64,000 characters. 

Lookup Wizard Creates a field that allows you to 
choose a value from another table 
or from a list of values using a 
combo box. Choosing this option in 
the data type list starts a wizard to 
define this for you.  

For more information on defining a 

Lookup field, click . 

The same size as the primary 
key field that is also the Lookup 
field; typically 4 bytes. 

 
Note   Number, Date/Time, Currency, and Yes/No data types provide predefined 
display formats. Set the Format property to choose from the formats available for each 
data type. You can also create a custom display format for all data types except the 
OLE Object data type. For information on how to define a custom display format,  
 
 
MMoovvee  aa  ffiieelldd  iinn  ttaabbllee  DDeessiiggnn  vviieeww  

1. Open the table in Design view. 

2. Select the field(s) you want to move.  

To select one field, click that field's row selector.  

To select a group of fields, drag through the row selectors of those fields.  

3. Click and hold down the mouse button in the row selector again. Microsoft 
Access displays a thin horizontal bar just above the last selected row. 

4. Drag the horizontal bar to the row just below where you want to move the fields.  



 

 
 

Note   Changing field order in table Design view changes the order in which fields are 
stored in the table and also changes the column order in the table's datasheet. For 
information on how to change only the datasheet's column order,  
 
CChhaannggee  aa  ffiieelldd  nnaammee  iinn  aa  ttaabbllee  
You can change a field name at any time without affecting the data in the field. Microsoft 
Access automatically fixes common side effects that occur when you make changes to 
a field name. For more information on how Microsoft Access updates field names,  
 
DDeelleettee  aa  ffiieelldd  ffrroomm  aa  ttaabbllee  iinn  DDeessiiggnn  vviieeww  

1. Open the table in Design view. 

2. Select the field(s) you want to delete.  

To select one field, click that field's row selector.  

To select a group of fields, drag through the row selectors of those fields.  

3. Click Delete Row on the toolbar.  

Notes  

• If other database objects contain references to a deleted field, you need to delete 
those references as well. For example, if a report includes a control bound to a 
deleted field, Microsoft Access won't be able to find the data from the field and 
will generate a message. 

• You can't delete a field that's part of a relationship. You must delete the 
relationship first.  

DDeelleettee  aa  ffiieelldd  ffrroomm  aa  ttaabbllee  iinn  DDaattaasshheeeett  vviieeww  

1. Open the table in Datasheet view. 

2. Click the field selector of the column you want to delete. 

3. On the Edit menu, click Delete Column.  

 
Notes  

• If other database objects contain references to a deleted field, you need to delete 
those references as well. For example, if a report includes a control bound to a 
deleted field, Microsoft Access won't be able to find the data from the field and 
will generate a message. 



 

 
 

• You can't delete a field that's part of a relationship. You must delete the 
relationship first.  

CChhaannggee  aa  ffiieelldd''ss  ddaattaa  ttyyppee  

1. If your table contains data, make a backup copy of the table before you change 
data types or field sizes. 

2. Open the table in Design view. 

3. Click the Data Type column of the field you want to change, click the arrow, and 
select the new data type. 

4. Click Save on the toolbar.  

Caution   If the data type conversion would result in lost values, Microsoft Access 
displays a message telling you that errors occurred during conversion before it actually 
saves the changes. Click Cancel to cancel the changes. Click OK to continue and save 
the changes anyway. 

For more information on the consequences of changing a field's data type, click . 
Note   In large tables, changing a data type might take a long time. If you want to cancel 
the conversion process at any point while it is running, press CTRL+BREAK, and then 
click OK. 
 
SSppeecciiffyy  aa  ddiiffffeerreenntt  ddiissppllaayy  nnaammee  ffoorr  aa  ffiieelldd  ((ccoolluummnn))  iinn  DDaattaasshheeeett  vviieeww  

1. Open the table in Design view. 

2. In the upper portion of the window, click the field for which you want to define a 
different column name. 

3. In the lower portion of the window on the General tab, click the Caption property 
box, and then type the text for the column name. The text can contain any 
combination of letters, numbers, spaces, and symbols up to 255 characters in 
length.  

 
 
 
Notes  

• This is useful in situations where you want the column heading to be longer or 
more descriptive than the actual field name. For example, you might want to 
name a field LName for use in Visual Basic for Applications code and 
expressions, but display "Last Name" as the field's column heading. 



 

 
 

• A field's Caption property also specifies the default text for labels attached to 
controls in forms and reports created with a wizard or by dragging a field from the 
field list. 

• If you set a field's Caption property, and later rename that field while in 
Datasheet view, the field's caption text will be deleted. If this happens, you can 
redefine the field's caption as described in this topic. You can avoid this by 
renaming the field in Design view.  

SSppeecciiffyy  tthhee  ddeeffaauulltt  ccoonnttrrooll  ((lliisstt  bbooxx,,  ccoommbboo  bbooxx,,  oorr  cchheecckk  bbooxx))  ffoorr  aa  
ffiieelldd  

1. Open the table that contains the field in Design view. 

2. Click in the Data Type column for a Text, Number, or Yes/No field. 

3. Click the Lookup tab in the lower portion of the screen. 

4. In the DisplayControl property box, click a control type in the list.  

Notes  

• You can specify a default control type for Text, Number, and Yes/No fields. When 
you set the default control type for a field, Microsoft Access displays that control 
in the datasheet for the table and automatically creates that type of control 
whenever you add that field to a form or report. For Text and Number fields, the 
default control type can be a text box, combo box, or list box (forms only). For 
Yes/No fields, the default control type can be a check box, text box, or combo 
box. 

• If you want to display the field as a combo box in a table datasheet, but as a text 
box in a query datasheet, you can set the Lookup property for the field in query 
Design view in addition to the table property.  

CChhaannggee  tthhee  ffiieelldd  ssiizzee  ffoorr  TTeexxtt  aanndd  NNuummbbeerr  ffiieellddss  
Use this procedure to control the maximum number of characters that can be entered 
into a Text field, or the range and kind of numeric values that can be entered into a 
Number field.  

1. In table Design view, in the upper portion of the window, click the field whose 
FieldSize property you want to set. 

2. In the lower portion of the window on the General tab, click the FieldSize 
property box. 

3. For a Text field, type the maximum number of characters to allow in the field (up 
to 255).  



 

 
 

For a Number field, click the arrow and select the desired field size. For more 
information on field sizes for Number fields 

DDeeffiinnee  aann  iinnppuutt  mmaasskk  ffoorr  aa  ffiieelldd  iinn  aa  ttaabbllee  

1. Open a table in Design view. 

2. In the upper portion of the window, click the field you want to define an input 
mask for. 

3. In the lower portion of the window on the General tab, click the Build button 
next to the InputMask property box to start the Input Mask wizard, and then 
follow the instructions in the wizard dialog boxes.  

Note   You can also enter the input mask definition in the property sheet without using 
the wizard. In most cases, it's easiest to use the wizard, but for Number and Currency 
fields, you must enter the input mask definition manually. For information on how to 
define an input mask manually 
 
DDeeffiinnee  aann  iinnppuutt  mmaasskk  ffoorr  aa  ffiieelldd  iinn  aa  qquueerryy  

1. Open a query in Design view. 

2. In the query design grid, place the insertion point in the column for the field you 
want to change. You can place the insertion point in any row for that field. 

3. Click Properties on the toolbar to open the property sheet for that field. 

4. On the General tab, click the Build button next to the InputMask property to 
start the Input Mask wizard, and then follow the instructions in the wizard dialog 
boxes.  

Note   You can also enter the input mask definition in the property sheet without using 
the wizard. In most cases, it's easiest to use the wizard, but for Number and Currency 
fields, you must enter the input mask definition manually. For information on how to 
define an input mask manually,  
CCrreeaattee  aann  iinnppuutt  mmaasskk  ffoorr  aa  ccoonnttrrooll  

1. Open a form in Design view. 

2. Select a text box or a combo box, and then click Properties on the toolbar to 
open the control's property sheet. 

3. Do one of the following:  



 

 
 

o In a Microsoft Access database (.mdb), click the Build button in the 
InputMask property box to start the Input Mask Wizard, and then follow 
the instructions in the wizard dialog boxes.  

 
DDeeffiinnee  aa  ddeeffaauulltt  vvaalluuee  iinn  ttaabbllee  DDeessiiggnn  vviieeww  

1. Open a table in Design view. 

2. In the upper portion of the window, click the field you want to define a default 
value for. 

3. In the lower portion of the window on the General tab, click the DefaultValue 
property box, and then type the default value (such as New York) or an 
expression (such as Date()).  

Notes    

• Setting the DefaultValue property for a field has no effect on existing data. 
However, you can replace a field's current value with the default value by 
pressing CTRL+ALT+SPACEBAR. 

• If you define a default value for a Yes/No field in a database that will be used 
internationally, enter an equal sign before the value, and Microsoft Access will 
display the default value in the local language. For example, enter =Yes to have 
Microsoft Access display "Ja" in Germany. You must set the DisplayControl 
property for the field to Text Box or Combo Box to see the value.  

 
AAssssiiggnn  aa  ddeeffaauulltt  vvaalluuee  ttoo  aa  ccoonnttrrooll  

1. Open a form in Design view or a data access page in Design view. 

2. Make sure the control is selected, and then click Properties on the toolbar to 
open the control's property sheet. 

3. In the DefaultValue property box, type the default value (such as New York) or 
an expression (such as =Date()). If the string expression that you type includes 
commas or other punctuation, be sure to enclose the value in quotation marks. 
For example, to use "New York, NY" as the default value, type "New York, NY". 
In a form in a Microsoft Access database (.mdb), if you need help creating an 
expression, click the Build button to use the Expression Builder  

Note   If you set the DefaultValue property for a field in the table's design and also set 
the DefaultValue property for a control bound to that field, the default value set for the 
control overrides the default value set for the field. 
 



 

 
 

PPrrooppeerrttiieess  tthhaatt  ccoonnttrrooll  hhooww  bbllaannkk  ffiieellddss  aarree  hhaannddlleedd  
 
You can control the way that a blank field is handled by setting different combinations of 
the field's Required and AllowZeroLength properties. The AllowZeroLength property 
is only available for Text, Memo, or Hyperlink fields. The Required property determines 
whether an entry must be made. If the AllowZeroLength property is set to Yes, then 
Microsoft Access will differentiate between two kinds of blank values: Null values and 
zero-length string values. 
 
TThhee  ddiiffffeerreennccee  bbeettwweeeenn  NNuullll  vvaalluueess  aanndd  zzeerroo--lleennggtthh  ssttrriinnggss  
Microsoft Access allows you to distinguish between two kinds of blank values. In some 
situations, a field may be left blank because the information may exist but is not 
currently known, or because the field doesn't apply to the record at all. For example, if a 
table has a Number field, you can leave the field blank if you're unsure of the customer's 
fax number, or whether the customer even has a fax. In this case, leaving the field blank 
enters a Null value, which means "I don't know." Entering a zero-length string by typing 
double quotation marks (" ") means "I know that there is no value." 
  
WWhheenn  ttoo  aallllooww  NNuullll  vvaalluueess  iinn  aa  ffiieelldd  
If you want to leave a field blank and don't need to determine why the field is left blank, 
set both the Required and AllowZeroLength properties to No. This is the default when 
creating a new Text, Memo, or Hyperlink field. 
  
WWhheenn  ttoo  aallllooww  nneeiitthheerr  NNuullll  vvaalluueess  nnoorr  zzeerroo--lleennggtthh  ssttrriinnggss  iinn  aa  ffiieelldd  
If you never want a field to be left blank, set the Required property to Yes and the 
AllowZeroLength property to No. 
  
WWhheenn  ttoo  aallllooww  bbootthh  NNuullll  vvaalluueess  aanndd  zzeerroo--lleennggtthh  ssttrriinnggss  iinn  aa  ffiieelldd  
If you want to be able to distinguish between a field that is blank because the 
information is unknown and a field that is blank because it doesn't apply, set the 
Required property to No and the AllowZeroLength property to Yes. 
 
In this case, when adding a record, you would leave the field blank (which enters a Null 
value) if the information is unknown. On the other hand, you would type double 
quotation marks (" ") with no space between them to enter a zero-length string, 
indicating that the field doesn't apply to the current record. 
WWhheenn  ttoo  aallllooww  oonnllyy  zzeerroo--lleennggtthh  ssttrriinnggss  oorr  ssoommee  vvaalluuee  iinn  aa  ffiieelldd  
 
If you only want a field left blank if you know that a field isn't applicable to a record, set 
both the Required property and the AllowZeroLength property to Yes. 
In this case, the only way to leave a field blank is to type double quotation marks with no 
space between them, or press the SPACEBAR to enter a zero-length string. 
The following table shows the results of all possible settings of the Required and 
AllowZeroLength properties. 
 



 

 
 

Required AllowZeroLength User's action Value entered 

No No Presses ENTER <Null> 

    Presses SPACEBAR <Null> 

    Types " " (not allowed) 

Yes No Presses ENTER (not allowed) 

    Presses SPACEBAR (not allowed) 

    Types " " (not allowed) 

No Yes Presses ENTER <Null> 

    Presses SPACEBAR <Null> 

    Types " " <Zero-length 
string> 

Yes Yes Presses ENTER (not allowed) 

    Presses SPACEBAR <Zero-length 
string> 

    Types " " <Zero-length 
string> 

 
DDiissttiinngguuiisshhiinngg  NNuullll  vvaalluueess  ffrroomm  zzeerroo--lleennggtthh  ssttrriinnggss  
When you view data in a field that contains both Null values and zero-length strings, the 
fields look the same — they contain no values. You can distinguish Null values from 
zero-length strings by using an expression in a query field or in the control source of an 
unbound control in a form, a report or a data access page. The following expression 
returns “Unknown” if the field contains Null and “ZLS” if the field contains a zero-length 
string; otherwise, the expression returns the value in that field.  
=IIf(IsNull([fieldname]),”Unknown”,Format([fieldname],”@;\ZLS”)) 
FFiinnddiinngg  zzeerroo--lleennggtthh  ssttrriinnggss  oorr  NNuullll  vvaalluueess  
 
You can use the Find command on the Edit menu to locate Null values or zero-length 
strings. In Datasheet view or Form view, select the field in which you want to search. In 
the Find In Field box, type Null to find Null values, or type quotation marks (" ") with no 
space between them to find zero-length strings. In the Match box, select Whole Field, 
and make sure the Search Fields As Formatted check box isn't selected. 
  
AAbboouutt  ccoommpprreessssiinngg  tthhee  ddaattaa  iinn  aa  TTeexxtt,,  MMeemmoo,,  oorr  HHyyppeerrlliinnkk  ffiieelldd  
 



 

 
 

Microsoft Access 2000 uses the Unicode character-encoding scheme to represent the 
data in a Text, Memo, or Hyperlink field. In Unicode, each character is represented by 
two bytes instead a single byte.  
 
An encoding scheme that stores each character in one byte limits you to a single code 
page — a numbered set containing a maximum of 256 characters. However, Unicode 
can support a maximum of 65,536 characters, because it represents each character as 
two bytes. As a result, the data in a Text, Memo, or Hyperlink field requires more 
storage space than it did in previous versions of Access.  
 
You can offset this effect of Unicode character representation and ensure optimal 
performance by setting the Unicode Compression property of the field to Yes. This is 
the default when you create a new Text, Memo, or Hyperlink field. When the Unicode 
Compression property of a field is set to Yes, any character whose first byte is 0 is 
compressed when it is stored and uncompressed when it is retrieved. Because the first 
byte of a Latin character — a character of a Western European language such as 
English, Spanish, or German — is 0, Unicode character representation does not affect 
how much storage space is required for compressed data that consists entirely of Latin 
characters. 
 
You can store in a single field any combination of characters that Unicode supports. 
However, if the first byte of a particular character is not 0, that character is not 
compressed. 
 
Note   Data in a Memo field is not compressed unless it requires 4,096 bytes or less of 
storage space after compression. As a result, the contents of a Memo field might be 
compressed in one record, but might not be compressed in another record. 
  
RReessttrriicctt  oorr  vvaalliiddaattee  ddaattaa  
 
You can use validation rules or input masks to control how data is entered in a field in a 
table or query, or in a control on a form or report. You can also use macros to perform 
more complex validation. 
  
DDeeffiinnee  vvaalliiddaattiioonn  rruulleess  ttoo  ccoonnttrrooll  wwhhaatt  vvaalluueess  ccaann  bbee  eenntteerreedd  iinnttoo  aa  
ffiieelldd  

1. Open a table in Design view. 

2. In the upper portion of the window, click the field you want to define a validation 
rule for. 

3. In the lower portion of the window on the General tab, click the ValidationRule 
property box, and then type the validation rule, or click the Build button to create 
the validation rule using the Expression Builder.  



 

 
 

For example, you could define the validation expression ">9" for a Quantity field 
to prevent a user from placing an order for fewer than 10 units.  

4. In the ValidationText property box, type the message that you want displayed 
when the rule is broken.  

For example, for the validation expression ">9", you could enter "You must order 
10 or more units."  

If you set a validation rule in a field that contains data, Microsoft Access will ask if 
you want to apply the new rule to existing data when you save the table.  

Notes  

• Field validation rules are enforced whenever you add or edit data, whether it is 
through table Datasheet view, a control on a form that is bound to the field, an 
append query, an update query, Visual Basic for Applications code, or by 
importing data from another table. 

• You can test to see if the data in a table meets validation rules by right-clicking 
the title bar of table Design view, and then by clicking Test Validation Rules.  

RReeqquuiirree  tthhaatt  ddaattaa  bbee  eenntteerreedd  ffoorr  aa  ffiieelldd  

1. In table Design view, in the upper portion of the window, click the field that you 
want to require data entry for. 

2. In the lower portion of the window on the General tab, click the Required 
property box, and then click Yes.  

When you save changes to your table, Microsoft Access gives you the option to 
check to see whether the field has a value in all existing records. However, you 
can require that a value be entered in this field in all new records even if there 
are existing records with Null (blank) values in the field that aren't going to be 
changed.  

Note   The Required property is enforced at the table level, so if you set this property to 
Yes, the field must have a value in all instances in which data might be entered in the 
field — in the table, in forms and datasheets based on the table, when a macro or 
Visual Basic for Applications code sets the value of the field, or when data is imported 
into the table. 
  
WWhhaatt  kkiinndd  ooff  pprriimmaarryy  kkeeyy  sshhoouulldd  II  uussee??  
The power of a relational database system such as Microsoft Access comes from its 
ability to quickly find and bring together information stored in separate tables using 
queries, forms, and reports. In order to do this, each table should include a field or set of 



 

 
 

fields that uniquely identifies each record stored in the table. This information is called 
the primary key of the table. Once you designate a primary key for a table, to ensure 
uniqueness, Microsoft Access will prevent any duplicate or Null values from being 
entered in the primary key fields. 
There are three kinds of primary keys that can be defined in Microsoft Access: 
AutoNumber, single-field, and multiple-field. 
  
AAuuttooNNuummbbeerr  pprriimmaarryy  kkeeyyss  
An AutoNumber field can be set to automatically enter a sequential number as each 
record is added to the table. Designating such a field as the primary key for a table is 
the simplest way to create a primary key. If you don't set a primary key before saving a 
newly created table, Microsoft Access will ask if you want it to create a primary key for 
you. If you answer Yes, Microsoft Access will create an AutoNumber primary key. There 
are additional considerations  
 
SSiinnggllee--ffiieelldd  pprriimmaarryy  kkeeyyss  
If you have a field that contains unique values such as ID numbers or part numbers, you 
can designate that field as the primary key. If the field you select as primary key does 
have duplicate or Null values, Microsoft Access won't set the primary key. You can run 
a Find Duplicates query to determine which records contain duplicate data. If you can't 
readily eliminate duplicate entries by editing your data, you can either add an 
AutoNumber field and set it as the primary key or define a multiple-field primary key. 
  
MMuullttiippllee--ffiieelldd  pprriimmaarryy  kkeeyyss  
 
In situations where you can't guarantee the uniqueness of any single field, you may be 
able to designate two or more fields as the primary key. The most common situation 
where this arises is in the table used to relate two other tables in a many-to-many 
relationship. The Order Details table in the Northwind sample database is such a table, 
relating the Orders and Products tables. Its primary key consists of two fields: OrderID 
and ProductID. The Order Details table can list many products and many orders, but 
each product can only be listed once per order, so combining the OrderID and 
ProductID fields produces an appropriate primary key.  

Another example would be an inventory database that uses a field part number of two 
or more fields (part and subpart). 

Note   If you are in doubt about whether you can select an appropriate combination of 
fields for a multiple-field primary key, you should probably add an AutoNumber field and 
designate it as the primary key instead. For example, combining FirstName and 
LastName fields to produce a primary key is not a good choice, since you may 
eventually encounter duplication in the combination of these two fields. 



 

 
 

SSeett  oorr  cchhaannggee  tthhee  pprriimmaarryy  kkeeyy  

1. Open a table in Design view. 

2. Select the field or fields you want to define as the primary key.  

To select one field, click the row selector for the desired field.  

To select multiple fields, hold down the CTRL key and then click the row selector 
for each field.  

3. Click Primary Key on the toolbar.  

Notes  

• You can specify a primary key for a field that already contains data, but Microsoft 
Access generates a message when you save the table if it finds duplicate values 
or Null values in the field. If you encounter this message, you have three 
choices: use a Find Duplicates query to locate records with duplicate values or 
Null values and then edit the field to remove them; choose a different field; or 
add an AutoNumber field and set it as the primary key. For more information on 

finding duplicate records, click . 

• In a multiple-field primary key, field order may be important to you. The fields in a 
multiple-field primary key are sorted according to their order in table Design view.  

• If you want a different order, first specify the fields for the primary key as 
described in the preceding procedure, and then click Indexes on the toolbar to 
display the Indexes window and reorder the field names for the index named 
PrimaryKey.  

RReemmoovvee  tthhee  pprriimmaarryy  kkeeyy  

1. If the primary key is used in a relationship, you must delete the relationship 
before you can remove the primary key.  

2. Open the table in Design view. 

3. Click the row selector for the current primary key and then click Primary Key on 
the toolbar.  

Note   This procedure doesn't delete the field or fields that are designated as the 
primary key; it simply removes the primary key features from the table. In some 
situations, you may need to temporarily remove the primary key. For example, importing 
records into a table may result in some duplicate records. Until you eliminate the 
duplicates, you should remove the primary key. For more information on finding 
duplicate records, 



 

 
 

 
CCrreeaattee  aa  ssiinnggllee--ffiieelldd  iinnddeexx  

1. Open a table in Design view. 

2. In the upper portion of the window, click the field that you want to create an index 
for. 

3. In the lower portion of the window on the General tab, click in the Indexed 
property box, and then click Yes (Duplicates OK) or Yes (No Duplicates).  

Click Yes (No Duplicates) if you want to ensure that no two records have the 
same data in this field.  

CCrreeaattee  aa  mmuullttiippllee--ffiieelldd  iinnddeexx  

1. Open the table in Design view. 

2. Click Indexes on the toolbar. 

3. In the first blank row in the Index Name column, type a name for the index. You 
can name the index after one of the index fields, or use some other appropriate 
name. 

4. In the Field Name column, click the arrow and select the first field for the index. 

5. In the next row in the Field Name column, select the second field for the index. 
(Leave the Index Name column blank in that row.) Repeat this step until you 
have selected all the fields you want to include in this index. You can use up to 
10 fields.  

Note   The default sort order is Ascending. Select Descending in the Sort Order 
column of the Indexes window to sort the corresponding field's data in descending 
order. 
  
DDeelleettee  aann  iinnddeexx  
Indexes speed up searches, but they can also slow bulk record updates such as 
append queries. If you have indexed a field or fields that you don't use to search, sort, 
or join, and you perform operations that perform bulk record updates that you want to 
speed up, delete the index. Deleting an index doesn't delete the field or the data in the 
field. 
TToo  ddeelleettee  aa  ssiinnggllee--ffiieelldd  iinnddeexx  

1. Open the table in Design view. 

2. In the upper portion of the window, click the field whose index you want to delete. 



 

 
 

3. In the lower portion of the window on the General tab click in the Indexed 
property box, and then click No.  

TToo  ddeelleettee  aa  mmuullttiippllee--ffiieelldd  iinnddeexx  

1. Open the table in Design view. 

2. Click Indexes on the toolbar. 

3. In the Indexes window, select the rows containing the index you want to delete 
and press the DELETE key. This removes only the index, not the field itself.  

PPrreevveenntt  dduupplliiccaattee  vvaalluueess  ffrroomm  bbeeiinngg  eenntteerreedd  iinn  aa  ccoommbbiinnaattiioonn  ooff  ffiieellddss  

1. Open the table in Design view. 

2. Create a multiple-field index using the fields you want to prohibit duplicate values 
for. Leave the Indexes window open when you have finished defining the index.  

3. In the upper portion of the Indexes window, click the new index name. 

4. In the lower portion of the Indexes window, click the Unique property box, and 
then select Yes.  

PPrreevveenntt  dduupplliiccaattee  vvaalluueess  ffrroomm  bbeeiinngg  eenntteerreedd  iinnttoo  aa  ffiieelldd  
A single-field primary key prohibits duplicate values in that field to ensure that each 
record has a unique identifier. However, you may want to prevent duplicate values in 
other fields as well. For example, you might want to assign computers to employees 
using a serial number field for the computers.  

1. Open a table in Design view. 

2. In the upper portion of the window, click the field that you want to prohibit 
duplicate values for. 

3. In the lower portion of the window on the General tab, click in the Indexed 
property box, and then click Yes (No Duplicates).  

AAbboouutt  rreellaattiioonnsshhiippss  iinn  aann  AAcccceessss  ddaattaabbaassee  
WWhhyy  ddeeffiinnee  rreellaattiioonnsshhiippss??  
After you've set up different tables for each subject in your Microsoft Access database, 
you need a way of telling Microsoft Access how to bring that information back together 
again. The first step in this process is to define relationships between your tables. After 
you've done that, you can create queries, forms, and reports to display information from 
several tables at once. For example, this form includes information from five tables: 



 

 
 

  
HHooww  ddoo  rreellaattiioonnsshhiippss  wwoorrkk??  
In the previous example, the fields in five tables must be coordinated so that they show 
information about the same order. This coordination is accomplished with relationships 
between tables. A relationship works by matching data in key fields — usually a field 
with the same name in both tables. In most cases, these matching fields are the primary 
key from one table, which provides a unique identifier for each record, and a foreign key 
in the other table. For example, employees can be associated with orders they're 
responsible for by creating a relationship between the Employees table and the Orders 
table using the EmployeeID fields. 
  
AA  oonnee--ttoo--mmaannyy  rreellaattiioonnsshhiipp  
A one-to-many relationship is the most common type of relationship. In a one-to-many 
relationship, a record in Table A can have many matching records in Table B, but a 
record in Table B has only one matching record in Table A. 
  
AA  mmaannyy--ttoo--mmaannyy  rreellaattiioonnsshhiipp  
In a many-to-many relationship, a record in Table A can have many matching records in 
Table B, and a record in Table B can have many matching records in Table A. This type 
of relationship is only possible by defining a third table (called a junction table) whose 
primary key consists of two fields — the foreign keys from both Tables A and B. A 
many-to-many relationship is really two one-to-many relationships with a third table. For 
example, the Orders table and the Products table have a many-to-many relationship 
that's defined by creating two one-to-many relationships to the Order Details table. 
  
AA  oonnee--ttoo--oonnee  rreellaattiioonnsshhiipp  
In a one-to-one relationship, each record in Table A can have only one matching record 
in Table B, and each record in Table B can have only one matching record in Table A. 
This type of relationship is not common, because most information related in this way 
would be in one table. You might use a one-to-one relationship to divide a table with 
many fields, to isolate part of a table for security reasons, or to store information that 
applies only to a subset of the main table. For example, you might want to create a table 
to track employees participating in a fundraising soccer game. 
  
DDeeffiinniinngg  rreellaattiioonnsshhiippss  
You define a relationship by adding the tables that you want to relate to the 
Relationships window, and then dragging the key field from one table and dropping it on 
the key field in the other table. You can also define relationships by using the keyboard. 
 
The kind of relationship that Microsoft Access creates depends on how the related fields 
are defined:  

• A one-to-many relationship is created if only one of the related fields is a primary 
key or has a unique index. 



 

 
 

• A one-to-one relationship is created if both of the related fields are primary keys 
or have unique indexes. 

• A many-to-many relationship is really two one-to-many relationships with a third 
table whose primary key consists of two fields — the foreign keys from the two 
other tables.  

Note   If you drag a field that isn't a primary key and doesn't have a unique index to 
another field that isn't a primary key and doesn't have a unique index, an indeterminate 
relationship is created. In queries containing tables with an indeterminate relationship, 
Microsoft Access displays a default join line between the tables, but referential integrity 
won't be enforced, and there's no guarantee that records are unique in either table. 
  
DDiissppllaayy  tthhee  RReellaattiioonnsshhiippss  wwiinnddooww  

1. If you haven't already done so, switch to the Database window. You can press 
F11 to switch to the Database window from any other window. 

2. Click Relationships on the toolbar.  

The Relationships window is displayed. If the relationship layout was saved 
previously, the saved layout is displayed. If not, the Show Tables dialog box is 
displayed to select tables or queries to add to the Relationships window.  

DDeeffiinnee  rreellaattiioonnsshhiippss  bbeettwweeeenn  ttaabblleess  

1. Close any tables you have open. You can't create or modify relationships 
between open tables. 

2. If you haven't already done so, switch to the Database window. You can press 
F11 to switch to the Database window from any other window. 

3. Click Relationships on the toolbar. 

4. If your database doesn't have any relationships defined, the Show Table dialog 
box will automatically be displayed. If you need to add the tables you want to 
relate and the Show Table dialog box isn't displayed, click Show Table on the 
toolbar. If the tables you want to relate are already displayed, skip to step 6. 

5. Double-click the names of the tables you want to relate, and then close the Show 
Table dialog box. 

6. Drag the field that you want to relate from one table to the related field in the 
other table.  

To drag multiple fields, press the CTRL key and click each field before dragging them.  



 

 
 

In most cases, you drag the primary key field (which is displayed in bold text) from one 
table to a similar field (often with the same name) called the foreign key in the other 
table. The related fields don't have to have the same names, but they must have the 
same data type (with two exceptions) and contain the same kind of information. In 
addition, when the matching fields are Number fields, they must have the same 
FieldSize property setting. The two exceptions to matching data types are that you can 
match an AutoNumber field with a Number field whose FieldSize property is set to 
Long Integer; and you can match an AutoNumber field with a Number field if both fields 
have their FieldSize property set to Replication ID.  

7. The Edit Relationships dialog box is displayed. Check the field names 
displayed in the two columns to ensure they are correct. You can change them if 
necessary.  

Set the relationship options if necessary. For information about a specific item in 
the Relationships dialog box, click the question mark button and then click the 
item.  

8. Click the Create button to create the relationship. 

9. Repeat steps 5 through 8 for each pair of tables you want to relate.  

When you close the Relationships window, Microsoft Access asks if you want to 
save the layout. Whether you save the layout or not, the relationships you create 
are saved in the database.  

 
Notes    

• If you need to view all the relationships defined in the database, click Show All 
Relationships on the toolbar. To view only the relationships defined for a 

particular table, click the table, and then click Show Direct Relationships 
on the toolbar. 

• If you need to make a change to the design of a table, you can right-click the 
table you want to change, and then click Table Design. 

• You can create relationships using queries as well as tables. However, referential 
integrity isn't enforced with queries. 

• To create a relationship between a table and itself, add that table twice. This is 
useful in situations where you need to perform a lookup within the same table. 
For example, in the Employees table in the Northwind sample database, a 
relationship has been defined between the EmployeeID and ReportsTo fields, so 
that the ReportsTo field can display employee data from a matching EmployeeID. 



 

 
 

DDeeffiinnee  rreellaattiioonnsshhiippss  bbyy  uussiinngg  tthhee  kkeeyybbooaarrdd  

1. Close any tables that you have open. You can’t create or modify relationships 
between open tables. 

2. If you haven’t already done so, switch to the Database window. You can press 
F11 to switch to the Database window from any other window. 

3. Press ALT+T to select the Tools menu, and then press R to open the 
Relationships window. 

4. If your database doesn’t have any relationships defined, the Show Table dialog 
box appears automatically. If you need to add the tables that you want to relate, 
and the Show Table dialog box does not appear, press ALT+R to select the 
Relationships menu, and then press T to open the Show Table dialog box. If 
the tables that you want to relate already appear in the Relationships window, 
skip to step 7. 

5. In the Show Table dialog box, select the first table that you want to relate, and 
then press ENTER to add it to the Relationships window. 

6. Repeat step 5 for any other tables you want to relate, and then press ALT+C to 
close the Show Table dialog box. 

7. Press ALT+R to select the Relationships menu, and then press R to open the 
Edit Relationships dialog box. 

8. Press ALT+N to open the Create New dialog box. 

9. In the Left Table Name box, select the name of the table that contains the 
primary key. 

10. In the Right Table Name box, select the name of the table that contains the 
foreign key. 

11. In the Left Column Name box, select the primary key field, and in the Right 
Column Name box, select the foreign key field.  

The related fields don’t have to have the same names, but they must have the 
same data type and contain the same kind of information. In addition, when the 
matching fields are Number fields, they must have the same FieldSize property 
setting. There are two exceptions to matching data types: you can match an 
AutoNumber field with a Number field whose FieldSize property is set to Long 
Integer; and you can match an AutoNumber field with a Number field if the 
FieldSize property for both fields is set to Replication ID.  

12. Press ENTER. 



 

 
 

13. In the Edit Relationships dialog box, use the arrow keys to make sure that the 
two columns contain the field names you want; you can change them if 
necessary, or you can specify additional fields if you are using a multiple-field 
primary key.  

Set relationship options if necessary. For information about a specific item in the 
Relationships dialog box, select the item and then press F1.  

14. Press ALT+C to create the relationship. 

15. Repeat steps 5 through 14 for each pair of tables you want to relate.  

Notes    

• If you need to view all the relationships that are defined in the database, press 
ALT+R to select the Relationships menu, and then press L. To view only the 
relationships defined for a particular table, select that table, press ALT+R to 
select the Relationships menu, and then press D. 

• If you need to make a change to the design of a table, select that table; press 
SHIFT+F10 to select the shortcut menu, and then select Table Design. 

• You can create relationships for queries as well as tables. However, referential 
integrity isn't enforced with queries. 

• To create a relationship between a table and itself, add that table twice. This is 
useful in situations where you need to perform a lookup within the same table. 
For example, in the Employees table in the Northwind sample database, a 
relationship has been defined between the EmployeeID and ReportsTo fields, so 
that the ReportsTo field can display employee data from a matching EmployeeID.  

 
DDeeffiinnee  aa  mmaannyy--ttoo--mmaannyy  rreellaattiioonnsshhiipp  bbeettwweeeenn  ttaabblleess  

1. Create the two tables that will have a many-to-many relationship.  
2. Create a third table, called a junction table, and add fields with the same 

definitions as the primary key fields from each of the other two tables to this 
table. In the junction table, the primary key fields function as foreign keys. You 
can add other fields to the junction table, just as you can to any other table. 

3. In the junction table, set the primary key to include the primary key fields from the 
other two tables. For example, in an Order Details junction table, the primary key 
would be made up of the OrderID and ProductID fields.  

4. Define a one-to-many relationship between each of the two primary tables and 
the junction table.  

5. To add data to the tables, do one of the following:  
o Create a query that works with more than one table. For more information,  



 

 
 

o Create a form that works with more than one table. For more information,  

Note   In the Northwind sample database, a many-to-many relationship exists between 
the Orders and Products tables. One order in the Orders table can include multiple 
products from the Products table. In addition, a single product can appear in many 
orders. In the sample database, the Order Details table is a junction table between the 
Orders table and the Products table. 
 
DDeeffiinnee  tthhee  ddeeffaauulltt  jjooiinn  ttyyppee  ffoorr  aa  rreellaattiioonnsshhiipp  bbeettwweeeenn  ttwwoo  ttaabblleess  

1. If you haven't already done so, switch to the Database window. You can press 
F11 to switch to the Database window from any other window. 

2. Click Relationships on the toolbar to open the Relationships window. 

3. Double-click the middle section of a join line between two tables to open the 
Relationships dialog box. 

4. Click the Join Type button, and then click the desired join type.  

Option 1 defines an inner join. This is the default.  

Option 2 defines a left outer join.  

Option 3 defines a right outer join.  

Note   The Join Type button won't be enabled if the tables are linked tables. If the 
tables are in Microsoft Access format, you can open the database in which they are 
stored to set the join type.  
Defining the join type for a relationship in the Relationships window doesn't affect the 
relationship itself; it sets the kind of join that will be used by default when creating 
queries based on the related tables. You can always override the default join type later 
when defining a query.  
 
DDeelleettee  aa  rreellaattiioonnsshhiipp  

1. Close any tables you have open. You can't delete relationships between open 
tables. 

2. If you haven't already done so, switch to the Database window. You can press 
F11 to switch to the Database window from any other window. 

3. Click Relationships on the toolbar. 

4. If the tables whose relationship you want to delete aren't displayed, click Show 
Table on the toolbar and double-click each table you want to add. Then click 
Close. 



 

 
 

5. Click the relationship line for the relationship you want to delete (the line will turn 
bold when it's selected), and then press the DELETE key.  

EEddiitt  aann  eexxiissttiinngg  rreellaattiioonnsshhiipp  

1. Close any tables you have open. You can't modify relationships between open 
tables. 

2. If you haven't already done so, switch to the Database window. You can press 
F11 to switch to the Database window from any other window. 

3. Click Relationships on the toolbar. 

4. If the tables whose relationship you want to edit aren't displayed, click Show 
Table on the toolbar and double-click each table you want to add. 

5. Double-click the relationship line for the relationship you want to edit. 

6. Set the relationship options. For information about a specific item in the 
Relationships dialog box, click the question mark button and then click the item.  

WWhhaatt  iiss  rreeffeerreennttiiaall  iinntteeggrriittyy??  
Referential integrity is a system of rules that Microsoft Access uses to ensure that 
relationships between records in related tables are valid, and that you don't accidentally 
delete or change related data. You can set referential integrity when all of the following 
conditions are met:  

• The matching field from the primary table is a primary key or has a unique index. 

• The related fields have the same data type. There are two exceptions. An 
AutoNumber field can be related to a Number field with a FieldSize property 
setting of Long Integer, and an AutoNumber field with a FieldSize property 
setting of Replication ID can be related to a Number field with a FieldSize 
property setting of Replication ID. 

• Both tables belong to the same Microsoft Access database. If the tables are 
linked tables, they must be tables in Microsoft Access format, and you must open 
the database in which they are stored to set referential integrity. Referential 
integrity can't be enforced for linked tables from databases in other formats.  

When referential integrity is enforced, you must observe the following rules:  

• You can't enter a value in the foreign key field of the related table that doesn't 
exist in the primary key of the primary table. However, you can enter a Null value 
in the foreign key, specifying that the records are unrelated. For example, you 
can't have an order that is assigned to a customer that doesn't exist, but you can 



 

 
 

have an order that is assigned to no one by entering a Null value in the 
CustomerID field. 

• You can't delete a record from a primary table if matching records exist in a 
related table. For example, you can't delete an employee record from the 
Employees table if there are orders assigned to the employee in the Orders 
table. 

• You can't change a primary key value in the primary table, if that record has 
related records. For example, you can't change an employee's ID in the 
Employees table if there are orders assigned to that employee in the Orders 
table.  

If you want Microsoft Access to enforce these rules for a relationship, select the 
Enforce Referential Integrity check box when you create the relationship. If referential 
integrity is enforced and you break one of the rules with related tables, Microsoft Access 
displays a message and doesn't allow the change. 
 
You can override the restrictions against deleting or changing related records and still 
preserve referential integrity by setting the Cascade Update Related Fields and 
Cascade Delete Related Records check boxes. When the Cascade Update Related 
Fields check box is set, changing a primary key value in the primary table automatically 
updates the matching value in all related records. When the Cascade Delete Related 
Records check box is set, deleting a record in the primary table deletes any related 
records in the related table. For more information on Cascade Delete Related Records 
and Cascade Update Related Fields check boxes,  
  
WWhhyy  sshhoouulldd  II  uussee  ccaassccaaddiinngg  uuppddaatteess  oorr  ccaassccaaddiinngg  ddeelleetteess??  
 
For relationships in which referential integrity is enforced, you can specify whether you 
want Microsoft Access to automatically cascade update and cascade delete related 
records. If you set these options, delete and update operations that would normally be 
prevented by referential integrity rules are allowed. When you delete records or change 
primary key values in a primary table, Microsoft Access makes necessary changes to 
related tables to preserve referential integrity. 
 
If you select the Cascade Update Related Fields check box when defining a 
relationship, any time you change the primary key of a record in the primary table, 
Microsoft Access automatically updates the primary key to the new value in all related 
records. For example, if you change a customer's ID in the Customers table, the 
CustomerID field in the Orders table is automatically updated for every one of that 
customer's orders so that the relationship isn't broken. Microsoft Access cascades 
updates without displaying any message. 
 



 

 
 

Note   If the primary key in the primary table is an AutoNumber field, setting the 
Cascade Update Related Fields check box will have no effect, because you can't 
change the value in an AutoNumber field. 
 
If you select the Cascade Delete Related Records check box when defining a 
relationship, any time you delete records in the primary table, Microsoft Access 
automatically deletes related records in the related table. For example, If you delete a 
customer record from the Customers table, all the customer's orders are automatically 
deleted from the Orders table (this includes records in the Order Details table related to 
the Orders records). When you delete records from a form or datasheet with the 
Cascade Delete Related Records check box selected, Microsoft Access warns you 
that related records may also be deleted. However, when you delete records using a 
delete query, Microsoft Access automatically deletes the records in related tables 
without displaying a warning. 
  
WWhhaatt  iiss  eexxppoorrttiinngg??  
 
Exporting is a way to output data and database objects to another database, 
spreadsheet, or file format so another database, application, or program can use the 
data or database objects. Exporting is similar in functionality to copying and pasting. In 
general, you use the Export command on the File menu to export data or database 
objects, but there are other commands you can use as described below. You can export 
data to a variety of supported databases, programs, and file formats.  
EExxppoorrttiinngg  ddaattaabbaassee  oobbjjeeccttss  
You can export most database objects from a Microsoft Access database or Microsoft 
Access project to another Access database or Access project.  
  
MMaaiilliinngg  ddaattaabbaassee  oobbjjeeccttss  
By using the Mail Recipient (as Attachment) command on the Send To submenu of 
the File command, you can e-mail the output of a database object by attaching it to an 
electronic mail message in several different file formats, including Microsoft Excel (.xls), 
Rich Text Format (.rtf), MS-DOS text (.txt), HTML (.html), IDC/HTX, ASP, or data 
access page.  
By using the Mail Recipient command on the Send To submenu of the File command, 
you can also send a page as the body of an e-mail message.  
 
To send a database object in e-mail, you need Microsoft Outlook, Microsoft Exchange, 
Microsoft Mail, or another electronic mail application that supports Messaging 
Application Programming Interface (MAPI). 
  
EExxppoorrttiinngg  ttoo  aa  WWeebb  ppaaggee  
 
There are three ways you can use Microsoft Access data or database objects to create 
a Web page:  



 

 
 

• In a Web browser that supports Dynamic HTML version 4.0 or later, you can use 
data access pages. You do not output data access pages; you create a data 
access page as a database object that contains a shortcut to the location of the 
data access page's corresponding HTML file. Use data access pages to view, 
edit, update, delete, filter, group, and sort live data from either a Microsoft Access 
database or a Microsoft SQL Server database. Learn about creating data access 
pages. 

• You can output server-generated HTML files, either ASP or IDC/HTX, from 
tables, queries, and forms. Server-generated HTML files are displayed in a table 
format in a Web browser. Use server-generated HTML files when you want to 
use any Web browser, your data changes frequently, and you need to see live 
data in a table connected to an ODBC data source, but you don't need to update 
or interact with the data.  

• You can create output HTML files from tables, queries, forms, and reports. In a 
Web browser, reports display in a report format, and tables, queries, and forms 
display in a datasheet format. Use static HTML files when you want to use any 
Web browser that supports HTML version 3.2 or later and your data does not 
change frequently.  

EExxppoorrttiinngg  ttoo  oorr  eexxcchhaannggiinngg  ddaattaa  wwiitthh  MMiiccrroossoofftt  WWoorrdd  
 
There are four ways you can use Microsoft Access data with Microsoft Word:  

• In an Access database, you can use the Microsoft Word Mail Merge Wizard to 
create a mail merge document in Microsoft Word 2000 that links to Microsoft 
Access 2000 data by using the Merge It With MS Word command on the Office 
Links submenu of the Tools menu. Once the link is established, you can open 
your document in Microsoft Word at any time to print a new batch of form letters 
or labels using the current data in Microsoft Access. 

• For any version of Microsoft Word, you can export Microsoft Access data to a 
mail merge data source file that can be used with the mail merge feature of 
Word. 

• You can save the output of a datasheet, form, or report as a Rich Text Format 
(.rtf) file. A Rich Text Format file preserves formatting, such as fonts and styles, 
and can be opened with Microsoft Word and other Windows word-processing or 
desktop-publishing programs. 

• You can save the output of a datasheet, form, or report as a .rtf file and 
automatically load the file into Microsoft Word by using the Publish It With MS 
Word command on the Office Links submenu of the Tools menu.  

EExxppoorrttiinngg  ttoo  MMiiccrroossoofftt  EExxcceell  oorr  aannootthheerr  sspprreeaaddsshheeeett  pprrooggrraamm  
 



 

 
 

There are three ways you can use Microsoft Access data with Microsoft Excel or 
another spreadsheet program:  

• You can export the datasheet as unformatted data to Microsoft Excel or another 
spreadsheet program. 

• You can save the output of a datasheet, form, or report directly as an Excel (.xls) 
file or worksheet . 

• You can save the output of a datasheet, form, or report as an Excel (.xls) file and 
automatically load the file into Microsoft Excel by using the Analyze It With MS 
Excel command on the Office Links submenu of the Tools menu.  

In the latter two cases, you can preserve most formatting, such as fonts and colors. 
Report group levels are saved as Microsoft Excel outline levels, and a form is saved as 
a table of data. 
  
 
 
AAuuttoommaattiinngg  eexxppoorrtt  ooppeerraattiioonnss  
 
To make frequent export operations more convenient, you can automate them by 
creating a macro or creating a Visual Basic for Applications procedure. This is useful, 
for example, when you export data on a regular schedule or you are building a Web site 
by using multiple database objects. 
  
TThhee  ddiiffffeerreennccee  bbeettwweeeenn  iimmppoorrttiinngg  aanndd  lliinnkkiinngg  
 
Microsoft Access provides two choices for using data from an external data source. You 
can:  

• Import the data into a new Microsoft Access table, which is a way to convert data 
from a different format and copy it into Microsoft Access. You can also import 
database objects into the current Microsoft Access database or Microsoft Access 
project. 

• Link the data, which is a way to connect to data from another application without 
importing it so that you can view and edit the data in both the original application 
and in an Access database. (In previous versions of Microsoft Access, this 
process was referred to as attaching.)  

You can import or link data from a variety of supported databases, programs, and file 
formats.  
  
IImmppoorrttiinngg  ddaattaa  
 



 

 
 

Importing data creates a copy of its information in a new table in your Access database 
or Access project. The source table or file is not altered in this process.  
When importing data, you can't append data to existing tables (except when importing 
spreadsheet or text files). However, once you have imported a table, in an Access 
database you can perform an append query or in an Access project you can use a 
stored procedure to add the table's data to another table. 
You can also import database objects other than tables, such as forms or reports, from 
another Access database or Access project. 
  
LLiinnkkiinngg  ddaattaa  
 
In an Access database, linking data enables you to read and in most cases, update data 
in the external data source without importing. The external data source's format is not 
altered so that you can continue to use the file with the program that originally created it, 
but you can add, delete, or edit its data by using Microsoft Access as well. You can link 
a table only in an Access database, not an Access project. 
Microsoft Access uses different icons to represent linked tables and tables that are 
stored in the current database. If you delete the icon for a linked table, you delete the 
link to the table, not the external table itself. 

 
WWaayyss  ttoo  iimmppoorrtt  aanndd  lliinnkk  ddaattaa  
 
There are two ways to import or link data:  

• Open or create an Access database or create an Access project to contain the 
imported tables, or linked tables in the case of an Access database, and then use 
the Import or Link Tables commands on the Get External submenu of the File 
menu. 

• In an Access database, Open the external database directly, including dBASE, 
Paradox, Exchange, and any ODBC data source, including Microsoft SQL Server 
and Microsoft Visual FoxPro. Microsoft Access will automatically create a new 
Access database in the same folder as the external database and add links to 
each table in the external database.  

UUssiinngg  OODDBBCC  ddaattaa  ssoouurrcceess  
 
You can import or link data from ODBC databases, such as Microsoft SQL Server and 
Visual FoxPro, as well as other programs that provide drivers compliant with ODBC 
Level 1 to access their data files. 
  
UUnnssuuppppoorrtteedd  pprrooggrraammss  
 
If you have a program whose data is not stored in one of the supported external 
database or file formats, but the program can export, convert, or save its data as one of 



 

 
 

these formats, then you can import that data. Additionally, when you import or link an 
external database format, such as dBASE or Paradox, Access usually preserves 
indexes. For example, you can't import or link a Microsoft Works database directly, but 
you can export the data from Microsoft Works to a dBASE IV (.dbf) database file and 
then import that data into Microsoft Access to preserve field names and indexes.  
In general, most unsupported programs, even those on different operating systems, can 
export data to a delimited or fixed-width text file, which you can then import or link from 
Microsoft Access, although you won't preserve indexes. 
 
Automating import operations 
To make frequent import operations more convenient, you can automate them by 
creating a macro or creating a Visual Basic for Applications procedure. This is useful, 
for example, when you import data on a regular schedule or you have unusual or 
complex requirement for importing data. 
 
RReeaassoonnss  ttoo  iimmppoorrtt  ddaattaa  iinnttoo  aa  ttaabbllee  
If you know that you will use your data only in Microsoft Access, you should import it. 
Microsoft Access generally works faster with its own tables, and, if you need to, you can 
modify the imported table to meet your needs just like any other table that is created in 
Microsoft Access. 
 
RReeaassoonnss  ttoo  lliinnkk  ddaattaa  ffrroomm  aann  eexxtteerrnnaall  ttaabbllee  
If the data that you want to use in your Access database is also being updated by a 
program other than Microsoft Access, you should link it. Using this approach, the 
current methods of updating, managing, and sharing the data can remain in place, and 
you can use Microsoft Access to work with the data as well. For example, you can 
create queries, forms, and reports that use the external data, combine external data 
with the data in Microsoft Access tables, and even view and edit the external data while 
others are using it in the original program. 
 
You can also link tables from other Microsoft Access databases. For example, you 
might want to use a table from another Microsoft Access database that is shared on a 
network. This is particularly useful if you want to store all of your tables in one database 
on a network server, while keeping forms, reports, and other objects in a separate 
database that is copied among users of the shared database. You can easily split an 
existing database into two databases by using the Database Splitter subcommand on 
the Database Utilities command on the Tools menu.  
  
DDaattaa  ffoorrmmaattss  MMiiccrroossoofftt  AAcccceessss  ccaann  eexxppoorrtt  
 

Application Version or format supported 

Microsoft Access database 2.0, 7.0/95, 8.0/97, 9.0/2000 

Microsoft Access project 2000 



 

 
 

dBASE III, III+, IV, and 5  

7 (Requires Borland Database Engine 4.x or later) 

Paradox, Paradox for Windows 3.x, 4.x, and 5.0  

8.0 (Requires Borland Database Engine 4.x or later) 

Microsoft Excel 3.0, 4.0, 5.0, 7.0/95, 8.0/97, and 9.0/2000 

Microsoft Word, Rich Text 
Format 

  

Lotus 1-2-3 .wk1 and .wk3 formats 

Delimited text files All character sets 

Fixed-width text files All character sets 

HTML and IDC/HTX 1.0 (if a list) 
2.0, 3.x, 4.x (if a table or list) 

Microsoft Active Server Pages   

SQL tables, Microsoft Visual 
FoxPro, and programs and 
databases that support the 
ODBC protocol 

Visual FoxPro 3.0, 5.0, and 6.x  

For an up-to-date list of supported ODBC drivers, see 
the Microsoft Knowledge Base. 

  
DDaattaa  ssoouurrcceess  MMiiccrroossoofftt  AAcccceessss  ccaann  iimmppoorrtt  oorr  lliinnkk  
 
Note   You can link a table only in a Microsoft Access database, not a Microsoft Access 
project. 

Data source Version or format supported 

Microsoft Access database 2.0, 7.0/95, 8.0/97, 9.0/2000 

Microsoft Access project 9.0/2000 

dBASE III, III+, IV, and 5  

7 (Linking (read/write) requires Borland Database 
Engine 4.x or later ) 

Paradox, Paradox for Windows 3.x, 4.x, and 5.0  

8 0 (Linking (read/write) requires Borland Database



 

 
 

Engine 4.x or later ) 

Microsoft Excel spreadsheets 3.0, 4.0, 5.0, 7.0/95, 8.0/97, and 9.0/2000 

Lotus 1-2-3 spreadsheets 
(Linking is read-only) 

.wks, .wk1, .wk3, and .wk4 

Microsoft Exchange All versions 

Delimited text files All character sets 

Fixed-width text files All character sets 

HTML 1.0 (if a list) 
2.0, 3.x (if a table or list) 

SQL tables, Microsoft Visual 
FoxPro, and data from other 
programs and databases that 
support the ODBC protocol 

Visual FoxPro 2.x, 3.0, 5.0, and 6.x (import only)  

For an up-to-date list of supported ODBC drivers, see 
the Microsoft Knowledge Base. 

  
WWhhaatt  iiss  aa  ddaattaa  ssoouurrccee??  
 
A data source is a source of data and the connection information needed to access that 
data. Examples of data sources are Microsoft Access, Microsoft SQL Server, Oracle 
RDBMS, a spreadsheet, and a text file. Examples of connection information include 
server location, database name, logon ID, password, and various ODBC driver options 
that describe how to connect to the data source. 
 
In the ODBC architecture, an application (such as Access or a Microsoft Visual Basic 
program) connects to the ODBC Driver Manager, which in turn uses a specific ODBC 
driver (for example, Microsoft SQL ODBC driver) to connect to a data source (in this 
case, an SQL Server database). In Access, you use ODBC data sources to connect to 
data external to Access that do not have built-in drivers. 
 
To connect to these data sources, you must do the following:  

• Install the appropriate ODBC driver on the computer that contains the data 
source. 

• Define a data source name (DSN) by using either the ODBC Data Source 
Administrator to store the connection information in the Windows registry or a 
DSN file, or a connect string in Visual Basic code to pass the connection 
information directly to the ODBC Driver Manager.  

MMaacchhiinnee  ddaattaa  ssoouurrcceess  
 



 

 
 

Machine data sources store connection information in the Windows Registry on a 
specific computer with a user-defined name. You can use machine data sources only on 
the computer they are defined on. There are two types of machine data sources — user 
and system. User data sources can be used only by the current user and are visible 
only to that user. System data sources can be used by all users on a computer and are 
visible to all users on the computer and system-wide services, such as Microsoft 
Windows NT services. A machine data source is especially useful when you want to 
provide added security, because only users who are logged on can view a machine 
data source and it cannot be copied by a remote user to another computer. 
  
FFiillee  ddaattaa  ssoouurrcceess  
 
File data sources (also called DSN files) store connection information in a text file, not 
the Windows Registry, and are generally more flexible to use than machine data 
sources. For example you can copy a file data source to any computer with the correct 
ODBC driver so that your application can rely on consistent and accurate connection 
information to all the computers it uses. Or you can place the file data source on a 
single server, share it between many computers on the network, and easily maintain the 
connection information in one location. 
 
A file data source can also be unshareable. An unshareable file data source resides on 
a single computer and points to a machine data source. You can use unshareable file 
data sources to access existing machine data sources from file data sources. 
  
CCoonnnneecctt  ssttrriinnggss  
 
If you are a programmer, you can define a formatted connect string in your Visual Basic 
code that specifies the connection information. Using a connect string avoids defining a 
machine or file DSN and passes the connection information directly to the ODBC Driver 
Manager. This is useful, for example, when you want to avoid requiring system 
administrators or users from first creating a DSN, or to simplify the installation of your 
application. 
  
WWaayyss  ttoo  wwoorrkk  wwiitthh  ddaattaa  iinn  aa  ffoorrmm  
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
  
  
  
 
 
 
AAdddd  nneeww  ddaattaa  iinn  DDaattaasshheeeett  oorr  FFoorrmm  vviieeww  

1. Open a Datasheet, or form in Form view.  

2. Click New Record on the toolbar. 

3. Type the data you want, and then press TAB to go to the next field. 

4. At the end of the record, press TAB to go to the next record.  

SSaavvee  aa  rreeccoorrdd  iinn  DDaattaasshheeeett  oorr  FFoorrmm  vviieeww  
 
Microsoft Access automatically saves the record you are adding or editing as soon as 
you move the insertion point to a different record, or close the form or datasheet you are 
working on.  



 

 
 

• To explicitly save the data in a record while you are editing it, click Save Record 
on the Records menu.  

DDeelleettee  aa  rreeccoorrdd  iinn  DDaattaasshheeeett  oorr  FFoorrmm  vviieeww  

1. Open a Datasheet, or form in Form view.  

2. Click the record you want to delete. 

3. Click Delete Record on the toolbar.  

Note   When you delete data, you might want to delete related data in other tables. For 
example, if you delete a supplier, you probably want to delete the products that the 
supplier supplies. In some cases, you can make sure the proper data is deleted by 
enforcing referential integrity and turning on cascade deletions. 
  
IInnsseerrtt  aa  ddeeffaauulltt  vvaalluuee  iinn  aa  ffiieelldd  

1. Open a Datasheet. 

2. Click in the field in which you want to insert the default value. 

3. Press CTRL+ALT+SPACEBAR.  

Note   To see the default value in a Microsoft Access database, open the table in table 
Design view and look at the DefaultValue property. To see the default value in a 
Microsoft Access project, display the Column Properties view in a database diagram 
and look at the Default Value column property. 
  
EEddiitt  tthhee  ddaattaa  iinn  aa  ffiieelldd  iinn  DDaattaasshheeeett  oorr  FFoorrmm  vviieeww  

1. Open a Datasheet, or form in Form view.  

2. To edit data within a field, click in the field you want to edit.  

To replace the entire value, move the pointer to the leftmost part of the field until 
it changes into the plus pointer and then click.  

3. Type the text you want to insert.  

Notes    

• If you make a typing mistake, press BACKSPACE. If you want to cancel your 
changes in the current field, press ESC. If you want to cancel your changes in 
the entire record, press ESC again before you move out of the field. 



 

 
 

• When you move to another record, Microsoft Access saves your changes.  

SSppeecciiffyy  aa  zzeerroo--lleennggtthh  ssttrriinngg  iinn  DDaattaasshheeeett  oorr  FFoorrmm  vviieeww  ttoo  iinnddiiccaattee  
nnoonneexxiisstteenntt  ddaattaa  

1. Open a Datasheet, or form in Form view.  

2. Type double (" ") quotation marks without a space to enter a zero-length string in 
the field.  

The field remains a zero-length string, even though the quotation marks disappear when 
you move to another field or object.  
Notes    

• In a Microsoft Access database, if Access displays a message saying "Field can't 
be a zero-length string," then change the AllowZeroLength field property. To 

learn about changing this property, click . 

• In a Microsoft Access project, you can only enter a zero-length string in a field 
with the varchar or nvarchar data type in a Microsoft SQL Server 7.0 database. 
Zero-length strings are not supported in SQL Server 6.5.  

UUnnddoo  cchhaannggeess  wwhheenn  aaddddiinngg  oorr  eeddiittiinngg  rreeccoorrddss  iinn  DDaattaasshheeeett  oorr  FFoorrmm  
vviieeww  

• Click Undo on the toolbar to take back your most recent change. 

• Click Undo Saved Record on the Edit menu if you have already saved changes 
to the current record, or have moved to another record.  

As soon as you begin editing another record, apply or remove a filter, or switch to 
another window, you can't use these methods for correcting changes. 
  
HHooww  aa  ffiieelldd''ss  ddaattaa  ttyyppee  aanndd  vvaalliiddaattiioonn  cchheecckkiinngg  aaffffeecctt  ddaattaa  eennttrryy  iinn  
DDaattaasshheeeett  oorr  FFoorrmm  vviieeww  
 
When you try to move out of a field after changing data, Microsoft Access validates the 
data, making sure that the value you entered is allowed in that field. If the value isn't 
allowed, Microsoft Access alerts you. In order to move off the field, you must either 
change the data to an acceptable value or undo your changes. 
A value might not be allowed in a field for the following reasons:  

• The value isn't compatible with the field's data type. If you enter a value that 
doesn't match the data type, Microsoft Access attempts to convert the entry to 
the correct data type. However, some data can't be converted to other data 



 

 
 

types. For example, you can't store a name in a field with the Number data type 
in a Microsoft Access database or the smallint data type in a Microsoft Access 
project. 

• The data breaks a rule set in the ValidationRule property for the field. 

• Data is required in the field, and you've tried to leave it blank. 

• The validation macro specified for the BeforeUpdate property canceled the 
update.  

Microsoft Access also validates data when you move out of a record. Before it saves a 
record, Microsoft Access makes sure it doesn't break any validation rules set in the 
ValidationRule property for the record. Additionally, if the table you are editing has a 
primary key or unique index, Microsoft Access makes sure that the record you are 
editing doesn't have the same value for the field or fields as another record in the table. 
If the record can't be saved, you must either make any necessary corrections or click 
Undo to cancel all changes you made to the record. 
  
SSeelleeccttiinngg  ffiieellddss  aanndd  rreeccoorrddss  iinn  DDaattaasshheeeett  vviieeww  
The following table lists mouse techniques for selecting data or records in Datasheet 
view. 

To select Click 

Data in a field Where you want to start selecting and drag across the 
data. 

An entire field The left edge of the field in a datasheet, where the 

pointer changes into . 

Adjacent fields The left edge of a field and drag to extend the 
selection. 

A column The field selector. 

Adjacent columns The field name at the top of the column and then, 
without releasing the mouse, drag to extend the 
selection. 

A record The record selector. 

Multiple records The record selector of the first record, and then drag 
to extend the selection. 

All records Select All Records on the Edit menu. 

 



 

 
 

The following table lists keyboard techniques for selecting data or records in Datasheet 
view. 

To select Do this 

Data in a field Move the insertion point to the start of the text you 
want to select, and then hold down SHIFT and press 
the arrow keys to move to the end of the selection. 

An entire field Move the insertion point to the field, and press F2. 

Adjacent fields With a field selected, hold down SHIFT and press the 
appropriate arrow key. 

The current column Press CTRL+SPACEBAR. 

The current record Press SHIFT+SPACEBAR. 

Multiple records Press SHIFT+SPACEBAR, and then SHIFT+UP 
ARROW or SHIFT+DOWN ARROW. 

WWhheenn  ccaann  II  uuppddaattee  ddaattaa  ffrroomm  aa  qquueerryy??  
 
In some cases, you can edit the data in query Datasheet view to change the data in the 
underlying table. In other cases, you can't. The following table shows whether a query's 
results can be updated, and if not, whether there is an alternative. 

Query or query field Updatable Solution 

Query based on one table Yes   

Query based on tables with a one-
to-one relationship 

Yes   

Query based on tables with a one-
to-many relationship 

Usually 
For more information, click . 

Query based on three or more 
tables in which there is a many-to-
one-to-many relationship. 

No Though you can't update the data 
in the query directly, you can 
update the data in a form or data 
access page based on the query if 
the form's RecordsetType 
property is set to Dynaset 
(Inconsistent Updates). 

Crosstab query No   

SQL pass-through query No   

Query that calculates a sum, 
average count or other type of

No By using a domain aggregate 
function in the Update To row of



 

 
 

total on the values in a field, or an 
update query that references a 
field in the Update To row from 
either a crosstab query, select 
query, or subquery that contains 
totals or aggregate functions 

an update query, you can 
reference fields from either a 
crosstab query, select query, or 
subquery that contains totals or 
aggregate functions. For more 

information, click . 

Union query No   

Query whose UniqueValues 
property is set to Yes 

No   

Query that includes a linked 
ODBC table with no unique index, 
or a Paradox table without a 
primary key 

No   

Query (or underlying table) for 
which Update Data permission 
isn't granted 

Can delete 
but not update 

To modify data, permissions must 
be assigned. For more 

information, click . 

Query (or underlying table) for 
which Delete Data permission isn't 
granted 

Can update 
but not delete 

To delete data, permissions must 
be assigned. For more 

information, click . 

Query that includes more than one 
table or query, and the tables or 
queries aren't joined by a join line 
in Design view 

No You must join the tables properly 
in order to update them. For more 

information, click . 

Calculated field No   

Field is read-only; the database 
was opened as read-only or is 
located on a read-only drive 

No   

Field in record that has been 
deleted or locked by another user 

No A locked record should be 
updatable as soon as it is 
unlocked. 

Memo, Hyperlink, or OLE Object 
field in the query's results 

Yes  

  
CCooppyy  oorr  mmoovvee  aa  ffiieelldd,,  ccoonnttrrooll,,  tteexxtt,,  mmaaccrroo  aaccttiioonn,,  oorr  ootthheerr  iitteemm  
 



 

 
 

You can copy or move items such as fields, controls, text, or macro actions. You can 
also copy database objects. Learn more about copying database objects.  

1. Select the items you want to copy or move. 

2. To copy the item, click Copy on the toolbar.  

To move the item, click Cut on the toolbar.  

3. Click the location where you want to place the item. 

4. Click Paste on the toolbar.  

Notes    

• When you copy a field, control, or macro action, Microsoft Access includes any 
associated properties, controls, or action arguments. For example, when you 
copy a text box control, Access copies its label as well. When you copy an action 
by clicking the row selector, Access copies the associated action arguments, 
macros, and conditional expressions.  

• Access doesn't copy event procedures associated with a control. 

• You can use the Office Clipboard to collect and paste multiple data items such as 
records or groups of records, or the contents of fields or controls. However, you 
cannot use the Office Clipboard to collect items such as controls, macro actions, 
or database objects. Learn more about collecting and pasting multiple items.  

SSeelleecctt  ffiieellddss  aanndd  rreeccoorrddss  iinn  PPaaggee  vviieeww  
The following table lists mouse techniques for selecting data or records in Page view. 

To select Click 

Data in a field Where you want to start selecting and drag across the 
data. 

An entire field Three times 

A record On a grouped data access page, click any field. 

 
The following table lists keyboard techniques for selecting data or records in Page view. 

To select Do this 

Data in a field Move the insertion point to the start of the text you 
want to select, and then hold down SHIFT and press 
the arrow keys to move to the end of the selection. 



 

 
 

An entire field Move the insertion point to anywhere in the field and 
press HOME, SHIFT+END 

A record On a grouped data access page, press TAB 

 
Note   Your data access page may have a PivotTable list or spreadsheet control and 
they have their own methods of selection. To display Help for a PivotTable list or 
spreadsheet, click Help on that feature's toolbar. 
  
EEnntteerr  aa  hhyyppeerrlliinnkk  bbyy  ppaassttiinngg  aa  hhyyppeerrlliinnkk  oorr  hhyyppeerrlliinnkk  aaddddrreessss  

1. Navigate to a hyperlink or hyperlink address in one of the following ways:  
o Open a Microsoft Office document that contains a defined hyperlink. 

o Open a document that was created with any application and contains a 
valid hyperlink address that is not defined as a hyperlink. 

o Open a Web browser such as Microsoft Internet Explorer.  
2. Do one of the following:  

o In a Microsoft Office document, right-click the defined hyperlink. Point to 
Hyperlink on the shortcut menu, and then click Copy Hyperlink. 

o In any document, select the hyperlink address, and then click Copy on the 
Edit menu. 

o In Internet Explorer, select the address in the Address box or select a 
valid hyperlink address anywhere on a page, right-click, and then click 
Copy or Copy Shortcut.  

Note   If you're copying a defined hyperlink from an Office document, make sure 
to copy just the hyperlink. If you copy characters that surround but aren't part of 
the hyperlink, then Microsoft Access will link to the text that you selected instead 
of the address of the hyperlink.  

3. Switch to Microsoft Access and do one of the following:  
o In a Microsoft Access database (.mdb), open the table or query in 

Datasheet view.  

o In an Access database or Microsoft Access project (.adp), open the form 
in Datasheet view or Form view,  

4. Place the insertion point in the hyperlink field in the datasheet or in the text box 
or other control that accepts hyperlinks on the form. 

5. Do one of the following:  
o To paste a defined hyperlink, click Paste As Hyperlink on the Edit menu. 



 

 
 

o To paste a hyperlink address that isn't defined as a hyperlink, click Paste 
on the Edit menu. When you paste an address this way, Microsoft Access 
recognizes the protocol in the address and converts the text to a hyperlink.  

Microsoft Access adds the hyperlink to the field or control. You can click the 
hyperlink to open the target document or Web page.  

EEnntteerr  aa  hhyyppeerrlliinnkk  bbyy  ddrraaggggiinngg  aann  IInntteerrnneett  sshhoorrttccuutt  

1. In Microsoft Access, do one of the following:  
o In a Microsoft Access database (.mdb), open the table or query in 

Datasheet view.  

o In an Access database or Microsoft Access project (.adp), open the form 
in Datasheet or Form view, or the data access page in Page view.  

2. Navigate to an Internet shortcut (an icon on your desktop or an item in the 
History subfolder of your Windows folder). 

3. Select the Internet shortcut. 

4. Right-click the selection and drag the shortcut to the hyperlink field in the 
datasheet or to the text box or other control that accepts hyperlinks on the form 
or data access page.  

Microsoft Access adds the hyperlink to the field or control. On a form or 
datasheet, you can click the hyperlink to open the target document or Web page. 
On a data access page, the text box in which you enter a hyperlink address 
doesn’t format the address as a hyperlink. Look for the address formatted as 
hyperlink elsewhere on the page.  

Tip   Click the Refresh button on the Internet Explorer toolbar to see the hyperlink 
address displayed as a formatted hyperlink. 
  
TTyyppee  aa  hhyyppeerrlliinnkk  iinn  aa  ffiieelldd  oorr  tteexxtt  bbooxx  

1. Open the table, query, or form in Datasheet view, the form in Form view, or the 
data access page in Page view. 

2. Place the insertion point in the hyperlink field in the datasheet or in the text box 
or other control that accepts hyperlinks on the form or data access page.  

3. Type a valid hyperlink address. A hyperlink address can have up to four parts 
separated by the number sign (#):  

Notes    



 

 
 

• In a Microsoft Access database (.mdb), you can open the target document or 
Web page by clicking the hyperlink in a table, query, or form in Datasheet view or 
a form in Form view.  

• In a Microsoft Access project (.adp), you can open the target document or Web 
page by clicking the hyperlink in a form in Form view or Datasheet view. In 
Datasheet view of a table, query, or stored procedure, the hyperlink address is 
displayed as a text string, not as a formatted hyperlink. 

• In a data access page, the text box in which you enter a hyperlink address 
displays the hyperlink address as a text string, not as a formatted hyperlink. Look 
for the address formatted as hyperlink elsewhere on the page.  

The ScreenTip displayed for a hyperlink on a data access page is defined for the 
hyperlink control, so a ScreenTip that you enter won’t be displayed on the page.  

Click the Refresh button on the Microsoft Internet Explorer toolbar to see the 
hyperlink address displayed as a formatted hyperlink on the data access page.  

AAdddd,,  cchhaannggee,,  oorr  ddeelleettee  tthhee  ppaatthh  ttoo  aa  ppiiccttuurree  iinn  PPaaggee  vviieeww  
Note   The picture is not stored in the database. Rather, the path to the picture's 
location is stored in the database, and the picture is stored in a computer's file system.  

1. Move to the record or use a filter to find the record containing the path to the 
picture you want to add, change, or delete. 

2. Click inside the field containing the path to the picture.  

3. Do one of the following:  

To add the path to the picture, type in the path of the picture's location.  

To change the path to the picture, edit the path. Learn about editing a field.  

To delete the path to the picture, select the entire contents of the field and press 
the DEL key.  

Notes  

• To see your results in the data access page, explicitly save the record, and then 
refresh the data access page.  

• The path can be a relative path, a path on your computer, a universal naming 
convention (UNC) path, or a uniform resource locator URL. The type of path you 
should use depends on the requirements of the database.  



 

 
 

• To delete the actual picture, you must delete it from its location in the file system. 
This capability may not be in the page, depending on how it was authored. See 
Microsoft Windows Help for more information on deleting files.  

CCooppyy  oorr  mmoovvee  rreeccoorrddss  ttoo  aa  ddaattaasshheeeett  

1. Open a Datasheet, or form in Form view.  

2. Select the record or records you want to copy or move.  

Note   If you're copying or moving records from another application, be sure the 
data is arranged in a spreadsheet or table, or separated by tab characters, 
before you select it.  

3. To copy records, click Copy on the toolbar.  

To move records, click Cut on the toolbar.  

4. Open the datasheet you want to paste the records into. If necessary, rearrange 
the columns of the datasheet to match the order of the data you are copying or 
moving. 

5. To replace records with the records you selected, select the records you want to 
replace, and then click Paste on the toolbar.  

To append records to the end of the datasheet, click Paste Append on the Edit 
menu.  

If the source datasheet has more fields than the destination datasheet, Microsoft 
Access doesn't paste the extra fields. For information on troubleshooting paste 
problems 
  
DDiissppllaayy  ddaattaa  ffrroomm  aa  ffiieelldd  iinn  aa  ttaabbllee  oorr  aa  qquueerryy  

1. Open a form in Design view, a report in Design view, or a data access page in 
Design view. 

2. If you want to use a wizard to help you create the control, make sure that the 
Control Wizards tool in the toolbox is pressed in.  

 

Notes  

o On forms and reports, you can use wizards to create command buttons, 
list boxes, subforms, combo boxes, and option groups. On data access 



 

 
 

pages, you can use wizards to create command buttons, list boxes, and 
drop-down list boxes. 

o Wizards are not available in a stand-alone data access page, or when you 
point a data access page to a database other than the one currently open. 
In this case, you will have to create the control without using a wizard.  

3. Display the field list by clicking Field List on the toolbar. 

4. Do one of the following:  
o Select one or more fields in the field list on a form or report.  

To select Do this 

One field Click the field. 

A block of fields Click the first field in the block, hold down the SHIFT 
key, and then click the last field in the block. 

Nonadjacent fields Hold down the CTRL key and click the name of each 
field that you want to include. 

All fields Double-click the field list title bar. 

5.  
o Select a field, table, or query in the field list on a data access page.  

To select Do this 

One field Click the field. 

A table or query 
Click the Wizards tool in the toolbox if it's not 
already pressed in, and click the table or query. 

6. Do one of the following:  
o Drag the field(s) from the field list and position them on the form or report. 

o Drag the field, table, or query from the field list and position it on the data 
access page. In the Layout Wizard dialog box, click Individual Controls. 

o Note   You must drag the field(s), table, or query from the field list. If you 
click the field(s), table, or query in the field list and then click the form, 
report, or data access page, Microsoft Access won't create the control. 
Access places one text box on the form, report, or data access page for 
each field that you select in the field list. If you select a table or query in 
the data access page field list, Access places a text box for each field in 



 

 
 

the table or query on the data access page. Each text box is bound to one 
field in the underlying data source. Each text box also has an attached 
label by default.  

7. Place the upper-left corner of the icon where you want the upper-left corner of 
the main control (not its label) to be, and release the mouse button.  

Notes  

• Access creates the appropriate control for the field and sets certain properties, 
based on the field's data type. If this isn't the type of control that you want to 
create, click the appropriate control tool in the toolbox before dragging the field 
from the field list. In a form or report, controls are also created based on the 
settings of the DisplayControl property. To read about the DisplayControl 
property 

• In forms and reports, you can also change a control to another type of control 
after you create it.  

CChheecckk  tthhee  ssppeelllliinngg  ooff  ddaattaa  iinn  DDaattaasshheeeett  vviieeww  

1. Open a Datasheet. 

2. Select the records, columns, fields, or text within a field whose spelling you want 
to check.  

3. Click Spelling on the toolbar.  

Notes    

• In the Spelling dialog box, click Add if you want to add the word that is in the 
Not In Dictionary box to the custom dictionary listed in the Add Words To box. 

• If a datasheet contains subdatasheets, Microsoft Access only checks the spelling 
of the datasheet or subdatasheet where you have placed the insertion point.  

AAuuttoommaattiiccaallllyy  ccoorrrreecctt  ttyyppiinngg  wwhheenn  II''mm  eenntteerriinngg  ddaattaa  
Use AutoCorrect to automatically correct text that you frequently mistype, and to 
automatically replace abbreviations with long names. For example, you can create an 
entry "esq" for "Martin R. Esquivel." Whenever you type esq followed by a space or 
punctuation mark, Microsoft Access automatically replaces "esq" with the name Martin 
R. Esquivel.  

1. On the Tools menu, click AutoCorrect. 

2. Select the Replace text as you type check box. 

3. In the Replace box, type the text that you want corrected automatically. 



 

 
 

4. In the With box, type the corrected text. 

5. Click Add.  

Notes    

• AutoCorrect won't correct text that was typed before you selected the Replace 
text as you type check box. 

• If in the preceding example you actually want "esq" to appear in one case, clear 
the Replace text as you type box, type esq in a field and save the field by 
moving to another record. Then select the Replace text as you type box again. 
Microsoft Access will not change the previously typed and saved "esq." 

• AutoCorrect works with text in a Datasheet or text in a form in Form view.  

 
AAbboouutt  ffiinnddiinngg  oorr  rreeppllaacciinngg  ddaattaa  
WWaayyss  ttoo  ffiinndd  oorr  rreeppllaaccee  ddaattaa  
There are many ways in Microsoft Access to find or replace just the data you need, 
whether you're looking for a particular value, one record, or a group of records.  

• You can find a record by scrolling in a datasheet or form, or by typing its record 
number in the record number box. 

• With the Find dialog box, you can locate specific records or find certain values 
within fields. You can navigate through records as Access finds each occurrence 
of the item you're looking for. If you want to replace certain values that you find, 
use the Replace dialog box instead. 

• With a filter, you can temporarily isolate and view a specific set of records to work 
with while you have a form or datasheet displayed. 

• With a query, you can work with a specific set of records that meet criteria you 
specify from one or more tables in the database. You can work with this subset 
independent of a specific form or datasheet by running the query.  

TThhee  eeffffeecctt  ooff  tthhee  mmaaxxiimmuumm  rreeccoorrdd  lliimmiitt  iinn  aa  MMiiccrroossoofftt  AAcccceessss  pprroojjeecctt  
When you attempt to find or replace data in a Microsoft Access project, Access 
performs the operation only on the data that is stored on the client. If your datasheet or 
form has reached its maximum record limit, there is more data on the server. To ensure 
that you are finding or replacing all the data on the server, set the maximum record limit 
to no limit by using the maximum record limit button to the right of the navigation 
buttons. 
 



 

 
 

AAbboouutt  uussiinngg  wwiillddccaarrdd  cchhaarraacctteerrss  ttoo  sseeaarrcchh  ffoorr  ppaarrttiiaall  oorr  mmaattcchhiinngg  
vvaalluueess    
You use wildcard characters as placeholders for other characters when you are 
specifying a value you want to find and you:  

• Know only part of the value. 

• Want to find values that start with a specific letter or match a certain pattern.  

In a Microsoft Access database, you can use the following characters in the Find and 
Replace dialog boxes, or in queries, commands, and expressions, to find such things 
as field values, records, or file names. 
 

Character Usage Example 

* Matches any number of characters. 
It can be used as the first or last 
character in the character string. 

wh* finds what, white, and 
why 

? Matches any single alphabetic 
character. 

B?ll finds ball, bell, and bill 

[ ] Matches any single character 
within the brackets. 

B[ae]ll finds ball and bell but 
not bill 

! Matches any character not in the 
brackets. 

b[!ae]ll finds bill and bull but 
not bell 

- Matches any one of a range of 
characters. You must specify the 
range in ascending order (A to Z, 
not Z to A). 

b[a-c]d finds bad, bbd, and 
bcd 

# Matches any single numeric 
character. 

1#3 finds 103, 113, 123 

 
Notes    

• Wildcard characters are meant to be used with text data types, although you can 
sometimes use them successfully with other data types, such as dates, if you 
don't change the Regional Settings properties for these data types. 

• When using wildcard characters to search for an asterisk (*), question mark (?), 
number sign (#), opening bracket ([), or hyphen (-), you must enclose the item 
you're searching for in brackets. For example, to search for a question mark, type 
[?] in the Find dialog box. If you're searching for a hyphen and other characters 
simultaneously, place the hyphen before or after all the other characters inside 



 

 
 

the brackets. (However, if you have an exclamation point (!) after the opening 
bracket, place the hyphen after the exclamation point.) If you're searching for an 
exclamation point (!) or closing bracket (]), you don't need to enclose it in 
brackets. 

• You can't search for the opening and closing brackets ([ ]) together because 
Microsoft Access interprets this combination as a zero-length string. You must 
enclose the opening and closing brackets in brackets ([[ ]]). 

• A Microsoft Access project uses different wildcard characters than an Access 
database uses. For more information, search the Microsoft SQL Server Books 
Online index for "wildcard characters". If you're searching for values in any other 
data source, you may need to use different wildcard characters. Check the 
documentation for that data source for more information.  

 
FFiinndd  aa  ssppeecciiffiicc  rreeccoorrdd  bbyy  ssccrroolllliinngg  iinn  aa  DDaattaasshheeeett  oorr  ffoorrmm  
If there are more records than fit in your Datasheet view or continuous form window, 
you can use the scroll box on the scroll bar to find a specific record.  

• Drag the scroll box up or down on the scroll bar.  

Next to the scroll box, Microsoft Access displays the number of the record at the top of 
the screen. 
If you have a Microsoft IntelliMouse, you can use the wheel button to scroll to a specific 
record depending on your current view. 

View Wheel button behavior Cursor behavior 

Datasheet, or subform 
displayed as a datasheet 

Scrolls row by row  Does not move 

Single form or subform 
displayed as a single 
form 

Goes to the next or previous 
record 

Goes to the next or 
previous record 

Continuous form or 
subform displayed as a 
continuous form 

Goes to the next or previous 
record 

Does not move 

 
 
FFiinndd  ssppeecciiffiicc  ooccccuurrrreenncceess  ooff  aa  vvaalluuee  iinn  aa  ffiieelldd  

For information on finding Null values and zero-length strings, click .  

 



 

 
 

1. In Form or Datasheet view, select the field (column) you want to search, unless 
you want to search all fields. (Searching a single field is faster than searching the 
entire form or datasheet.) 

2. Click Find on the toolbar. 

3. In the Find What box, type the value you want to find.  

If you don't know the exact value you want to find, you can use wildcard 
characters in the Find What box to specify what you're looking for. For examples 
of wildcard characters and how to use them,  

4. Set any other options you want to use in the Find dialog box. Click More for 
additional options. 

5. Click Find Next.  

Notes  

• When looking for values in a datasheet with a subdatasheet, or form with a 
subform displayed as a datasheet, Microsoft Access only looks in the datasheet, 
subdatasheet, or form where you’ve placed the insertion point. 

• In the Code window, the Find dialog box has additional options specific to the 
Visual Basic Editor. You can specify the range of the search by selecting an 
option in the Search options group. Note that Access searches procedures 
based on the order they were added to the module. The Use Pattern Matching 
check box uses the same semantics as the Like Operator uses.  

RReeppllaaccee  ssppeecciiffiicc  ooccccuurrrreenncceess  ooff  aa  vvaalluuee  iinn  aa  ffiieelldd  
You can replace all occurrences of the specified value at once or each occurrence one 
at a time. If you want to find Null values and zero-length strings, however, you must use 
the Find dialog box to find these occurrences, and then replace them manually.  
In Form or Datasheet view, select the field (column) you want to search, unless you 
want to search all fields. (Searching a single field is faster than searching the entire 
datasheet or form.) 

1. On the Edit menu, click Replace. 

2. In the Find What box, type the value you want to find; in the Replace With box, 
type the value you want to replace it with.  

If you don't know the exact value you want to find, you can use wildcard 
characters in the Find What box to specify what you're looking for. For examples 

of wildcard characters and how to use them, click .  



 

 
 

3. Set any other options you want to use in the Replace dialog box. Click More for 
additional options. 

4. To replace all occurrences of the specified value at once, click Replace All.  

To replace each occurrence one at a time, click Find Next, and then click 
Replace; to skip an occurrence and find the next one, click Find Next.  

Notes    

• In a Microsoft Access database, you can replace large amounts of data more 
quickly or perform calculations on data (such as raising all salaries in an 
Employee table by 5 percent) by using an update query instead of the Replace 
dialog box. However, you can't confirm individual replacements when using an 
update query and an update query isn't as convenient when you want to search 
for and replace data in more than one field. In a Microsoft Access project, you 
can use a stored procedure to update large amounts of data. 

• When replacing data in a datasheet with a subdatasheet, or form with a subform 
displayed as a datasheet, Microsoft Access only replaces data in the datasheet, 
subdatasheet, or form where you’ve placed the insertion point. 

• In the Code window, the Replace dialog box has additional options specific to 
the Visual Basic Editor. You can specify the range of the search by selecting an 
option in the Search options group. Note that Access searches procedures 
based on the order they were added to the module. The Use Pattern Matching 
check box uses the same semantics as the Like Operator uses.  

 
CChhaannggee  ddeeffaauulltt  bbeehhaavviioorr  ffoorr  ffiinndd  oorr  rreeppllaaccee  ooppeerraattiioonnss  

1. On the Tools menu, click Options. 

2. Click the Edit/Find tab. 

3. Under Default Find/Replace Behavior, click the option you want to use.  

Note   Changes made to this setting don't take effect until the next time you start 
Microsoft Access. To change the behavior for a specific find or replace operation, 
choose Find or Replace from the Edit menu, and then set the appropriate options in 
the dialog box. 
 
FFiinndd  bbllaannkk  ffiieellddss  oorr  zzeerroo--lleennggtthh  ssttrriinnggss  uussiinngg  tthhee  FFiinndd  ddiiaalloogg  bbooxx  

1. In Form or Datasheet view, click in the field (column) you want to search, and 
then click Find on the toolbar.  



 

 
 

2. Click More, if necessary. 

3. Do one of the following:  
o If blank fields are formatted (such as "Unknown"), type the formatted 

string, and make sure that the Search Fields As Formatted check box is 
selected. To find unformatted blank fields in a Microsoft Access database, 
in the Find What box, type Null or Is Null, and make sure that the Search 
Fields As Formatted check box is not selected.  

o To find zero-length strings, in the Find What box, type double quotation 
marks (""), with no spaces in between, and make sure that the Search 
Fields As Formatted check box is not selected.  

4. In the Search box, select Up or Down. 

5. In the Match box, make sure that Whole Field is selected. 

6. In the Look In box, select the field to search. 

7. To find one or more occurrences of a blank, click Find Next.  

 
SSiimmiillaarriittiieess  aanndd  ddiiffffeerreenncceess  bbeettwweeeenn  sseelleecctt  qquueerriieess  aanndd  ffiilltteerrss  
The basic similarity between select queries and filters is that they both retrieve a subset 
of records from an underlying table or query. How you want to use the records that are 
returned determines whether you use a filter or a query. 
Generally, use a filter to temporarily view or edit a subset of records while you're in a 
form or datasheet. Use a query if you want to do any or all of the following:  

• View the subset of records without first opening a specific table or form. 

• Choose the tables containing the records you want to work with and add more 
tables at a later date if necessary. 

• Control which fields from the subset of records display in the results. 

• Perform calculations on values in fields.  

Note   Even if you determine you need a query, consider taking advantage of the easy 
Filter By Form, Filter By Selection, or Filter For Input techniques for creating a filter, and 
then saving the filter as a query. This enables you to bypass the query's design grid 
altogether (unless you want to make additional changes to the query). Even so, when 
you open the query in Design view, you'll see how Microsoft Access filled in the design 
grid using the information from the filter. You can then use this information as a guide 
for making additional changes. 
The following table identifies the similarities and differences between queries and filters.  

Characteristics Filters Queries 



 

 
 

Enable you to add more tables if 
you want to include their records in 
the subset that's returned 

No Yes 

Enable you to specify which fields 
you want to display in the results 
from the subset of records 

No  Yes 

Appear as a separate object in the 
Database window 

No Yes 

Can be used on a closed table, 
query, or form 

No Yes 

Produce results that can be used 
as the source of data for a form or 
report 

Yes Yes 

Can calculate sums, averages, 
counts, and other types of totals 

No Yes 

Can sort records Yes Yes 

Enable you to edit data if editing is 
otherwise allowed 

Yes Yes, depending on the type of query. 
You can also perform bulk updates 
with an update query. 

 
 
CCoommppaarriissoonn  ooff  ffiilltteerriinngg  mmeetthhooddss  ffoorr  ttaabblleess,,  qquueerriieess,,  oorr  ffoorrmmss  
 

What do you want 
the filter to do? 

 
Filter By Selection 

Filter By Form and 
Filter For Input 

 
Advanced 
Filter/Sort 

Search for records 
that meet multiple 
criteria. 

Yes (but you must 
specify the criteria 
one at a time) 

Yes (and you can 
specify the criteria  
all at once) 

Yes (and you can 
specify the criteria 
all at once) 

Search for records 
that meet one 
criteria or another 
criteria. 

No Yes Yes 

Allow you to enter 
expressions as 
criteria. 

No Yes Yes 



 

 
 

Sort records in 
ascending or 
descending order. 

No (however, after 
applying the filter, 
you can sort all 
filtered records by 
clicking Sort 

Ascending or 
Sort Descending 

on the toolbar) 

No (however, after 
applying the filter, 
you can sort all 
filtered records by 
clicking Sort 

Ascending or 
Sort Descending 

on the toolbar) 

Yes (you can sort 
some fields in 
ascending order 
and other fields in 
descending order) 

 
 
FFiilltteerr  rreeccoorrddss  bbyy  sseelleeccttiinngg  vvaalluueess  iinn  aa  ffoorrmm  oorr  ddaattaasshheeeett  

1. In a field on a form, subform, datasheet, or subdatasheet, find one instance of 
the value you want records to contain in order to be included in the filter's results. 

2. Select the value, and then click Filter By Selection on the toolbar. How you 
select the value determines what records the filter returns. For more information 

on selecting values, click .  

Repeat step 2 until you have the set of records you want.  

Notes  

• When you save a table or form, Microsoft Access saves the filters you created. 
You can reapply the filters when you need them, the next time you open the table 
or form. 

• When you save a query, Microsoft Access saves the filters you created, but it 
does not add the filter criteria to the query design grid. You can reapply the filters 
after you run the query, the next time you open it. 

• If you created a filter on a subdatasheet or subform, this filter is also available 
when you open the table or form for the subdatasheet or subform independently. 

• You can also filter for records that do not have a certain value. After selecting a 
value, right-click it, and then click Filter Excluding Selection. 

• For information on creating a form or report based on the filtered data, click .  

 



 

 
 

FFiilltteerr  rreeccoorrddss  bbyy  eenntteerriinngg  vvaalluueess  iinn  aa  bbllaannkk  vviieeww  ooff  yyoouurr  ffoorrmm  oorr  
ddaattaasshheeeett    

1. Open a table, query, or form in Datasheet view or open a form in Form view.  

To filter records in a subdatasheet, display the subdatasheet by clicking its 
expand indicator.  

2. Click Filter By Form on the toolbar to switch to the Filter By Form window.  

You can specify criteria for the form, subform, main datasheet, or any 
subdatasheet that's displayed. Each subdatasheet or subform has its own Look 
For and Or tabs.  

3. Click the field in which you want to specify the criteria that records must meet to 
be included in the filtered set of records. 

4. Enter your criteria by selecting the value you're searching for from the list in the 
field (if the list includes field values), or by typing the value into the field.  

o To find records in which a check box, toggle button, or option button is or 
is not selected, click the check box or button until it's the way you want. To 
return it to a neutral position so that it won't be used as criteria for filtering 
records, continue clicking the check box or button until it's grayed.  

o To find records in which a particular field is empty or not empty, type Is 
Null or Is Not Null into the field. (You can select these options from the 
list in fields with a Memo, OLE Object, or Hyperlink data type, and in 
calculated fields in queries.) 

o To find records using a criteria expression, type the expression into the 
appropriate field or enter one using the Expression Builder.  

o If you specify values in more than one field, the filter returns records only if 
they contain the same values you specified in each of those fields.  

5. To specify alternative values that records can have to be included in the filter's 
results, click the Or tab for the datasheet, subdatasheet, form, or subform you're 
filtering, and enter more criteria.  

The filter returns records if they have all the values specified on the Look For tab 
or all the values specified on the first Or tab or all the values specified on the 
second Or tab, and so on.  

6. Click Apply Filter on the toolbar.  

Notes    



 

 
 

• When you save a table or form, Microsoft Access saves the filters you created. 
You can reapply the filters when you need them, the next time you open the table 
or form. 

• If you created a filter on a subdatasheet or subform, this filter is also available 
when you open the table or form for the subdatasheet or subform independently. 

• When you save a query, Microsoft Access saves the filters you created, but it 
does not add the filter criteria to the query design grid. You can reapply the filters 
after you run the query, the next time you open it. 

• For information on creating a form or report based on the filtered data, click .  

 
FFiilltteerr  rreeccoorrddss  bbyy  eenntteerriinngg  ccrriitteerriiaa  iinn  ppllaaccee  iinn  aa  ffoorrmm  oorr  ddaattaasshheeeett  

1. Open a table, query, or form in Datasheet view, or a form in Form view.  

To filter records in a subdatasheet, first click the expand indicator to display that 
subdatasheet.  

2. Do one of the following:  
o To specify the exact field value you want the filtered records to contain, 

right-click in the field in the datasheet, subdatasheet, form, or subform 
you're filtering, and then in the Filter For box on the shortcut menu, type 
the value. For example, to find all the records that have London in the City 
field, right-click in the City field, and then type London in the Filter For 
box.  

o To specify more complex criteria, type the complete expression using the 
appropriate combination of identifiers, operators, wildcard characters, and 
values to produce the result you want. For example, to find all the records 
where the Contact Title field includes the word "Marketing" anywhere in 
the title, right-click in the Contact Title field, and then type *Marketing* in 
the Filter For box. To display only the records for orders that were 
shipped more than 15 days after the specified required date, type 
[ShippedDate]-[RequiredDate]>15. (In this last example, you don't have 
to right-click a specific field to enter the expression. However, in a 
datasheet with subdatasheets, first click in the sheet you want to filter.)  

3. Do one of the following:  
o To apply the filter and close the shortcut menu, press ENTER.  

o To apply the filter and keep the shortcut menu displayed (so that you can 
specify additional criteria for the field), press TAB. Enter new criteria, and 
then press TAB again. Repeat until you have just the records you want.  



 

 
 

Notes  

• When you save a table or form, Microsoft Access saves the filters you created. 
You can reapply the filters when you need them, the next time you open the table 
or form. 

• When you save a query, Microsoft Access saves the filters you created, but it 
does not add the filter criteria to the query design grid. You can reapply the filters 
after you run the query, the next time you open it.  

 
FFiilltteerr  rreeccoorrddss  bbyy  uussiinngg  tthhee  AAddvvaanncceedd  FFiilltteerr//SSoorrtt  wwiinnddooww  

1. Open a table, query, or form in Datasheet view or open a form in Form view. 

2. Click in the datasheet, subdatasheet, form, or subform you want to filter. 

3. On the Records menu, point to Filter, and then click Advanced Filter/Sort. 

4. Add to the design grid the field or fields you'll need to specify the values or other 
criteria the filter will use to find records.  

5. To specify a sort order, click in the Sort cell for a field, click the arrow, and select 
a sort order.  

Microsoft Access first sorts the leftmost field in the design grid, then it sorts the 
next field to the right, and so on.  

6. In the Criteria cell for the fields you have included, enter the value you're looking 
for or enter an expression.  

7. Apply the filter by clicking Apply Filter on the toolbar.  

Notes  

• When you save a table or form, Microsoft Access saves the filters. You can 
reapply the filters when you need them, the next time you open the table or form. 

• When you save a query, Microsoft Access saves the filters you created, but it 
does not add the filter criteria to the query design grid. You can reapply the filters 
after you run the query, the next time you open it. 

• If you created a filter on a subdatasheet or subform, this filter is also available 
when you open the table or form for the subdatasheet or subform independently. 

• For information on creating a form or report based on the filtered data, click . 



 

 
 

• Instead of creating a filter from scratch, you can use an existing query as a filter. 

For more information, click .  

 
MMooddiiffyy  aa  ffiilltteerr  bbyy  uussiinngg  FFiilltteerr  BByy  SSeelleeccttiioonn  oorr  FFiilltteerr  EExxcclluuddiinngg  
SSeelleeccttiioonn  
You can modify the filter by adding more criteria or changing the existing criteria.  

1. To further limit a set of records that already has a filter applied, start with step 2. 
To change the criteria previously defined for a filter, first remove the filter if it is 
currently applied.  

2. In Form or Datasheet view, select a value in the form, subform, datasheet, or 
subdatasheet that you want to use as criteria, and then click either Filter By 
Selection on the toolbar or right-click the value and click Filter Excluding 
Selection on the shortcut menu. Repeat this process until you have the records 
you want.  

Note   You can also switch to the Filter By Form window or Advanced Filter/Sort window 
to change the criteria, including specifying alternative criteria (one criteria or another). 
 
MMooddiiffyy  aa  ffiilltteerr  bbyy  uussiinngg  FFiilltteerr  FFoorr  IInnppuutt  
You can modify the filter by adding more criteria or changing the existing criteria.  

1. To further limit a set of records that already has a filter applied, start with step 2. 
To change the criteria previously defined for a filter, first remove the filter if it is 
currently applied.  

2. In Form or Datasheet view, do one of the following:  
o Right-click the field you want to specify criteria for in the main form, 

datasheet, subform, or subdatasheet, and then in the Filter For box on 
the shortcut menu, type the value you want to use as criteria. 

o Right-click any field in the main form, datasheet, subform, subdatasheet, 
and specify the expression you want to use as criteria in the Filter For 
box.  

3. Press TAB and repeat step 2 until you have the records you want.  

For more information about using Filter For Input, click .  

Note   You can also switch to the Filter By Form window or Advanced Filter/Sort window 
to change the criteria. 
 
SSwwiittcchh  bbeettwweeeenn  ffiilltteerr  wwiinnddoowwss  iinn  aa  ttaabbllee,,  qquueerryy,,  oorr  ffoorrmm  
You can switch between windows to create or modify a filter by using the method that 
works best for your filtering needs, or to see a different view of an existing filter. Filter By 



 

 
 

Form and Advanced Filter/Sort have their own windows. However, you use Filter By 
Selection or Filter For Input directly in Form view or Datasheet view. 

To switch to From this window Do this 

Filter By Form Datasheet view or Form 
view 

On the toolbar, click Filter By Form 

. 

  Advanced Filter/Sort On the Filter menu, click Filter By 
Form. 

Advanced  
Filter/Sort 

Datasheet view or Form 
view 

On the Records menu, point to Filter, 
and then click Advanced Filter/Sort. 

  Filter By Form On the Filter menu, click Advanced 
Filter/Sort. 

 
To apply a filter from either Filter By Form or the Advanced Filter/Sort window and see 
the results in Datasheet view or Form view, click Apply Filter on the toolbar. To close 
either filter window and return to Datasheet view or Form view without applying the filter, 
click Close on the toolbar. 
Note   After specifying the values you're searching for by using Filter By Selection, Filter 
By Form, or Filter For Input, you can switch to the Advanced Filter/Sort window to see 
how the values you specified are translated into a criteria expression in the design grid. 
 
AAppppllyy  aa  ffiilltteerr  iinn  aa  ttaabbllee,,  qquueerryy,,  oorr  ffoorrmm  

• In a form, datasheet, or either filter window, click Apply Filter on the toolbar.  

Notes  

• When you apply a filter to a datasheet, Microsoft Access also applies filters you 
created in any subdatasheet within it. 

• Microsoft Access can apply a filter automatically when you open a form if you set 
the form's OnOpen property to a macro that uses the ApplyFilter action or to an 
event procedure that uses the ApplyFilter method of the DoCmd object.  

• If you create a filter in a form, subform, datasheet, or subdatasheet that already 
contained a filter from a previous working session, the new filter replaces the 
previous one.  

 
AAppppllyy  aann  eexxiissttiinngg  qquueerryy  aass  aa  ffiilltteerr  oonn  aa  ffoorrmm  oorr  ddaattaasshheeeett  
While you can save only one filter for each datasheet, subdatasheet, form, or subform, 
you can use queries that you've already created as additional filters. A query must meet 



 

 
 

certain requirements if you're going to use it as a filter. For more information on those 

requirements, click .  

1. Click in the datasheet, subdatasheet, form, or subform you want to filter. 

2. Switch to the Filter By Form window or the Advanced Filter/Sort window.  

3. On the toolbar, click Load From Query . 

4. In the Filter box, select a query, and then click OK. 

5. Click Apply Filter on the toolbar.  

Note   For information on creating a form or report based on the filtered data, click . 
 
RReemmoovvee  aa  ffiilltteerr  ffrroomm  aa  ttaabbllee,,  qquueerryy,,  oorr  ffoorrmm  

• To remove a filter and show the records that were displayed previously in the 
table, query, or form, click Remove Filter on the toolbar in Datasheet view or 
Form view. 

• To remove a filter in a multiuser (shared) database and see which records have 
been added, deleted, or changed since you opened the table, query, or form, 
click Remove Filter/Sort on the Records menu in Datasheet view or Form view.  

Notes  

• Removing a filter doesn't delete it. You can reapply the filter by clicking Apply 
FIlter on the toolbar. When you remove a filter from a datasheet, Microsoft 
Access also removes any filters you applied to any subdatasheet within it. 

• If you prefer, you can use the ShowAllRecords action in a macro or Visual Basic 
for Applications code to remove the filter.  

 
DDeelleettee  aa  ffiilltteerr  ffrroomm  aa  ttaabbllee,,  qquueerryy,,  oorr  ffoorrmm  
Use this procedure to delete any type of filter, regardless of what method you used to 
create it.  

1. Click in the datasheet, subdatasheet, form, or subform whose filter you want to 
delete. 

2. Switch to the Advanced Filter/Sort window.  
3. On the Edit menu, click Clear Grid. 



 

 
 

4. Click Apply Filter on the toolbar.  

 
RReemmoovvee  oorr  aappppllyy  aann  iinnhheerriitteedd  ffiilltteerr  iinn  aa  rreeppoorrtt  

1. Open the report in Design view, or if the report is already open, make sure it is 
selected. 

2. Click Properties on the toolbar to display the report's property sheet. 

3. In the FilterOn property box, click No to remove the filter or Yes to apply it.  

Notes  

• Microsoft Access can apply a filter automatically when you open a report if you 
set the report's OnOpen property to a macro that uses the ApplyFilter action or to 
an event procedure that uses the ApplyFilter method of the DoCmd object. You 
can also automatically apply a filter to a report using the OpenReport action or its 
corresponding method. 

• You can delete the filter if you want. For more information, click .  

 
HHooww  aa  ffiilltteerr  aanndd  ssoorrtt  oorrddeerr  ffoorr  aa  ttaabbllee  oorr  qquueerryy  aaffffeeccttss  nneeww  ffoorrmmss  oorr  
rreeppoorrttss  
When you create a form or report based on a table or query that has a filter or a sort 
order specified in it, Microsoft Access includes the filter and sort order with the form or 
report. The sort order is automatically applied. Whether or not the filter is automatically 
applied depends on how you create the form or report.  

• If you create the form or report directly from filtered data while the data is 
displayed in an open table or query, the filter is applied automatically each time 
you view the report, but it is applied only the first time you view the form after 
creating it. (The next time you open the form, you'll apply the filter yourself.) 

• If you create the form or report based on a closed table or query, the filter won't 
be applied in the new form or report. You apply it when you need it.  

 
MMooddiiffyy  aann  iinnhheerriitteedd  ssoorrtt  oorrddeerr  iinn  aa  rreeppoorrtt  

1. Open the report in Design view, or if the report is already open, make sure it is 
selected. 

2. Click Properties on the toolbar to display the report's property sheet. 



 

 
 

3. Click the OrderBy property box, and then specify the field and sort order you 
want to sort on.  

o To sort records in one field in ascending order, type the field name 
enclosed in brackets ([ ]) followed by ASC.  

[fieldname1] ASC  

o To sort records in one field in descending order, type the field name 
enclosed in brackets ([ ]) followed by DESC.  

[fieldname1] DESC  

o To sort records in more than one field in ascending or descending order, 
type the setting this way:  

[fieldname1] ASC,  
[fieldname2] DESC  

Note   If you don't specify ASC or DESC after field names, Microsoft Access sorts in 
ascending order, the first listed field first, then the next listed field, and so on.  
 
AAbboouutt  uussiinngg  ccrriitteerriiaa  iinn  qquueerriieess  oorr  aaddvvaanncceedd  ffiilltteerrss  ttoo  rreettrriieevvee  cceerrttaaiinn  
rreeccoorrddss  
Criteria are restrictions you place on a query or an advanced filter to identify the specific 
records you want to work with. For example, instead of viewing all the suppliers that 
your company uses, you can view just suppliers from Japan. To do this, you specify 
criteria that limits the results to records whose Country field is "Japan". 
To specify criteria for a field in the design grid, enter an expression in the Criteria cell 
for that field. The expression in the preceding example would be "Japan". You can use 
more complicated expressions, however, such as "Between 1000 And 5000". If your 
query includes linked tables, the values you specify in criteria on fields from the linked 
tables are case-sensitive — they must match the case of the values in the underlying 
table. 
You can enter additional criteria for the same field or different fields. When you type 
expressions in more than one Criteria cell, Microsoft Access combines them using 
either the And or the Or operator. If the expressions are in different cells in the same 
row, Microsoft Access uses the And operator, which means only the records that meet 
the criteria in all the cells will be returned. If the expressions are in different rows of the 
design grid, Microsoft Access uses the Or operator, which means records that meet 
criteria in any of the cells will be returned. 
 
You can also specify criteria to affect the results of a calculation. By adding criteria, you 
can limit the groups for which you're performing a calculation, limit the records included 
in the calculation, or limit the results that are displayed after the calculation is 
performed. For information on where to enter criteria in a query that performs 
calculations,  



 

 
 

 
WWhheerree  ttoo  eenntteerr  eexxpprreessssiioonnss  iinn  qquueerriieess  aanndd  ffiilltteerrss  
You can use expressions — in the design grid of a query or the Advanced Filter/Sort 
window, in an SQL statement in a query's SQL view, or in the Filter By Form window — 
to specify criteria that identify the records you want to work with. In queries, you can 
also use expressions to update values in a group of records or to create calculated 
fields. 
In the design grid, you enter the expression in different places depending on the 
operation you're trying to perform. (The following table shows where you can enter 
expressions.) After you type an expression in the design grid and press the ENTER key, 
Microsoft Access displays the expression using syntax it understands. If you don't 
include an operator with the expression, Microsoft Access assumes you mean the = 
operator. For example, if you type Denmark as the criteria in a Country field, Microsoft 
Access displays "Denmark", and interprets the expression as Country="Denmark". If 
you include references to field names in the expression, the fields must be in one of the 
tables added to the query (unless you are using the DLookup function or a subquery). 
You can't drag the fields to the expression in the design grid, however. 
 

To do this Type the expression in 

Specify criteria for a select, crosstab, or 
action query, or for an advanced filter 

A Criteria cell in the design grid of a query 
or advanced filter. 

Create a calculated field A Field cell in the design grid of a query or 
advanced filter. 

Update records according to the results 
of the expression (update queries only) 

An Update To cell in the design grid of an 
update query. 

Specify the records you want to work 
with, how they are grouped, the criteria 
for the groupings, or how records are 
sorted 

An SQL statement in SQL view. 

Specify criteria when using Filter By 
Form 

A field in the Filter By Form window for a 
custom expression, or select an expression 
from the list in the field. 

 
Note   You can see how Microsoft Access evaluates query expressions by switching to 
a query's SQL view to display its underlying SQL statements. To display a query in SQL 
view, click the arrow next to the View button on the toolbar, and then click SQL View. If 
your query includes linked tables, the values you specify in criteria on fields from the 
linked tables are case-sensitive — they must match the case of the values in the 
underlying table. 
 



 

 
 

WWaayyss  ttoo  ffiilltteerr  rreeccoorrddss  bbeeffoorree  tthheeyy  aarree  rreettrriieevveedd  ffrroomm  tthhee  ddaattaabbaassee  
 
To filter the records before the data access page retrieves them, you can base your 
page on a query that includes criteria (search conditions) to limit the records. 
Alternatively, in a Microsoft Access project you can define a filter in the ServerFilter 
property in Visual Basic for Applications or Microsoft Visual Basic Scripting Edition 
(VBScript), and in a Microsoft Access database you can define a filter by using the 
Filter property in Visual Basic for Applications or Microsoft Visual Basic Scripting 
Edition (VBScript). On a grouped data access page, you can create a filter that retrieves 
data for a specific group, such as orders for a specific customer. The data access page 
won't display any records until you choose the group from a drop-down list in Page view 
or Microsoft Internet Explorer. Once you choose the group, the filter is applied and only 
those records are retrieved. You can create a filter for ungrouped data access pages, 
too. Instead of choosing the group whose records you want to see, you choose a value 
from a field you designated as the filter field. This is similar to using Filter By Form. All 
records that contain that value are retrieved. 
 
Note   Filtering records before they are retrieved can improve data access page 
performance because there are fewer records to download from the underlying 
database. 
  
WWaayyss  ttoo  ffiilltteerr  rreeccoorrddss  aafftteerr  tthheeyy  aarree  rreettrriieevveedd  ffrroomm  tthhee  ddaattaabbaassee  
To filter records after they are retrieved for the current data access page in either Page 
view or the browser, use Filter By Selection. With this type of filter, you select in a field 
the value you want the filtered records to contain. In data access page Design view, you 
can also add a filter to a hyperlink on a page. Then, when you click the link in Page view 
or the browser, only the records specified in the filter are displayed on the page you 
jump to.  
FFiinndd  ssppeecciiffiicc  ddaattaa  bbyy  uussiinngg  aa  ffiilltteerr  oonn  aa  ddaattaa  aacccceessss  ppaaggee  iinn  PPaaggee  vviieeww  
With a filter, you can find records based on whether they contain a specific value in a 
particular field. For example, you can find all records that have "Germany" in the 
Country field. When you apply the filter, only the records that contain the value that you 
selected will show in the data access page. Once you remove the filter, all the records 
will be displayed again. For grouped data access pages, you can filter the list of groups 
(the group headings) or the records within groups.  

• In a field in Page view of a data access page, select the value that you want to 
use to filter records, and then click Filter By Selection on the record navigation 
toolbar.  

For grouped data access pages, display the records within the group that you 
want to filter, select the value you want to filter for, and then click Filter By 
Selection on the record navigation toolbar for that group. The filter only applies 
to the current group. In other words, if a page groups customer orders by 
country, and you filter the records for Brazil that have a required date of 6/2/98, 



 

 
 

that filter only applies to the records for Brazil, not to the records for the other 
countries.  

You can further narrow the subset of records by continuing to select values and 
clicking Filter By Selection until you have just the records you want. For 
example, if you only want to see records for customers in Germany with a 
required date of 5/12/98, you select "Germany" in the Country field, click Filter 
By Selection select "5/12/98" in the Required Date field, then click Filter By 
Selection again.  

Notes  

• If you only select part of the value in a field, the data access page still uses the 
entire field value for filtering. 

• You can remove the filter and then reapply it during the same working session. 

• This procedure doesn't apply to a PivotTable list or spreadsheet. These features 
can be filtered independent of the rest of the data on the data access page and 
may also support additional filtering capabilities. For more information, click Help 

on the toolbar for the PivotTable list or spreadsheet, and then search for 
“filters.”  

RReemmoovvee  aa  ffiilltteerr  ttoo  sshhooww  aallll  rreeccoorrddss  iinn  aa  ddaattaa  aacccceessss  ppaaggee  iinn  PPaaggee  vviieeww  

• In Page view of a data access page, click Remove Filter on the record 
navigation toolbar.  

Notes  

• Removing a filter doesn't delete it. You can reapply the filter, even after closing 
and reopening the data access page, by clicking Apply Filter on the record 
navigation toolbar.  

• This procedure doesn't apply to a PivotTable list or spreadsheet. These features 
can be filtered independent of the rest of the data on the data access page and 
may also support additional filtering capabilities. For more information, click Help 

on the toolbar for the PivotTable list or spreadsheet, and then search for 
“filters.”  

 
SSoorrtt  rreeccoorrddss  iinn  FFoorrmm  oorr  DDaattaasshheeeett  vviieeww  

For a list of issues to consider when sorting records, click .  



 

 
 

1. In Form view or Datasheet view, click the field you want to use for sorting 
records. To sort records in a subform, click the field you want to sort. To sort 
records in a subdatasheet, display the subdatasheet by clicking its expand 
indicator, and then click the field. 

2. Do one of the following:  

o To sort in ascending order, click Sort Ascending .  

o To sort in descending order, click Sort Descending .  

Notes    

• In Datasheet view, when you sort the subdatasheet for one record, Microsoft 
Access sorts all the subdatasheets at that level. 

• In a form, you can sort on only one field at a time; in a datasheet or 
subdatasheet, you can select two or more adjacent columns at the same time, 
and then sort them. Microsoft Access sorts records starting with the leftmost 
selected column. When you save the form or datasheet, Microsoft Access saves 
the sort order.  

 
SSoorrtt  rreeccoorrddss  bbyy  uussiinngg  tthhee  ddeessiiggnn  ggrriidd  ooff  aa  qquueerryy  oorr  aaddvvaanncceedd  ffiilltteerr  
Before you specify a sort order, there are certain things you should consider.  
Open a query in Design view or display the Advanced Filter/Sort window for a table, 
query, or form. 

1. To sort on more than one field, first arrange the fields in the design grid in the 
order you want the sorts performed. Microsoft Access sorts on the leftmost field 
first, then on the next field to the right, and so on. For example, to sort on the 
LastName field first and then on the FirstName field, the LastName field must be 
to the left of the FirstName field in the grid. 

2. In the Sort cell for each of the fields you want to sort on, click an option. 

3. To see the results of the query, click View on the toolbar.  

 
SSoorrtt  ddaattaa  oonn  aa  ddaattaa  aacccceessss  ppaaggee  iinn  PPaaggee  vviieeww  
You can sort the data on a data access page, including data that's grouped. For 
grouped data access pages, you can sort the list of groups or the records within a 
group.  



 

 
 

1. In Page view of a data access page, click in the field you want to use for sorting 
records. For grouped pages, display the records within a particular group that 
you want to sort, and then select the value you want to sort on.  

2. Do one of the following:  

o To sort in ascending order, click Sort Ascending . 

o To sort in descending order, click Sort Descending .  

Notes  

• When you sort records within a group, the sort order only applies to that group. It 
does not affect the order of records in other groups. For example, say a data 
access page is grouped by region, the region names are listed in ascending 
order, and under each region, employees are listed in ascending order by their 
last name. If you display employee records for Mexico, and then sort employees 
in descending order by last name, the employee records for other regions will still 
be sorted in ascending order, as will the list of regions themselves. 

• To change the sort order, click in the field that you want to sort, and then click the 
sort button you want. 

• When you close the data access page, you'll lose the sort order. You can sort the 
records again when you open the page. 

• The order in which numbers, text, and special characters are sorted depends on 
the database and your regional settings in Windows Control Panel.  

• This procedure doesn't apply to a PivotTable list or spreadsheet. These features 
can be sorted independent of the rest of the data on the data access page and 
may also support additional sorting capabilities. For more information, click Help 
on the toolbar for the PivotTable list or spreadsheet, and then search for 
“sorting.”  

 
RReemmoovvee  aa  ssoorrtt  oorrddeerr  ffrroomm  aa  ttaabbllee,,  qquueerryy,,  oorr  ffoorrmm  

• In Datasheet view or Form view, click Remove Filter/Sort on the Records 
menu. If you specified the sort order in the Advanced Filter/Sort window where 
you also specified criteria for a filter, you can delete the sort order in the Sort cell 
in the design grid and still leave the filter's criteria intact.  



 

 
 

CCoonnssiiddeerraattiioonnss  wwhheenn  ssoorrttiinngg  rreeccoorrddss  iinn  aa  ttaabbllee,,  qquueerryy,,  ffoorrmm,,  oorr  rreeppoorrtt  

• Sort orders are saved with a table, query, or form. If you base a new form or 
report on a table or query that has a sort order saved with it, the new form or 
report inherits the sort order. 

• Microsoft Access will sort on up to 255 characters, in one or more fields, in the 
results of a query or advanced filter. 

• Sort order depends on the language setting you specify in the Options dialog 
box at the time you create your database. To check or change this setting, click 
Options on the Tools menu, and then click the General tab to see the setting 
under New Database Sort Order. If your database contains linked tables from a 
database that uses a different language sort order, Microsoft Access uses the 
sort order of the database that contains the link to the table, not the database 
where the table is stored. 

• If the design grid for the query or filter contains the asterisk from the field list, you 
can't specify a sort order in the design grid unless you also add the fields you 

want to sort on to the design grid. For more information, click . 

• To sort dates and times from earlier to later, use ascending order. Use 
descending order to sort from later to earlier. 

• Numbers stored in Text fields are sorted as strings of characters, not numeric 
values. Therefore, to sort them in numeric order, all text strings must be the 
same length with shorter numbers padded with leading zeros. For example, the 
result of an ascending sort of the text strings "1", "2", "11", and "22" will be "1", 
"11", "2", "22". You must pad the single-digit numbers with a leading zero for the 
strings to be sorted properly: "01", "02", "11", "22". For fields that don't contain 
Null values, another solution would be to sort on the numeric values of the 
strings by using the Val function. For example, if the Age column is a Text field 
that contains numeric values, specifying Val([Age]) in a Field cell and specifying 
a sort order in its Sort cell will put the records in the correct order. If you are only 
storing numbers or dates in a Text field, consider changing the field's data type to 
Number, Currency, or Date/Time in the table where the field is stored. Then, 
when you sort on the field, the numbers or dates will sort in numeric or date order 
without requiring leading zeros. 

• When you sort a field in ascending order, any records in which that field is blank 
(contains a Null value) are listed first. If a field contains records with both Null 
values and zero-length strings, the fields with null values appear first in the sort 
order, immediately followed by the zero-length strings. 

• You can't sort a field whose data type is Memo, Hyperlink, or OLE Object.  



 

 
 

 
AAbboouutt  sshhaarriinngg  aann  AAcccceessss  ddaattaabbaassee  oonn  aa  nneettwwoorrkk  

Share the entire Access database 

You can put the entire Access database on a network server or in a shared folder. This 
is the easiest method to implement. Everyone shares the data and uses the same 
forms, reports, queries, macros, and modules. Use this strategy if you want everyone to 
use the Access database the same way or you can't support users creating their own 
objects.  

SShhaarree  oonnllyy  tthhee  ttaabblleess  iinn  tthhee  AAcccceessss  ddaattaabbaassee  

You can put only the tables on a network server, and keep other database objects on 
users' computers. In this case, the Access database's performance is faster because 
only data is sent across the network. Also, users can customize their forms, reports, and 
other objects for their individual needs and preferences without affecting other users.  

SShhaarree  AAcccceessss  ddaattaabbaassee  oobbjjeeccttss  oorr  ddaattaa  aacccceessss  ppaaggeess  oonn  tthhee  IInntteerrnneett  

You can output one or more database objects to static HTML or server-generated 
HTML format, or create data access pages, and then display them in a browser, such 
as Internet Explorer, on the World Wide Web. Learn about the three types of Web 
pages Access creates. 

RReepplliiccaattee  tthhee  AAcccceessss  ddaattaabbaassee  

If you use two computers, such as an office computer and a portable computer, you can 
use Microsoft Windows Briefcase to make replicas of your Access database and keep 
those replicas synchronized. Also, several users at different locations can work on their 
own copies at the same time and then synchronize them over the network, either 
through a dial-up connection or on the Internet. Learn about replicating a database. 

MMoovvee  bbeettwweeeenn  ffiieellddss  iinn  lloonngg  rreeccoorrddss  wwiitthh  tthhee  GGoo  TToo  FFiieelldd  bbooxx  iinn  
DDaattaasshheeeett  vviieeww  
 
Adding the Go To Field box makes it easier to move between fields in long records in 
Datasheet view.  

1. Open a table, query, form, view, or stored procedure in Datasheet view. 

2. Click Toolbars on the View menu. 

3. Select Formatting (Datasheet). 

4. Click Close.  



 

 
 

The Go To Field box is the leftmost item on the Formatting (Datasheet) toolbar. Use it 
to click the name of the field in the current record that you want to move to. 
 
FFiinndd  aa  ssppeecciiffiicc  rreeccoorrdd  bbyy  ssccrroolllliinngg  iinn  aa  DDaattaasshheeeett  oorr  ffoorrmm  
If there are more records than fit in your Datasheet view or continuous form window, 
you can use the scroll box on the scroll bar to find a specific record.  

• Drag the scroll box up or down on the scroll bar.  

Next to the scroll box, Microsoft Access displays the number of the record at the top of 
the screen. 
 
If you have a Microsoft IntelliMouse, you can use the wheel button to scroll to a specific 
record depending on your current view. 
 

View Wheel button behavior Cursor behavior 

Datasheet, or subform 
displayed as a datasheet 

Scrolls row by row  Does not move 

Single form or subform 
displayed as a single 
form 

Goes to the next or previous 
record 

Goes to the next or 
previous record 

Continuous form or 
subform displayed as a 
continuous form 

Goes to the next or previous 
record 

Does not move 

 
 
FFiinndd  aa  rreeccoorrdd  bbyy  rreeccoorrdd  nnuummbbeerr  iinn  DDaattaasshheeeett  oorr  FFoorrmm  vviieeww  

1. Open a table, query, form, view, or stored procedure in Datasheet view, or a form 
in Form view. 

2. Double-click the number in the record number box to select it, or press F5. 

3. Type the number of the record you want, and then press ENTER.  

 
 



 

 
 

CChhaapptteerr  33  ::  QQuueerriieess  
QQuueerriieess::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
You use queries to view, change, and analyze data in different ways. You can also use 
them as the source of records for forms, reports, and data access pages. 

OOppeenn  oorr  rruunn  aa  qquueerryy  
You can open a select, crosstab, or action query in Design view. You can also open a 
select or crosstab query in Datasheet view, to view the query's results. 
You can't open an action query in Datasheet view to view its results. However, in 
Datasheet view you can preview the data that will be affected when you run the action 
query. 
 
OOppeenn  aa  qquueerryy  iinn  DDeessiiggnn  vviieeww  

1. In the Database window, click Queries under Objects. 

2. Click the query you want to open, and then click Design on the Database 
window toolbar.  

Notes  

• If a form, report, or data access page is based on a query, you can open the 
query to modify its design directly from the form, report, or data access page.  

• If you previously saved a query while it was displayed in SQL view, that's the 
view Microsoft Access displays the next time you click Design on the Database 
window toolbar for that query.  

VViieeww  tthhee  rreessuullttss  ooff  aa  sseelleecctt  oorr  ccrroossssttaabb  qquueerryy  
Microsoft Access displays the results of a select or crosstab query in a datasheet. You 
can display the datasheet from query Design view or by clicking Open on the Database 
window toolbar. 

From Do this 

Query Design view 
Click View on the toolbar. 

Database window 
Click Queries under Objects, and then double-
click the query name, or select the query and then click 
Open on the Database window toolbar. 



 

 
 

 
To stop the query, press CTRL+BREAK. (This procedure may not work for very large 
queries, however.) 
 
PPrreevviieeww  rreeccoorrddss  aaffffeecctteedd  bbyy  aa  mmaakkee--ttaabbllee,,  ddeelleettee,,  aappppeenndd,,  oorr  uuppddaattee  
qquueerryy  

• In query Design view, click View on the toolbar to display the query in Datasheet 
view.  

For this query The datasheet displays 

Update The fields to be updated. 

Delete The records to be deleted. 

Make-table The fields to be included in the new table. 

Append The records to be added to another table. 

  
RRuunn  aa  mmaakkee--ttaabbllee,,  aappppeenndd,,  ddeelleettee,,  oorr  uuppddaattee  qquueerryy  

1. Open the query in Design view. 

2. To preview the records that will be affected, click View on the toolbar and check 
the records. For information on what you're previewing,  

3. To return to query Design view, click View on the toolbar again. Make any 
changes you want in Design view. 

4. Click Run on the toolbar to run the query.  

Note   To stop a query after you start it, press CTRL+BREAK. 
 
WWhhaatt  iiss  aa  sseelleecctt  qquueerryy  aanndd  wwhheenn  wwoouulldd  yyoouu  uussee  oonnee??  
A select query is the most common type of query. It retrieves data from one or more 
tables and displays the results in a datasheet where you can update the records (with 
some restrictions). You can also use a select query to group records and calculate 
sums, counts, averages, and other types of totals. 
WWhhaatt  iiss  aa  ppaarraammeetteerr  qquueerryy  aanndd  wwhheenn  wwoouulldd  yyoouu  uussee  oonnee??  
A parameter query is a query that when run displays its own dialog box prompting you 
for information, such as criteria for retrieving records or a value you want to insert in a 
field. You can design the query to prompt you for more than one piece of information; 
for example, you can design it to prompt you for two dates. Microsoft Access can then 
retrieve all records that fall between those two dates. 



 

 
 

Parameter queries are also handy when used as the basis for forms, reports, and data 
access pages. For example, you can create a monthly earnings report based on a 
parameter query. When you print the report, Microsoft Access displays a dialog box 
asking for the month that you want the report to cover. You enter a month and Microsoft 
Access prints the appropriate report. You can also create a custom form or dialog box 
that prompts for a query's parameters instead of using the parameter query's dialog 
box.  
 
WWhhaatt  iiss  aa  ccrroossssttaabb  qquueerryy  aanndd  wwhheenn  wwoouulldd  yyoouu  uussee  oonnee??    
A crosstab query displays summarized values (sums, counts, and averages) from one 
field in a table and groups them by one set of facts listed down the left side of the 
datasheet and another set of facts listed across the top of the datasheet. 
For information on creating a crosstab query with a wizard,  
 
Tip   You can display crosstab data without creating a separate query in your database 
either by using the PivotTable Wizard in a form or by creating a PivotTable list in a data 
access page. With a PivotTable form or PivotTable list, you can change row and column 
headings on demand to analyze your data in different ways.  
 
WWhhaatt  iiss  aann  aaccttiioonn  qquueerryy  aanndd  wwhheenn  wwoouulldd  yyoouu  uussee  oonnee??  
An action query is a query that makes changes to many records in just one operation. 
There are four types of action queries: delete, update, append, and make-table. 
This topic provides examples of: 
Delete query 
Update query 
Append query 
Make-table query 
 
DDeelleettee  qquueerryy  
Deletes a group of records from one or more tables. For example, you could use a 
delete query to remove products that are discontinued or for which there are no orders. 
With delete queries, you always delete entire records, not just selected fields within 
records. 
  
UUppddaattee  qquueerryy  
Makes global changes to a group of records in one or more tables. For example, you 
can raise prices by 10 percent for all dairy products, or you can raise salaries by 5 
percent for the people within a certain job category. With an update query, you can 
change data in existing tables. 
  
AAppppeenndd  qquueerryy  
Adds a group of records from one or more tables to the end of one or more tables. For 
example, suppose that you acquire some new customers and a database containing a 
table of information on those customers. To avoid typing all this information in, you'd like 
to append it to your Customers table. Append queries are also helpful for:  



 

 
 

• Appending fields based on criteria. For example, you might want to append only 
the names and addresses of customers with outstanding orders. 

• Appending records when some of the fields in one table don't exist in the other 
table. For example, in the Northwind sample database, the Customers table has 
11 fields. Suppose that you want to append records from another table that has 
fields that match 9 of the 11 fields in the Customers table. An append query will 
append the data in the matching fields and ignore the others.  

MMaakkee--ttaabbllee  qquueerryy  
Creates a new table from all or part of the data in one or more tables. Make-table 
queries are helpful for:  

• Creating a table to export to other Microsoft Access databases. For example, you 
might want to create a table that contains several fields from your Employees 
table, and then export that table to a database used by your personnel 
department. 

• Creating data access pages that display data from a specified point in time. For 
example, suppose you want to display a data access page on 15-May-96 that 
displays the first quarter's sales totals based on the data that was in the 
underlying tables as of 9:00 A.M. on 1-Apr-96. A data access page based on a 
query or SQL statement extracts the most up-to-date data from the tables (the 
data as of 15-May-96), rather than the records as of a specific date and time. To 
preserve the data exactly as it was at 9:00 A.M. on 1-Apr-96 , create a make-
table query at that point in time to retrieve the records you need and store them 
in a new table. Then use this table, rather than a query, as the basis for the data 
access page.  

• Making a backup copy of a table. 

• Creating a history table that contains old records. For example, you could create 
a table that stores all your old orders before deleting them from your current 
Orders table. 

• Improving performance of forms, reports, and data access pages based on 
multiple-table queries or SQL statements. For example, suppose you want to 
print multiple reports that are based on a five-table query that includes totals. You 
may be able to speed things up by first creating a make-table query that retrieves 
the records you need and stores them in one table. Then you can base the 
reports on this table or specify the table in an SQL statement as the record 
source for a form, report, or data access page, so you don't have to rerun the 
query for each report. However, the data in the table is frozen at the time you run 
the make-table query.  



 

 
 

WWhhaatt  iiss  aann  SSQQLL  qquueerryy  aanndd  wwhheenn  wwoouulldd  yyoouu  uussee  oonnee??  
An SQL query is a query you create using an SQL statement. Examples of SQL-specific 
queries are the union query, pass-through query, data-definition query, and subquery. 
This topic provides examples of: 
 
Union query 
Pass-through query 
Data-definition query 
Subquery 
 
UUnniioonn  qquueerryy  
This type of query combines fields (columns) from one or more tables or queries into 
one field or column in the query's results. For example, if you have six vendors that 
send new inventory lists each month, you can combine these lists into one result set 
using a union query, and then create a make-table query based on the union query to 
make a new table.  
 
PPaassss--tthhrroouugghh  qquueerryy  
This type of query sends commands directly to ODBC databases, such as Microsoft 
FoxPro, using commands that are accepted by the server. For example, you can use a 
pass-through query to retrieve records or change data. 
  
DDaattaa--ddeeffiinniittiioonn  qquueerryy  
This type of query creates, deletes, alters tables, or creates indexes in a database , 
such as Microsoft Access or Microsoft FoxPro tables. 
  
SSuubbqquueerryy  
This type of query consists of an SQL SELECT statement inside another select query or 
action query. You can enter these statements in the Field row of the query design grid 
to define a new field, or in the Criteria row to define criteria for a field. You can use 
subqueries to:  

• Test for the existence of some result from the subquery (using the EXISTS or 
NOT EXISTS reserved words).  

• Find any values in the main query that are equal to, greater than, or less than 
values returned by the subquery (using the ANY, IN, or ALL reserved words). 

• Create subqueries within subqueries (nested subqueries).  

AAbboouutt  AAuuttooLLooookkuupp  qquueerriieess  tthhaatt  eenntteerr  ddaattaa  aauuttoommaattiiccaallllyy  
You can design a multiple-table query to automatically fill in certain field values for a 
new record. When you enter a value in the join field in the query or in a form, report, or 
data access page based on the query, Microsoft Access looks up and fills in existing 
information related to that value. For example, if you know the value in the join field 



 

 
 

between a Customers table and an Orders table (typically, a customer identifier such as 
CustomerID), you could enter the customer ID and have Microsoft Access enter the rest 
of the information for that customer. If no matching information is found, Microsoft 
Access displays an error message when the focus leaves the record. 
 
For AutoLookup to work, certain conditions must be met:  

• The query must be based on more than one table and the tables must have a 
one-to-many relationship. (Referential integrity doesn't have to be enforced.) 

• The join field on the "one" side of the relationship must have a unique index. A 
unique index means that the field is a primary key or its Indexed property in table 
Design view is set to Yes (No Duplicates). 

• The join field you add to the design grid must come from the table on the "many" 
side of the one-to-many relationship. (In other words, it's the foreign key for that 
table.) For AutoLookup to work, this field can't be a primary key and its Indexed 
property can't be set to Yes (No Duplicates). For example, in a query that 
includes the Customers and Orders tables, drag to the design grid the 
CustomerID field from the Orders table, not the one from the Customers table. 

• The value you enter in the join field from the "many" side must already exist in 
the join field from the "one" side.  

When the value of the join field from the "many" side of the relationship is added or 
changed in a record, Microsoft Access automatically finds and displays the associated 
values from the table on the "one" side of the relationship. 
While you can always update the join field from the "many" side of a relationship, you 
can update the join field from the "one" side only if you enabled cascading updates 
when defining the relationship between the tables. Either way, when you update data, 
Microsoft Access automatically recalculates any totals or expressions in the query that 
are dependent on the updated data. 
 
CCrreeaattee  aa  qquueerryy  ffrroomm  aa  ffiilltteerr  iinn  aa  ttaabbllee,,  qquueerryy,,  oorr  ffoorrmm  
Instead of designing a query from scratch in query Design view, you can create it 
automatically by saving an existing filter in a table, query, or form as a query. A query 
offers more flexibility than a filter. With the filter displayed in the Filter By Form window 
or the Advanced Filter/Sort window, click Save As Query on the toolbar. 

1. Type a name for the query, and then click OK.  

The new query appears in the Database window. It automatically includes all the 
fields from the underlying table because the query's OutputAllFields property is 
automatically set to Yes, but you can change the query's design if necessary.  

Note   You can use the query as a filter, too. You might do this if you already saved one 
filter with the form or datasheet, and you want to use the query as a second filter. 



 

 
 

 
FFiinndd  dduupplliiccaattee  rreeccoorrddss  oorr  ffiieelldd  vvaalluueess  iinn  aa  ttaabbllee  uussiinngg  aa  qquueerryy  wwiizzaarrdd  
From the results of a Find Duplicates query, you can determine if there are duplicate 
records in a table, or determine which records in a table share the same value. For 
example, you might search for duplicate values in an address field to determine if you 
have duplicate records for the same supplier, or you might search for duplicate values in 
a city field to see which suppliers are in the same city. 
Note   Microsoft Access can automatically delete all the duplicate records in a table, 
although you can't use the Find Duplicates Wizard to do it.  
In the Database window, click Queries under Objects, and then click New on the 
Database window toolbar. 

1. In the New Query dialog box, click Find Duplicates Query Wizard. 

2. Click OK. 

3. Follow the directions in the wizard dialog boxes. If you don't choose to show 
fields in addition to those with duplicate values, the query results will sum the 
instances of each duplicate value. In the last dialog box, you can choose to run 
the query or see the query's structure in Design view.  

If the resulting query isn't exactly what you want, you can rerun the wizard or 
change the query in Design view. For more information on changing a query in 

Design view, click .  

You can manually delete each duplicate record that the wizard finds. For more 

information, click . 
 
AAdddd  aa  ttaabbllee  oorr  qquueerryy  ttoo  aa  qquueerryy  

1. Open a query in Design view. 

2. On the toolbar, click Show Table . 

3. In the Show Table dialog box, click the tab that lists the objects whose data you 
want to work with. If the table you need is in another database or application, first 
link the table to the active database.  

4. Click the name of the object you want to add to the query. To select additional 
objects one at a time, hold down CTRL while you click each object name. To 
select a block of objects, click the first name in the block, hold down SHIFT, and 
then click the last name in the block. 

5. Click Add, and then click Close.  



 

 
 

Notes    

• You can also add a table or query to a query by dragging the table or query 
name from the Database window to the upper part of query Design view. 

• When you have multiple tables or queries in a query, they need to be joined 

together. For information on joining tables, click .  

 
AAdddd  ffiieellddss  ttoo  tthhee  ddeessiiggnn  ggrriidd  iinn  aa  qquueerryy  oorr  aaddvvaanncceedd  ffiilltteerr  
In a query, you add only those fields whose data you want to view, set criteria on, group 
by, update, or sort. In an advanced filter, you add only the fields you want to use for 
sorting or specifying criteria, and Microsoft Access will automatically display all the fields 
in the filtered results.  

1. Open a query in Design view, or open a form or datasheet and display the 
Advanced Filter/Sort window. 

2. In a query, make sure the field list for the table or query containing the fields you 
want to add appears in the top portion of the window. You can add a table or 
query if the field list you need isn't in the query.  

In the Advanced Filter/Sort window, Microsoft Access displays the field list for the 
underlying table, query, or SQL statement automatically. You can't add more 
tables or queries to this window.  

3. Select one or more fields from the field list and drag them to the columns in the 
grid.  

AAbboouutt  uussiinngg  tthhee  aasstteerriisskk  iinn  tthhee  qquueerryy  ddeessiiggnn  ggrriidd  

• Selecting the asterisk (*) in a query has an advantage over selecting all the 
fields. When you use the asterisk, the query results automatically include any 
fields that are added to the underlying table or query after the query is created; 
and automatically exclude fields that are deleted. 

• When you use the asterisk, you can't sort records or specify criteria for fields 
unless you add those fields along with the asterisk to the design grid.  

• If you type an asterisk in the Field row rather than dragging it, you must type the 
table name also. For example, type Customers.*.  

 



 

 
 

AAbboouutt  wwoorrkkiinngg  wwiitthh  bbllaannkk  ffiieellddss  iinn  qquueerriieess  
When a field contains no values, it contains a Null value or, for Text, Memo, or 
Hyperlink fields, a Null value or a zero-length string. If Null values exist in a field, they 
can affect the query's results. Following are some guidelines for working with Null 
values and zero-length strings in queries. (For information on the differences between 
Null values and zero-length strings,  
 
JJooiinniinngg  ffiieellddss  tthhaatt  ccoonnttaaiinn  NNuullll  vvaalluueess  
 
When you join tables in a query, the result includes only records that don't have Null 
values in the matching fields. For example, to list Suppliers and Customers who live in 
the same region, you create a query that includes the Suppliers and Customers tables, 
and the tables are joined on the Region field. When you view the results, you'll see only 
the values for records that contain a value in the Region field in both tables. 
  
SSeeaarrcchhiinngg  ffoorr  NNuullll  vvaalluueess  oorr  zzeerroo--lleennggtthh  ssttrriinnggss  
If you're using a query to search for Null values or zero-length strings, type Is Null into 
the Criteria cell to search for Null values, or type two double quotation marks (" ") into 
the Criteria cell to search for zero-length strings (don't type a space between the 
quotation marks). 
UUnnddeerrssttaannddiinngg  hhooww  NNuullll  vvaalluueess  aaffffeecctt  nnuummeerriicc  ccaallccuullaattiioonnss  
If you use an aggregate function to calculate the sum, average, count, or another 
amount on a field's values, records with Null values in that field won't be included in the 
calculation. This is true whether you calculate the aggregate using the Total row in the 
query design grid, the Simple Query Wizard, or a custom expression. For example, if 
you use the Count function to count the number of values in a field, it will return a count 
of all the records with non-Null values. If you want to find the total number of records 
including those with Null values, use Count with the asterisk (*) wildcard character. 
 
If you use an arithmetic operator (such as +, -, *, /) in an expression (such as 
[UnitsInStock]+[UnitsOnOrder]), and one of the fields in the expression contains a Null 
value, then the result of the entire expression will be a Null value. 
 
CCoonnvveerrttiinngg  NNuullll  vvaalluueess  ttoo  zzeerroo  
When you have fields that contain Null values, you can create an expression that 
converts the Null values to zero. You might do this if you want the records containing 
Null values to be included in an aggregate calculation, or if you want to prevent an 
expression from resulting in a Null value when a field that's referenced in the 
expression contains Null values. Use the Nz function, for example, to convert Null 
values to zero:  
Nz([Subtotal],0)+Nz([Freight],0) 
  
CCoommbbiinniinngg  TTeexxtt  ffiieellddss  tthhaatt  ccoonnttaaiinn  NNuullll  vvaalluueess  
If you're using an expression to combine two fields containing text values and one or 
both of the fields includes Null values, use the & operator instead of the + operator to 



 

 
 

combine the values. The & operator will combine the values even if they contain Null 
values, while the + operator will return a Null if either of the two values is a Null. For 
example:  
FullName: [LastName] & " " & [FirstName] 
  
SSoorrttiinngg  oonn  ffiieellddss  ccoonnttaaiinniinngg  NNuullll  vvaalluueess  aanndd  zzeerroo--lleennggtthh  ssttrriinnggss  
When you sort a field in ascending order, any records in which that field contains a Null 
value are listed first. If a field contains both Null values and zero-length strings, the Null 
values appear first in the sort order, immediately followed by the zero-length strings. 
  
UUssiinngg  tthhee  aasstteerriisskk  ((**))  wwiillddccaarrdd  cchhaarraacctteerr  ttoo  rreettuurrnn  nnoonn--NNuullll  vvaalluueess  
 
If you use the expression Like "*" when defining query criteria for a field, the query 
results will include zero-length strings in that field, but not Null values. 
 
PPrreevveenntt  dduupplliiccaattee  rreeccoorrddss  iinn  aa  qquueerryy  bbaasseedd  oonn  ffiieellddss  iinn  tthhee  uunnddeerrllyyiinngg  
ttaabbllee  

1. Open a query in Design view. 

2. Select the query by clicking anywhere in query Design view outside the design 
grid and the field lists. 

3. Click Properties on the toolbar to display the query's property sheet. 

4. Set the UniqueRecords property to Yes.  

Notes    

• The UniqueRecords property has an effect only when you use more than one 
table in the query and select fields from those tables. 

• When the UniqueRecords property is set to Yes, Microsoft Access automatically 
sets the UniqueValues property to No. 

• As an alternative to setting the UniqueRecords property, you can add to the 
design grid the field that distinguishes one record from another.  

 
PPrreevveenntt  dduupplliiccaattee  rreeccoorrddss  iinn  aa  qquueerryy  bbaasseedd  oonn  ffiieellddss  iinn  tthhee  ddeessiiggnn  
ggrriidd  

1. Open a query in Design view. 

2. Select the query by clicking anywhere in query Design view outside the design 
grid and the field lists. 



 

 
 

3. Click Properties on the toolbar to display the query's property sheet. 

4. Set the UniqueValues property to Yes.  

If the query's results include more than one field, the combination of values from 
all fields must be unique for a given record to be included in the results.  

5. To view the query's results, click View on the toolbar.  

Note   When the UniqueValues property is set to Yes, Microsoft Access automatically 
sets the UniqueRecords property to No. 
 
DDiissppllaayy  oonnllyy  tthhee  hhiigghheesstt  oorr  lloowweesstt  vvaalluueess  iinn  tthhee  qquueerryy''ss  rreessuullttss  
The query can display, for example, those records with the 10 highest or lowest values 
in a specific field or the records with the highest or lowest 10 percent of values in the 
field.  

1. Open the query in Design view. 

2. Add to the design grid the fields you want to display in the query's results, 
including the field you want to display top values for. 

3. In the Sort cell of the field you want to display top values for, click Descending 
to display the highest values or Ascending to display the lowest values. If you're 
sorting on other fields in the query's design grid, too, those fields must be to the 
right of the top values field. 

4. Click in the Top Values box on the toolbar. 

5. Enter the percentage or the number of highest or lowest values you want the 
query results to display.  

Note   To display a percentage, enter a number followed by a percent sign (%).  

6. To view the query's results, click View on the toolbar.  

Note   Setting the TopValues property in the query's property sheet works the same as 
using the Top Values button on the toolbar. 
 
WWaayyss  ttoo  bbrriinngg  ttooggeetthheerr  ddaattaa  ffrroomm  mmuullttiippllee  ttaabblleess  oorr  qquueerriieess  iinn  aa  qquueerryy  
The power of queries lies in being able to bring together or perform an action on data 
from more than one table or query. For example, you might want to view a customer's 
information with the orders the customer placed. To see this information, you need data 
from the Customers and Orders tables. 
When you add more than one table or query to a query, you need to make sure their 
field lists are joined to each other with a join line so that Microsoft Access knows how to 
connect the information. 



 

 
 

 
If tables in a query aren't joined to one another, either directly or indirectly, Microsoft 
Access doesn't know which records are associated with which, so it displays every 
combination of records (called a "cross-product" or "Cartesian product") between the 
two tables. Therefore, if each table had 10 records in it, the query's results will contain 
100 records (10X10). It also means the query might take a long time to run and 
ultimately might produce less meaningful results. 
If you previously created relationships between tables in the Relationships window, 
Microsoft Access automatically displays join lines when you add related tables in query 
Design view. If referential integrity is enforced, Microsoft Access also displays a "1" 
above the join line to show which table is on the "one" side of a one-to-many 
relationship and an infinity symbol to show which table is on the "many" side. 
 
Even if you haven't created relationships, Microsoft Access automatically creates joins if 
you add two tables to a query and the tables each have a field with the same or 
compatible data type and if one of the join fields is a primary key. The "one" and "many" 
symbols are not displayed in this case, because referential integrity is not enforced. 
 
Sometimes the tables you add to the query don't include any fields that can be joined. In 
this situation, you have to add one or more extra tables or queries to serve solely as a 
bridge between the tables whose data you want to use. For example, if you add the 
Customers and Order Details tables to a query, they won't have a join line between 
them because they don't have any fields that can be joined. But the Orders table is 
related to both tables, so you can include the Orders table in your query to provide a 
connection between the other two. 
 
Once tables and queries are joined, and you've added fields from both tables or queries 
to the design grid in query Design view, the default join tells the query to check for 
matching values in the join fields. (This is called an inner join in database terminology.) 
When it finds matches, it combines those two records and displays them as one record 
in the query's results. If one table or query doesn't have a matching record in the other 
table or query, neither record appears in the query's results. If you want the query to 
select all the records from one table or query whether or not it has matching records in 
the other table or query, you can change the join type. 
 
Examples of different join types and how they affect query results If you want the query 
to select records based on the value in the join field being greater than, less than, not 
equal to, greater than or equal to, or less than or equal to the value in the other join 
field, you must create an SQL statement in SQL view. 
Note   Once you create a multiple-table query, you may or may not be able to update 
the data.  
 
EEnnaabbllee  oorr  ddiissaabbllee  aauuttoommaattiicc  jjooiinnss  bbeettwweeeenn  ttaabblleess  aanndd  qquueerriieess  iinn  
qquueerriieess  
Even if you haven't created relationships between tables, Microsoft Access 
automatically creates joins if you add two tables to a query and the tables each have a 



 

 
 

field with the same or compatible data type and if one of the join fields is a primary key. 
You can enable or disable these automatic joins.  

1. On the Tools menu, click Options. 

2. Click the Tables/Queries tab. 

3. Select or clear the Enable AutoJoin check box.  

Notes    

• If you disable automatic joins, you can still create joins yourself. 

• This setting applies to new queries only.  

 
JJooiinn  mmuullttiippllee  ttaabblleess  aanndd  qquueerriieess  iinn  aa  qquueerryy  

• In query Design view, drag a field from the field list for one table or query to the 
equivalent field (a field of the same or compatible data type containing similar 
data) in the field list for the other table or query.  

With this type of join, Microsoft Access selects records from both tables or 
queries only when the values in the joined fields are equal.  

 
Notes    

• Join numeric fields only if the FieldSize property settings for both are Byte, 
Integer, or Long Integer.  

• You can change the type of join so that Microsoft Access selects all the records 
from one table or query whether or not it has matching records in the other table 

or query. For more information, click .  

JJooiinn  ttwwoo  ccooppiieess  ooff  tthhee  ssaammee  ttaabbllee  iinn  aa  qquueerryy  
By joining two copies of the same table, you create a self-join that combines records 
from the same table when there are matching values in the joined fields. For example, 
say you have an Employees table in which the ReportsTo field for each employee's 
record displays his or her manager's ID instead of name. You could use a self-join to 
display the manager's name in each employee's record instead.  

1. In query Design view, add the table to the query twice. 

2. Create the join by dragging a field in the first table's field list to the field you want 
to relate it to in the second field list.  



 

 
 

Notes    

• To read about how to complete the self-join in the preceding example, click . 

• Microsoft Access appends "_1" to the table name in the second field list. For 
example, if you add the Employees table twice, the first field list is titled 
"Employees," and the second field list is titled "Employees_1." You can rename 
the table to something more descriptive by setting the Alias property for the field 
list.  

 
AAbboouutt  uussiinngg  ccrriitteerriiaa  iinn  qquueerriieess  oorr  aaddvvaanncceedd  ffiilltteerrss  ttoo  rreettrriieevvee  cceerrttaaiinn  
rreeccoorrddss  
Criteria are restrictions you place on a query or an advanced filter to identify the specific 
records you want to work with. For example, instead of viewing all the suppliers that 
your company uses, you can view just suppliers from Japan. To do this, you specify 
criteria that limits the results to records whose Country field is "Japan". 
 
To specify criteria for a field in the design grid, enter an expression in the Criteria cell 
for that field. The expression in the preceding example would be "Japan". You can use 
more complicated expressions, however, such as "Between 1000 And 5000". If your 
query includes linked tables, the values you specify in criteria on fields from the linked 
tables are case-sensitive — they must match the case of the values in the underlying 
table. 
 
You can enter additional criteria for the same field or different fields. When you type 
expressions in more than one Criteria cell, Microsoft Access combines them using 
either the And or the Or operator. If the expressions are in different cells in the same 
row, Microsoft Access uses the And operator, which means only the records that meet 
the criteria in all the cells will be returned. If the expressions are in different rows of the 
design grid, Microsoft Access uses the Or operator, which means records that meet 
criteria in any of the cells will be returned. 
 
Examples of how to use multiple criteria in the design grid.  
You can also specify criteria to affect the results of a calculation. By adding criteria, you 
can limit the groups for which you're performing a calculation, limit the records included 
in the calculation, or limit the results that are displayed after the calculation is 
performed. For information on where to enter criteria in a query that performs 
calculations,  
 
EEnntteerr  ccrriitteerriiaa  iinn  aa  qquueerryy  oorr  aaddvvaanncceedd  ffiilltteerr  ttoo  rreettrriieevvee  cceerrttaaiinn  rreeccoorrddss  

1. Open a query in Design view, or display the Advanced Filter/Sort window for a 
table, query, or form. 

 



 

 
 

2. Click the first Criteria cell for the field you want to set criteria for. 

3. Enter the criteria expression by typing it or by using the Expression Builder. To 
display the Expression Builder, right-click in the Criteria cell, and then click 
Build.  

If your query includes linked tables, the values you specify in criteria on fields 
from the linked tables are case-sensitive — they must match the case of the 
values in the underlying table.  

When you view a subdatasheet in a query, the Advanced Filter/Sort window 
contains the record source only for the selected subdatasheet. To filter on fields 
contained in the main datasheet or in a different subdatasheet, close the 
Advanced Filter/Sort window, select the main datasheet or the subdatasheet on 
which you want to set filter criteria, and then reopen the Advanced Filter/Sort 
window.  

4. To enter another expression in the same field or in another field, move to the 
appropriate Criteria cell and enter the expression.  

 
WWaayyss  ttoo  ppeerrffoorrmm  ccaallccuullaattiioonnss  iinn  aa  qquueerryy  
There are many types of calculations you can perform in a query. For example, you can 
calculate the sum or average of the values in one field, multiply the values in two fields, 
or calculate the date three months from the current date. 
When you display the results of a calculation in a field, the results aren't actually stored 
in the underlying table. Instead, Microsoft Access reruns the calculation each time you 
run the query so that the results are always based on the most current data in the 
database. Therefore, you can't manually update the calculated results. 
To display the results of a calculation in a field, you can use a predefined calculation 
that Microsoft Access provides or custom calculations you define. Use the predefined 
calculations, called "totals," if you want to compute the following amounts for groups of 
records or for all the records combined: sum, average, count, minimum, maximum, 
standard deviation, or variance. You choose one totals calculation for each field you 
want to calculate. 
 
You can calculate some types of totals using the Simple Query Wizard. Or, you can 
calculate all types of totals using the Total row in the query design grid, where you 
select the aggregate function for the calculation you want to perform on a field. 
In the query design grid, you can also specify criteria to limit the groups for which totals 
are calculated, limit the records included in the calculation, or limit the results that are 
displayed after the calculation is performed. 
A custom calculation enables you to perform numeric, date, and text calculations on 
each record using data from one or more fields. For example, with a custom calculation, 
you can multiply one field's values by a set amount, find the difference between two 
dates stored in separate fields, combine several values in a Text field, or create 



 

 
 

subqueries. Using the options in the Total row in the design grid, you can perform the 
calculation on groups of records and calculate a sum, average, count, or other type of 
total on the calculated field. 
For custom calculations, you need to create a new calculated field directly in the design 
grid. You create a calculated field by entering an expression into an empty Field cell in 
the query design grid. 
 
The expression can be made up of multiple calculations — for example, 
Sum([UnitsInStock]+[UnitsOnOrder]). You can also specify criteria for a calculated field 
to affect the results of the calculation. 
You don't have to display the results of a calculation in a field, however. Instead, you 
can use them as criteria to determine the records the query selects or to determine 
which records to perform an action on. For example, you can specify the following 
expression in the Criteria row to tell the query to return only records that have values in 
the RequiredDate field that are between today's date and three months from today's 
date. 
 
You can also use a calculation to update data from an update query. For example, you 
can enter the following expression in the Update To cell to increase all the values in the 
UnitPrice field by 5 percent. 
 
CCrreeaattee  aa  ssiimmppllee  sseelleecctt  qquueerryy  wwiitthh  aa  wwiizzaarrdd  
The Simple Select Query Wizard creates queries that retrieve data from the fields you 
specify in one or more tables or queries. If you want, the wizard can also sum, count, 
and average values for groups of records or all records, and it can calculate the 
minimum or maximum value in a field. You can't limit the records it retrieves by setting 
criteria, however.  

1. In the Database window, click Queries under Objects, and then click New on 
the Database window toolbar. 

2. In the New Query dialog box, click Simple Query Wizard. 

3. Click OK. 

4. Click the name of the table or query you want to base your query on, and then 
select the fields whose data you want to retrieve.  

5. Click an additional table or query if desired, and then select the fields you want to 
use from it. Repeat this step until you have all the fields you need.  

6. Follow the directions in the wizard dialog boxes. In the last dialog box, you can 
choose either to run the query or to see the query's structure in Design view.  

If the resulting query isn't exactly what you want, you can rerun the wizard or 
change the query in Design view.  



 

 
 

CCrreeaattee  aa  nneeww  ttaabbllee  ffrroomm  tthhee  rreessuullttss  ooff  aa  qquueerryy  wwiitthh  aa  mmaakkee--ttaabbllee  qquueerryy  

1. Create a query, selecting the tables or queries that contain the records you want 
to put in the new table.  

2. In query Design view, click the arrow next to Query Type on the toolbar, and 
then click Make Table. The Make Table dialog box appears. 

3. In the Table Name box, enter the name of the table you want to create or 
replace. 

4. Click Current Database to put the new table in the currently open database. Or 
click Another Database and type the name of the database you want to put the 
new table in. Type the path if necessary. 

5. Click OK. 

6. Drag from the field list to the query design grid the fields you want in the new 
table. 

7. In the Criteria cell for the fields that you've dragged to the grid, type the criteria.  
8. To preview the new table before you create it, click View on the toolbar. To 

return to query Design view and make changes or run the query, click View 
on the toolbar. 

9. To create the new table, click Run on the toolbar.  

Notes  

• To stop a query after you start it, press CTRL+BREAK. 

• The data in the new table you create does not inherit the field properties or the 
primary key setting from the original table.  

 
CChhaannggee  rreeccoorrddss  aass  aa  ggrroouupp  uussiinngg  aann  uuppddaattee  qquueerryy  

1. Create a query, selecting the tables or queries that include the records you want 
to update and the fields you want to use for setting criteria.  

2. In query Design view, click the arrow next to Query Type on the toolbar, and 
then click Update Query. 

3. Drag from the field list to the query design grid the fields you want to update or 
you want to specify criteria for. 

4. In the Criteria cell, specify the criteria if necessary.  



 

 
 

For information on specifying criteria, click .  

5. In the Update To cell for the fields you want to update, type the expression or 
value you want to use to change the fields, as shown in the following illustration.  

6. To see a list of the records that will be updated, click View on the toolbar. This 
list won't show the new values. To return to query Design view, click View on the 
toolbar again. Make any changes you want in Design view. 

7. Click Run on the toolbar to update the records.  

Note   To stop a query after you start it, press CTRL+BREAK. 
 
EExxaammpplleess  ooff  eexxpprreessssiioonnss  iinn  uuppddaattee  qquueerriieess  
Use expressions such as the following in the Update To cell in the query design grid for 
the field you want to update. 

Expression Result 

"Salesperson" Changes value to Salesperson 

#8/10/96# Changes date values to 10-Aug-96 

Yes Changes No values in a Yes/No field to Yes 

"PN"&[PartNumber] Adds PN to the beginning of each specified 
part number 

[UnitPrice]*[Quantity] Calculates the product of UnitPrice and 
Quantity 

[Freight]*1.5 Increases freight charges by 50 percent 

DSum("[Quantity]*[UnitPrice]", 
"Order Details","[ProductID]=" & 
[ProductID]) 

Where the Product IDs in the current table 
match the Product IDs in the Order Details 
table, updates sales totals based on the 
product of Quantity and UnitPrice 

Right([ShipPostalCode],5) Truncates the leftmost characters in a field, 
leaving the five rightmost characters 

 
AAppppeenndd  rreeccoorrddss  ffrroomm  oonnee  ttaabbllee  ttoo  aannootthheerr  ttaabbllee  uussiinngg  aann  aappppeenndd  
qquueerryy  

1. Create a query that contains the table whose records you want to append to 
another table.  

2. In query Design view, click the arrow next to Query Type on the toolbar, and 
then click Append. The Append dialog box appears. 



 

 
 

3. In the Table Name box, enter the name of the table you want to append records 
to. 

4. Click Current Database if the table is in the currently open database. Or click 
Another Database and type the name of the database where the table is stored. 
Type the path if necessary.  

You can also enter a path to a Microsoft FoxPro, Paradox, or dBASE database, 
or a connection string to an SQL database.  

5. Click OK. 

6. Drag from the field list to the query design grid the fields you want to append and 
any fields you want to use for setting criteria. Also, you may or may not want to 
add the primary key field if it has an AutoNumber data type.  

7. If all the fields in both tables have the same names, you can just drag the 
asterisk (*) to the query design grid. However, if you're working in a database 
replica, you'll need to add all the fields instead.  

8. If the fields you've selected have the same name in both tables, Microsoft Access 
automatically fills the matching name in the Append To row. If the fields in the 
two tables don't have the same name, in the Append To row, enter the names of 
the fields in the table you're appending to. 

9. In the Criteria cell for the fields that you have dragged to the grid, type the 
criteria on which additions will be made.  

10. To preview the records that the query will append, click View on the toolbar. To 
return to query Design view, click View on the toolbar again. Make any changes 
you want in Design view. 

11. Click Run on the toolbar to add the records.  

Note   To stop a query after you start it, press CTRL+BREAK. 
 
DDeelleettee  rreeccoorrddss  ffrroomm  oonnee  ttaabbllee  oorr  ttaabblleess  iinn  aa  oonnee--ttoo--oonnee  rreellaattiioonnsshhiipp  

1. Create a new query that contains the tables from which you want to delete 
records.  

2. In query Design view, click the arrow next to Query Type on the toolbar, and 
then click Delete Query. 

3. For the tables you want to delete records from, drag the asterisk (*) from the field 
list to the query design grid.  

From appears in the Delete cell under these fields, as shown in the illustration 
that follows.  



 

 
 

4. To specify criteria for deleting records, drag to the design grid the fields on which 
you want to set criteria.  

Where appears in the Delete cell under these fields, as shown in the following 
illustration.  

5. In the Criteria cell for the fields that you have dragged to the grid, type the 
criteria.  

6. To preview the records that will be deleted, click View on the toolbar. To return to 
query Design view, click View on the toolbar again. Make any changes you want 
in Design view.  

7. Click Run on the toolbar to delete the records.  

Note   To stop a query after you start it, press CTRL+BREAK. 
 
DDeelleettee  rreeccoorrddss  bbyy  uussiinngg  aa  qquueerryy  tthhaatt  iinncclluuddeess  oonnllyy  tthhee  ""oonnee""  ttaabbllee  iinn  aa  
oonnee--ttoo--mmaannyy  rreellaattiioonnsshhiipp  
When you run a delete query on the "one" table in a one-to-many relationship, and 
you've enabled cascading deletes for this relationship, Microsoft Access also deletes 
related records from the "many" side. Create a new query that contains the "one" table 
from which you want to delete records.  

1. In query Design view, click the arrow next to Query Type on the toolbar, and 
then click Delete Query. 

2. Drag the asterisk (*) from the field list for the table to the query design grid.  

From appears in the Delete cell under this field, as shown in the illustration that 
follows.  

3. To specify criteria for deleting records, drag to the design grid the fields on which 
you want to set criteria.  

Where appears in the Delete cell under this field, as shown in the following 
illustration.  

4. In the Criteria cell for the fields that you have dragged to the grid, type the 
criteria.  

5. To preview the records that will be deleted, click View on the toolbar. To return to 
query Design view, click View on the toolbar again. Make any changes you want 
in Design view.  

6. Click Run on the toolbar to delete the records.  

Note   To stop a query after you start it, press CTRL+BREAK. 



 

 
 

 
DDeelleettee  rreeccoorrddss  bbyy  uussiinngg  aa  qquueerryy  tthhaatt  iinncclluuddeess  bbootthh  ttaabblleess  iinn  aa  oonnee--ttoo--
mmaannyy  rreellaattiioonnsshhiipp  

1. Create a new query that contains the tables from which you want to delete 
records or set criteria.  

2. In query Design view, click the arrow next to Query Type on the toolbar, and 
then click Delete Query. 

3. From the table with related records (on the "many" side of the one-to-many 
relationship), drag the asterisk (*) from the field list to the query design grid.  

From appears in the Delete cell under this field, as shown in the following 
illustration.  

4. From the primary table (on the "one" side of the one-to-many relationship), drag 
to the design grid the fields on which you want to set criteria.  

Where appears in the Delete cell under this field, as shown in the following 
illustration.  

5. In the Criteria cell for the fields that you have dragged to the grid, type the 
criteria.  

6. To preview the records that will be deleted, click View on the toolbar. To return to 
query Design view, click View on the toolbar again. Make any changes you want 
in Design view. 

7. Click Run on the toolbar to delete the records from the table on the "many" side. 

8. Select the field list for each table on the "many" side and press DELETE to 
remove it from the query. 

9. With just the primary table remaining in the query and the field on which you want 
to set criteria in the design grid, click Run again. Microsoft Access deletes the 
specified records from the "one" table.  

Note   To stop a query after you start it, press CTRL+BREAK. 
 
 
WWhhaatt  iiss  aa  ccrroossssttaabb  qquueerryy  aanndd  wwhheenn  wwoouulldd  yyoouu  uussee  oonnee??    
A crosstab query displays summarized values (sums, counts, and averages) from one 
field in a table and groups them by one set of facts listed down the left side of the 
datasheet and another set of facts listed across the top of the datasheet. 
 
Tip   You can display crosstab data without creating a separate query in your database 
either by using the PivotTable Wizard in a form or by creating a PivotTable list in a data 

 



 

 
 

access page. With a PivotTable form or PivotTable list, you can change row and column 
headings on demand to analyze your data in different ways.  
 
CCrreeaattee  aa  ccrroossssttaabb  qquueerryy  wwiitthhoouutt  uussiinngg  aa  wwiizzaarrdd  

To see an example of a crosstab query before you begin, click .  

1. In the Database window, click Queries under Objects, and then click New on 
the Database window toolbar. 

2. In the New Query dialog box, click Design View, and then click OK. 

3. In the Show Table dialog box, click the tab that lists the tables or queries whose 
data you want to work with. 

4. Double-click the name of each object you want to add to the query, and then click 
Close. 

5. Add fields to the Field row in the design grid and specify criteria. 

6. On the toolbar, click Query Type and then click Crosstab. 

7. For the field or fields whose values you want to appear as row headings, click the 
Crosstab row, and then click Row Heading.  

You must leave the default Group By in the Total row for these fields.  

8. For the field whose values you want to appear as column headings, click the 
Crosstab row, and then click Column Heading. You can choose Column 
Heading for one field only, and you must leave Group By in the Total row for 
this field.  

By default, the column headings are sorted in alphabetic or numeric order. If you 
want them to appear in a different order, or if you want to limit which column 
headings display, set the query's ColumnHeadings property.  

9. For the field whose values you want to use in the cross-tabulation, click the 
Crosstab row, and then click Value.  

Only one field can be set to Value.  

10. In the Total row for this field, click the type of aggregate function you want for the 
cross-tabulation (such as Sum, Avg, or Count). 

11. To specify criteria that limit row headings before the calculation is performed, 
enter an expression in the Criteria row for a field with Row Heading in the 



 

 
 

Crosstab cell. For example, you might display sales totals for products in certain 
categories, such as meat and seafood.  

To specify criteria that limit records before the row headings are grouped and 
before the cross-tabulation is performed, add the field you want to set criteria for 
to the design grid, click Where in the Total cell, leave the Crosstab cell blank, 
and then enter an expression in the Criteria row. (The query results won't display 
fields that have Where in the Total row.)  

12. To view the query's results, click View on the toolbar.  

To stop the query after you start it, press CTRL+BREAK.  

Notes  

• The query Quarterly Orders by Product in the Northwind sample database is an 
example of a crosstab query. To view this query, open the Northwind database in 
your Office folder's Samples folder, and then open Quarterly Orders by Product 

in Design view. For information on opening Northwind, click . 

• If you include a field in the query design grid, but click the (Not Shown) option in 
the Crosstab cell and Group By in the Total cell, Microsoft Access groups on it 
as a Row Heading, but doesn't display the row in the query's results. 

• The values in your Column Heading field may include characters usually not 
allowed in field names, such as decimals. If they do, Microsoft Access replaces 
the character with an underscore in the datasheet. 

SSoorrtt  oorr  lliimmiitt  ccoolluummnn  hheeaaddiinnggss  ddiissppllaayyeedd  iinn  aa  ccrroossssttaabb  qquueerryy  
In column headings containing, for example, the months of the year, you can display the 
months chronologically rather than alphabetically, and you can display only the columns 
for January through June.  

1. Design your crosstab query either with or without the help of a wizard.  

2. Display the query in Design view. 

3. Click the background of query Design view, outside the design grid and the field 
lists. 

4. On the toolbar, click Properties to display the query's property sheet. 

5. In the ColumnHeadings property box, enter the column headings you want to 
display, in the order in which you want to display them. Between the column 
headings, type a comma or the list separator for your country. (To find the list 



 

 
 

separator for your country, double-click Regional Settings in the Windows Control 
Panel.)  

The column headings you enter must exactly match the column headings in the 
query datasheet. For example, if a column heading in the datasheet is "USA," 
you must enter a column heading of "USA" — not "US." (After you press ENTER 
or move the pointer to a different location, Microsoft Access places quotation 
marks around each heading.)  

6. To view the query's results, click View on the toolbar.  

Notes    

• If you run a crosstab query often, or if you use it as the basis for a form, report, or 
data access page, you can speed up the query by using the preceding procedure 
to specify fixed column headings. 

• If you frequently use the same column headings in different queries, consider 
creating a table with one Text field to store the column headings. Then open the 
table and copy the headings into the ColumnHeadings property box as needed.  

WWhhaatt  iiss  aa  ppaarraammeetteerr  qquueerryy  aanndd  wwhheenn  wwoouulldd  yyoouu  uussee  oonnee??  
A parameter query is a query that when run displays its own dialog box prompting you 
for information, such as criteria for retrieving records or a value you want to insert in a 
field. You can design the query to prompt you for more than one piece of information; 
for example, you can design it to prompt you for two dates. Microsoft Access can then 
retrieve all records that fall between those two dates. 
Parameter queries are also handy when used as the basis for forms, reports, and data 
access pages. For example, you can create a monthly earnings report based on a 
parameter query. When you print the report, Microsoft Access displays a dialog box 
asking for the month that you want the report to cover. You enter a month and Microsoft 
Access prints the appropriate report.  
You can also create a custom form or dialog box that prompts for a query's parameters 

instead of using the parameter query's dialog box. For more information, click . 
 
CCrreeaattee  aa  ppaarraammeetteerr  qquueerryy  tthhaatt  pprroommppttss  ffoorr  ccrriitteerriiaa  eeaacchh  ttiimmee  iitt''ss  rruunn  
A parameter query displays one or more predefined dialog boxes that prompt you for 
the parameter value (criteria). You can also create a custom dialog box that prompts for 

the query's parameters. For more information, click .  

1. Create a select or crosstab query. 

2. In query Design view, drag the fields from the field list to the query design grid. 



 

 
 

3. In the Criteria cell for each field you want to use as a parameter, type a prompt 
enclosed in square brackets. Microsoft Access will display this prompt when the 
query is run. The text of the prompt must be different from the field name, 
although it can include the field name.  

For a field that displays dates, you can display the prompts "Type the beginning 
date:" and "Type the ending date:" to specify a range of values. In the field's 
Criteria cell, type Between [Type the beginning date:] And [Type the ending 
date:].  

4. To view the results, click View on the toolbar, and then type a value for the 
parameter. To return to query Design view, click View on the toolbar again.  

Notes  

• You must specify a data type for parameters in a crosstab query or in a 
parameter query that a crosstab query or chart is based on. In the crosstab 
query, you must also set the ColumnHeadings property. In other parameter 
queries, specify a data type for a field with the Yes/No data type and fields that 
come from a table in an external SQL database.  

• To prompt the user for one or more characters to search for, and then find 
records that begin with or contain the characters the user specifies, create a 
parameter query that uses the LIKE operator and the wildcard symbol (*). For 
example, the statement:  

LIKE [Enter the first character to search by: ] & "*"  

searches for words that begin with a specified letter. The statement:  

LIKE "*" & [Enter any character to search by: ] & "*"  

searches for words that contain the specified character.  

• You can print parameters in a report. For more information, click .  

WWhhaatt  iiss  aann  SSQQLL  qquueerryy  aanndd  wwhheenn  wwoouulldd  yyoouu  uussee  oonnee??  
An SQL query is a query you create using an SQL statement. Examples of SQL-specific 
queries are the union query, pass-through query, data-definition query, and subquery. 
This topic provides examples of: 
Union query 
Pass-through query 
Data-definition query 
Subquery 



 

 
 

UUnniioonn  qquueerryy  
This type of query combines fields (columns) from one or more tables or queries into 
one field or column in the query's results. For example, if you have six vendors that 
send new inventory lists each month, you can combine these lists into one result set 
using a union query, and then create a make-table query based on the union query to 

make a new table. For examples of union queries, click . 
  
PPaassss--tthhrroouugghh  qquueerryy  
This type of query sends commands directly to ODBC databases, such as Microsoft 
FoxPro, using commands that are accepted by the server. For example, you can use a 
pass-through query to retrieve records or change data. 
  
DDaattaa--ddeeffiinniittiioonn  qquueerryy  
This type of query creates, deletes, alters tables, or creates indexes in a database , 
such as Microsoft Access or Microsoft FoxPro tables. 
  
SSuubbqquueerryy  
This type of query consists of an SQL SELECT statement inside another select query or 
action query. You can enter these statements in the Field row of the query design grid 
to define a new field, or in the Criteria row to define criteria for a field. You can use 
subqueries to:  

• Test for the existence of some result from the subquery (using the EXISTS or 
NOT EXISTS reserved words).  

• Find any values in the main query that are equal to, greater than, or less than 
values returned by the subquery (using the ANY, IN, or ALL reserved words). 

• Create subqueries within subqueries (nested subqueries).  

 
UUssee  qquueerryy  DDeessiiggnn  vviieeww  ttoo  ggeenneerraattee  aann  SSQQLL  ssttaatteemmeenntt  ttoo  ppaassttee  
eellsseewwhheerree  
You can use SQL statements and clauses in many expressions, as arguments of 
procedures, and as property settings. For example, you can use an SQL statement to 
set the RowSource property of a list box in a form or report to generate a list of items.  

1. In query Design view, create the query from which you want to generate the SQL 
statement. 

2. Click the arrow next to the View button on the toolbar, and then click SQL View. 

3. Select all or part of the SQL statement, and then press CTRL+C to copy the 
selected text onto the Clipboard. 



 

 
 

4. Place the insertion point where you want to paste the SQL statement, such as in 
a property box or in the Code window of the Visual Basic Editor. 

5. Press CTRL+V.  

Notes  

• You can create or edit a query in SQL view instead of Design view. To do so, 
switch to SQL view and type or modify the SQL statement for your query. If you 
then switch back to Design view, the SQL statement will be represented in the 
design grid. 

• Most query properties in the property sheet in query Design view have equivalent 
clauses and options available in SQL view. 

• If you use a wizard to create a form, report, or data access page based on more 
than one table or to create a list box or combo box, Microsoft Access 
automatically creates an SQL statement to use as the record source for the form, 
report, or page or the row source for the list box or combo box. Without using a 
wizard, you can generate an SQL statement for the RecordSource or 
RowSource properties by clicking the Build button next to either of these 
properties, and then creating a query in query Design view. 

You can't use the design grid to create SQL-specific queries. For these types of queries, 
you must use SQL view.    



 

 
 

CChhaapptteerr  44  ::  FFoorrmmss  
FFoorrmmss::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
 
 
 
 
 
 
 
 
 
 
 
 

  
CCrreeaattee  aa  ffoorrmm  
Create a form by using AutoForm. With AutoForm, you select one record source and 
either columnar, tabular, or datasheet layout; AutoForm creates a form that uses all the 
fields from the record source you selected and all the fields from its related record 
sources. 
Create a form with a wizard. The wizard asks you detailed questions about the record 
sources, fields, layout, and format you want and creates a form based on your answers. 
Create a form on my own 
Create a form based on more than one table 
 
CCrreeaattee  aa  ffoorrmm  bbyy  uussiinngg  AAuuttooFFoorrmm  
AutoForm creates a form that displays all fields and records in the underlying table or 
query. If the record source you select has related tables or queries, the form will also 
include all the fields and records from those record sources.  

1. In the Database window, click Forms under Objects. 

2. Click the New button on the Database window toolbar. 

3. In the New Form dialog box, click one of the following wizards:  
o AutoForm: Columnar   Each field appears on a separate line with a label 

to its left. 

o AutoForm: Tabular   The fields in each record appear on one line, with 
the labels displayed once at the top of the form. 



 

 
 

o AutoForm: Datasheet   The fields in each record appear in row-and-
column format, with one record in each row and one field in each column. 
The field names appear at the top of each column.  

4. Click the table or query that contains the data you want to base your form on. 

5. Click OK.  

Microsoft Access applies the last autoformat you used to the form. If you haven't 
created a form with a wizard before or haven't used the AutoFormat command on the 
Format menu, it uses the Standard autoformat. 
Tip    You can also create a columnar AutoForm based on the open record source or 
the record source that's selected in the Database window. Click AutoForm on the 
Insert menu, or click the arrow next to the New Object button on the toolbar, and then 
click AutoForm. If the record source you select has related tables, AutoForm adds a 
subform control that contains the related tables displayed as datasheets and 
subdatasheets. 
 
CCrreeaattee  aa  ffoorrmm  wwiitthh  aa  wwiizzaarrdd  

1. In the Database window, click Forms under Objects. 

2. Click the New button on the Database window toolbar. 

3. In the New Form dialog box, click the wizard that you want to use. A description 
of the wizard appears in the left side of the dialog box. 

4. Click the name of the table or other record source that includes the data you 
want to base your form on.  

Note   You don't need to do this step if you click the Form Wizard option — you 
can specify the record source for the form in the wizard.  

5. Click OK. 

6. If you clicked Form Wizard, Chart Wizard, or PivotTable Wizard in step 3, 
follow the directions in the wizard dialog boxes. If you clicked AutoForm: 
Columnar, AutoForm: Tabular, or AutoForm: Datasheet, Microsoft Access 
automatically creates your form.  

If the resulting form doesn't look the way you want, you can change it in Design 
view.  

Note   If you click one of the AutoForm options, Microsoft Access uses the autoformat 
you last specified, either in the Form Wizard or using the AutoFormat command on the 
Format menu in Design view. 
 



 

 
 

CCrreeaattee  aa  bbllaannkk  ffoorrmm  aanndd  sseelleecctt  aa  rreeccoorrdd  ssoouurrccee  

1. In the Database window, click Forms under Objects. 

2. Click the New button on the Database window toolbar. 

3. In the New Form dialog box, click Design View. 

4. Click the name of the table or other record source that includes the data you 
want to base your form on. If the form won't contain data (for example, if you 
want to create a form to use as a switchboard to open other forms or reports, or if 
you want to create a custom dialog box), don't select anything from this list.  

Note   If you want to create a form that uses data from more than one table, base 
your form on a query.  

5. Click OK.  

Microsoft Access displays the form in Design view. For information on what you can do 

in Design view, click . 
 
CCrreeaattee  aa  ffoorrmm  aanndd  aa  ssuubbffoorrmm  aatt  tthhee  ssaammee  ttiimmee  
Before using this procedure, make sure you've set up your table relationships correctly.  

1. In the Database window, click Forms under Objects. 

2. Click the New button on the Database window toolbar. 

3. In the New Form dialog box, double-click Form Wizard in the list. 

4. In the first wizard dialog box, select a table or query from the list. For example, to 
create a Categories form that displays products for each category in a subform, 
select the Categories table (the "one" side of the one-to-many relationship). 

5. Double-click the fields you want to include from this table or query. 

6. In the same wizard dialog box, select another table or query from the list. Using 
the same example, select the Products table (the "many" side of the one-to-many 
relationship in the Categories form example).  

Note   It doesn't matter which table or query you choose first.  

7. Double-click the fields you want to include from this table or query. 



 

 
 

8. When you click Next, if you set up the relationships correctly before starting the 
wizard, the wizard asks which table or query you want to view by. Using the 
same example, to create the Categories form, click By Categories. 

9. In the same wizard dialog box, select the Form With Subform(s) option. 

10. Follow the directions in the remaining wizard dialog boxes. When you click 
Finish, Microsoft Access creates two forms, one for the main form and subform 
control, and one for the subform.  

 
CCrreeaattee  aa  ssuubbffoorrmm  aanndd  aadddd  iitt  ttoo  aann  eexxiissttiinngg  ffoorrmm  
Before using this procedure, make sure you've set up your table relationships correctly.  

1. Open the form that you want to add the subform to in Design view. 

2. Make sure the Control Wizards tool in the toolbox is pressed in. 

3. Click the Subform/Subreport tool in the toolbox. 

4. On the form, click where you want to place the subform. 

5. Follow the directions in the wizard dialog boxes. 

6. When you click Finish, Microsoft Access adds a subform control to your form. It 
also creates a separate form for the subform.  

AAdddd  aann  eexxiissttiinngg  ffoorrmm  ttoo  aannootthheerr  eexxiissttiinngg  ffoorrmm  ttoo  ccrreeaattee  aa  ffoorrmm  wwiitthh  aa  
ssuubbffoorrmm  
Before using this procedure, make sure you've set up your table relationships correctly.  

1. Open the form that you want to use as the main form in Design view. This is 
usually a form based on a table or query on the "one" side of a one-to-many 
relationship. 

2. Make sure the Control Wizards tool in the toolbox is pressed in. 

3. Press F11 to switch to the Database window. 

4. Drag a form, table, or query from the Database window to the main form.  

Microsoft Access adds a subform control to the form. If you dragged a form 
displayed in Form view, Microsoft Access displays the subform in that view. If 
you dragged a form displayed in Datasheet view or a table or query, Microsoft 
Access displays the subform as a datasheet.  

Notes  



 

 
 

 
CCrreeaattee  aa  ffoorrmm  wwiitthh  ttwwoo  ssuubbffoorrmmss  
Before using this procedure, make sure you've set up your table relationships correctly. 
You can use this procedure to create a form and two subforms that have a one-to-
many-to-many relationship. The main form has a one-to-many relationship with the first 
subform, and the first subform has a one-to-many relationship with the second subform.  

1. In the Database window, click Forms under Objects. 

2. Click the New button on the Database window toolbar. 

3. In the New Form dialog box, double-click Form Wizard in the list. 

4. In the first wizard dialog box, select the table or query for the main form. For 
example, suppose you want to create a Customers form that has two subforms 
— an Orders subform and an Order Details subform. Select the Customers table 
(the "one" side of the first one-to-many relationship). 

5. Double-click the fields you want to include from this table or query. 

6. In the same wizard dialog box, select the table or query for the first subform. 
Using the same example, select the Orders table (the "many" side of the first 
one-to-many relationship), and then double-click the fields you want to include 
from this table or query.  

Note   It doesn't matter which table or query you choose first.  

7. In the same wizard dialog box, select the table or query for the second subform. 
Using the same example, select the Order Details table (the "many" side of the 
second one-to-many relationship), and then double-click the fields you want to 
include from this table or query. 

8. When you click Next, if you set up the relationships correctly before starting the 
wizard, the wizard asks which table or query you want to view by. Using the 
same example, to create the Customers form, click By Customers. 

9. In the same wizard dialog box, select the Form With Subform(s) option. 

10. Follow the directions in the remaining wizard dialog boxes. When you click 
Finish, Microsoft Access creates a main form with two subform controls. It also 
creates two other forms, one for each subform.  

Notes  

• When you use a wizard to create a form with two subforms, Microsoft Access 
synchronizes the subforms by attaching an event procedure to the OnCurrent 
property of the first subform. You can copy and modify this event procedure if 



 

 
 

you want to synchronize more subforms on the same form. To see this event 
procedure, open the first subform in Design view, double-click the form selector, 
and then click the Build button next to the OnCurrent property. 

• The Customer Orders form in the Northwind sample database is a form with two 
subforms. To view this form, open the Northwind database in your Office folder's 

Samples folder, and then open the Customer Orders form in Design view. . 

 
CCrreeaattee  aa  ffoorrmm  wwiitthh  aa  ssuubbffoorrmm  tthhaatt  ccoonnttaaiinnss  aannootthheerr  ssuubbffoorrmm  
Before using this procedure, make sure you've set up your table relationships correctly. 
You can use this procedure to create a form and two levels of subforms that have a 
one-to-many relationship. The main form has a one-to-many relationship with the first 
subform, and the first subform has a one-to-many relationship with the second subform.  

1. Create a form with a subform.  

Note   Make sure to select the Tabular (the equivalent of Form view) option 
when the wizard asks what layout you want for the subform. If you select the 
Datasheet option, you won't be able to insert a subform inside the subform.  

2. In Design view of the main form, make sure the subform control is selected. After 
it’s selected, you can click again inside the control to select the form, a section, 
or a control, just as you would if you opened the subform in Design view from the 
Database window.  

3. Do one of the following:  
o Use the Subform Wizard to create the second subform.  
o Drag a form, table, or query from the Database window to the subform.  

Microsoft Access creates another subform inside the first subform and 
creates a form for the subform.  

4. Switch to Form view to see the form and subforms.  

HHooww  aa  ffiilltteerr  aanndd  ssoorrtt  oorrddeerr  ffoorr  aa  ttaabbllee  oorr  qquueerryy  aaffffeeccttss  nneeww  ffoorrmmss  oorr  
rreeppoorrttss  
When you create a form or report based on a table or query that has a filter or a sort 
order specified in it, Microsoft Access includes the filter and sort order with the form or 
report. The sort order is automatically applied. Whether or not the filter is automatically 
applied depends on how you create the form or report.  

• If you create the form or report directly from filtered data while the data is 
displayed in an open table or query, the filter is applied automatically each time 



 

 
 

you view the report, but it is applied only the first time you view the form after 
creating it. (The next time you open the form, you'll apply the filter yourself.) 

• If you create the form or report based on a closed table or query, the filter won't 
be applied in the new form or report. You apply it when you need it.  

 
CCrreeaattee  aa  ffoorrmm  oorr  rreeppoorrtt  ffrroomm  ffiilltteerreedd  rreeccoorrddss  

1. With the filtered records displayed, click the arrow next to the New Object button 
on the toolbar.  

o To use the AutoForm or AutoReport Wizard, click AutoForm or 
AutoReport. 

o To specify the type of form or report you want to create, click Form or 
Report, and then make your selection.  

The new object uses as its record source the table or query in which the 
filter was created, and it inherits the filter.  

2. Complete the design or make any other changes you want to the form or report, 
and then save it.  

Notes  

• If a sort order was specified in the underlying table or query, the new form or 
report will use it. 

• If you subsequently change the filter in a table or query, it has no effect on a form 
or report that was based on a filter you created previously in that table or query.  

 
OOppeenn  aa  ffoorrmm  

1. In the Database window, click Forms under Objects. 

2. Click the form you want to open. 

3. Click the Open button to open the form in Form view, or the Design button to 
open the form in Design view.  

Tip   You can also open a form in Form view by dragging the form from the Database 
window to the application background. 
Once you've opened a form, you can easily switch among the three views of the form by 
clicking the View button on the toolbar. 
 



 

 
 

SSeett  pprrooppeerrttiieess  ffoorr  aa  ffoorrmm,,  rreeppoorrtt,,  sseeccttiioonn,,  oorr  ccoonnttrrooll  

1. Open a form in Design view or a report in Design view. If the 
AllowDesignChanges property of a form is set to All Views, you can also set 
properties in Form view and Datasheet view. 

2. Do one of the following:  
o To set properties for a form or report, double-click the form selector or the 

report selector to open the property sheet for the form or report. 

o To set properties for a section on a form or report, double-click the section 
selector to open the property sheet for the section. 

o To set properties for a control, make sure the control is selected, and then 
click Properties on the toolbar. You can also double-click a control to 
open its property sheet.  

3. In the property sheet, click the property you want to set, and then do one of the 
following:  

o If an arrow appears in the property box, click it and then select a value 
from the list. 

o Type a setting or expression in the property box. 

o If a Build button appears next to the property box, click it to display a 
builder or to display a dialog box giving you a choice of builders. For 
example, you can use the Query Builder to change the design of an 
underlying query for a form or report.  

4. If you need more space to enter or edit a property setting, press SHIFT+F2 (or 
right-click and then click Zoom) to open the Zoom box.  

Tip   To get Help on any property in the property sheet, click the property and then 
press F1. 
 
TToo  pprreevviieeww  aa  ffoorrmm  ffrroomm  DDeessiiggnn  vviieeww,,  FFoorrmm  vviieeww,,  oorr  DDaattaasshheeeett  vviieeww  

1. Click Print Preview on the toolbar. 

2. To return to Design view, Form view, or Datasheet view, click the View button on 
the toolbar.  

TToo  pprreevviieeww  aa  ffoorrmm  ffrroomm  tthhee  DDaattaabbaassee  wwiinnddooww  

1. Click Forms under Objects. 

2. Select the form you want to preview. 

3. Click Print Preview on the toolbar.  



 

 
 

How Microsoft Access displays a form in Print Preview depends on the view from 
which you preview it. 

From You see the form 

Design view In Form view. 

Form view In Form view. 

Datasheet view As a datasheet. 

Database window In the view specified by the DefaultView property 
of the form. 

 

For information on viewing a form at different magnifications, click . 

For information on viewing two or more pages at one time, click . 
 
SSeett  ppaaggee  sseettuupp  ooppttiioonnss  ffoorr  aa  ttaabbllee,,  qquueerryy,,  ffoorrmm,,  oorr  rreeppoorrtt  

1. Open the database object in one of the following views:  
o Open a table or query in Datasheet view or Print Preview. 

o Open a form or report in any view (or from the Database window).  

Note   Page setup options aren't available for macros or modules.  

2. On the File menu, click Page Setup. 

3. Click the following tabs for the options you want to set:  
o Margins. To set margins and whether to print data only (for forms and 

reports) or to print headings (for tables or queries). 

o Page. To set orientation, paper size, and printer. 

o Columns. To set number, size, and layout of columns (for forms and 
reports).  

4. Click OK.  

Microsoft Access stores the settings for page setup options with a form or report, 
so you set these options only once for each form or report. For tables, queries, 
and modules, you must set page setup options every time you print.  

 



 

 
 

SSeett  tthhee  ooppeenniinngg  vviieeww  ooff  aa  ffoorrmm  ((oonnee  rreeccoorrdd,,  mmoorree  tthhaann  oonnee,,  oorr  
ddaattaasshheeeett))  

1. Open the form in Design view. 

2. Double-click the form selector to open the form's property sheet. 

3. In the DefaultView property box, click one of the following settings.  

Setting Description 

Single Form Displays one complete record at a time. (Form view 
only) 

Continuous Forms Displays as many complete records as will fit in the 
detail section of the form. (Form view only) 

Datasheet  Displays records arranged as rows and columns. 
Records may scroll off the screen. 

Note   If you want to disable Form view or Datasheet view, you can set the 
ViewsAllowed property. 
 
AAdddd  oorr  rreemmoovvee  aa  ffoorrmm  hheeaaddeerr  aanndd  ffooootteerr  oorr  aa  ppaaggee  hheeaaddeerr  aanndd  ffooootteerr  

1. Open the form in Design view. 

2. Click Form Header/Footer or Page Header/Footer on the View menu.  

Notes    

• Form headers and footers appear at the top and bottom of a form in Form view 
and at the beginning and end of a printed form. Page headers and footers appear 
at the top and bottom of each printed page — they don't appear in Form view. 

• If you remove a header and footer, Microsoft Access deletes the controls in the 
header and footer. 

• You can only add a header and footer as a pair. If you don't want both a header 
and a footer, you can size the one you don't want so that it has no height, or you 
can set its Visible property to No. You can also set the DisplayWhen property of 
a form header and footer to specify when you want the header and footer to be 
displayed ? always, in print only, or on the screen only.  

Example of using different types of sections in forms  
 



 

 
 

SSiizzee  aa  ffoorrmm  ttoo  ffiitt  iittss  ccoonntteennttss  

1. Open a form in Form view. 

2. Click Size To Fit Form on the Window menu.  

Note   If the Form window is maximized, the Size To Fit Form command is 
unavailable.  

3. Click Save on the toolbar to save the size of the form.  

When you click Size To Fit Form, Microsoft Access adjusts the size of the form 
depending on whether the form's DefaultView property setting is set to Single Form or 
Continuous Forms.  

• Single Form. If the displayed record is smaller than the Form window, Size To 
Fit Form crops the window to the size of the record. If the record is larger than 
the Form window, Size To Fit Form expands the Form window to show as much 
of the record as possible. 

• Continuous Forms. If only part of the bottom record is displayed, Size To Fit 
Form crops that record. If only one record is partially displayed, Size To Fit 
Form enlarges the window to show as much of the record as possible.  

CChhaannggee  ttaabb  oorrddeerr  iinn  aa  ffoorrmm  

1. Open the form in Design view. 

2. On the View menu, click Tab Order. 

3. Under Section, click the section you want to change. 

4. Do one of the following:  
o If you want Microsoft Access to create a left-to-right and top-to-bottom tab 

order, click Auto Order.  

o If you want to create your own custom tab order, click the selector for the 
control you want to move. (Click and drag to select more than one control 
at a time.) Click the selector again and drag the control to the desired 
location in the list.  

5. Click OK. 

6. Switch to Form view to test the tab order. (In Design view, the tab order is always 
the order in which you created the controls.)  

Notes  



 

 
 

• If you want to be able to select a control on a form, but you don't want to include 
that control in the tab order, set its TabStop property to No. 

• You can also specify which record or page to move the focus to when you press 
the TAB key in the last field in the current record.  

CChhaannggee  tthhee  ttaabb  bbeehhaavviioorr  ffoorr  tthhee  llaasstt  ffiieelldd  oonn  aa  ffoorrmm  

1. Open a form in Design view. 

2. Double-click the form selector to open the form's property sheet.  

3. In the Cycle property box, click one of the following settings.  

Setting Description 

All Records When you press TAB in the last field in the record, 
the focus moves to the first field in the next record. 

Current Record When you press TAB in the last field in the record, 
the focus moves back to the first field in the current 
record. 

Current Page When you press TAB in the last field in the form 
page, the focus moves back to the first field in the 
current page. 

 
SSuubbffoorrmmss::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
A subform is a form within a form. The primary form is called the main form, and the 
form within the form is called the subform. A form/subform combination is often referred 
to as a hierarchical form, a master/detail form, or a parent/child form. 
Subforms are especially effective when you want to show data from tables or queries 
with a one-to-many relationship. For example, you could create a form with a subform to 
show data from a Categories table and a Products table. The data in the Categories 
table is the "one" side of the relationship. The data in the Products table is the "many" 
side of the relationship — each category can have more than one product. 

 
The main form and subform in this type of form are linked so that the subform displays 
only records that are related to the current record in the main form. For example, when 
the main form displays the Beverages category, the subform displays only the products 
in the Beverages category. 
When you use a form with a subform to enter new records, Microsoft Access saves the 
current record in the main form when you enter the subform. This ensures that the 
records in the "many" table will have a record in the "one" table to relate to. It also 
automatically saves each record as you add it to the subform. 



 

 
 

A subform can be displayed as a datasheet, as in the preceding illustration, or it can be 
displayed as a single or continuous form. A main form can be displayed only as a single 
form. 
A main form can have any number of subforms if you place each subform on the main 
form. You can also nest up to ten levels of subforms. This means you can have a 
subform within a main form, and you can have another subform within that subform, and 
so on. For example, you could have a main form that displays customers, a subform 
that displays orders, and another subform that displays order details. 
  
CCrreeaattee  aa  ccaallccuullaatteedd  ccoonnttrrooll  oonn  aa  ffoorrmm  oorr  rreeppoorrtt  

1. Open a form in Design view or a report in Design view. 

2. Click the tool in the toolbox for the type of control you want to use as the 
calculated control.  

Note   A text box is the most common type of control to use to display a 
calculated value, but you can use any control that has a ControlSource 
property.  

3. On the form or report, click where you want to place the control. 

4. Do one of the following:  
o If the control is a text box, you can type the expression directly in the text 

box.  
o For any control, make sure the control is selected, click Properties on the 

toolbar to display the control's property sheet, and type the expression in 
the ControlSource property box. To use the Expression Builder to create 
the expression in a Microsoft Access database (.mdb), click the Build 
button next to the ControlSource property box.  

Notes  

• In a calculated control, precede each expression with the = operator. 

• If you need more room to type an expression in the ControlSource property box, 
press SHIFT+F2 to open the Zoom box. 

• If a form is based on a query, you may want to put the expression in the query 
instead of in a calculated control. For information on creating a calculated field in 
a query in a Microsoft Access database (.mdb). 

 
CCaallccuullaattee  aa  ttoottaall  ffoorr  oonnee  rreeccoorrdd  iinn  aa  ffoorrmm  

1. Open the form in Design view. 



 

 
 

2. Click the Text Box tool in the toolbox. 

3. In the form's detail section, click where you want to place the text box. 

4. Do one of the following:  
o Place the insertion point in the text box and type an expression that 

calculates a total.  

o Make sure the text box is selected, click Properties on the toolbar to open 
its property sheet, and type the expression in the ControlSource property 
box. In a Microsoft Access database (.mdb), to use the Expression Builder 
to create the expression, click the Build button next to the ControlSource 
property box.  

Notes  

• If you need more room to type an expression in the ControlSource property box, 
press SHIFT+F2 to open the Zoom box. 

• If a form is based on a query, you may want to put the expression in the query 
instead of in a calculated control.  

 
AAbboouutt  ccaallccuullaattiinngg  aa  ttoottaall  iinn  aa  ssuubbffoorrmm  aanndd  ddiissppllaayyiinngg  iitt  oonn  aa  ffoorrmm  
 
You can use a form with a subform to calculate a total for a group of records. The main 
form and the subform are based on tables with a one-to-many relationship. The main 
form shows records from the "one" side of the relationship; the subform shows records 
from the "many" side of the relationship. For example, the following illustration shows an 
Orders form that includes a subform. 
 
To calculate the order subtotal, you add a text box to the form footer of the subform and 
specify an expression in the ControlSource property box for the text box. The 
expression uses the Sum function. For example, the following expression calculates the 
total amount for all the products in the Orders form:  
=Sum([Quantity]*[UnitPrice])  
 
To display the order subtotal on the main form, create a text box on the main form that 
uses an expression to refer to the control on the subform that contains the calculated 
value. For example, you could specify the following expression in the ControlSource 
property box of the text box on the main form: 
 
Notes  

• If you want to use the value from a calculated control when computing a total, 
you can't use the name of the control in the Sum function. For example, if you 



 

 
 

had a control that calculated quantity * unit price, you'd still have to specify the 
full syntax =Sum([Quantity]*[UnitPrice]) in the expression. For this reason, when 
you use an expression that requires an aggregate function such as Sum, it's best 
to define the expression in the form's underlying query or SQL statement. Then 
you can use the name of the calculated field in the Sum function. For example, 
you could define a calculated field such as ExtendedPrice: [Quantity]*[UnitPrice] 
in an underlying query, and then use the field name in the expression that 
calculates the sum: =Sum([ExtendedPrice]).  

• The Orders form in the Northwind sample database has an example of a subform 
that calculates a subtotal that's displayed on the main form. To view this form, 
open the Northwind database in the Samples subfolder of your Office folder, and 
then open the Orders form in Design view.  

 
DDiissaabbllee  aa  tteexxtt  bbooxx  oorr  ootthheerr  ccoonnttrrooll  iinn  FFoorrmm  vviieeww  oorr  mmaakkee  ddaattaa  iinn  aa  
ccoonnttrrooll  rreeaadd--oonnllyy  

1. Open a form in Design view or a report in Design view. 

2. Make sure that the control is selected, and then click Properties on the toolbar to 
open its property sheet. 

3. Do one or both of the following:  
o If you want to disable the control completely so that it's dimmed and can't 

receive the focus, set the Enabled property to No. 

o If you want to make data in the control readable, but not allow users to 
change the data, set the Locked property to Yes. If you set the Enabled 
property to No and the Locked property to Yes, then the control won't 
appear dimmed, but it won't be able to receive the focus.  

Notes  

• You can use the Enabled property together with the AfterUpdate property to 
disable a control until a user enters text or makes a selection in another control. 
For example, you might want to disable a command button until data has been 
entered in a text box. You can use the AfterUpdate property of the text box to 
call an event procedure or a macro to enable the command button. 

• If you just want to keep a control off the tab order, but you want to make it 
possible to select that control, set the TabStop property for that control to No.  

MMaakkee  aa  ffoorrmm  rreeaadd--oonnllyy  

1. Open the form in Design view. 



 

 
 

2. Double-click the form selector to open the form's property sheet. 

3. In the AllowEdits property box, click No. 

4. In the AllowAdditions property box, click No. 

5. In the AllowDeletions property box, click No.  



 

 
 

CChhaapptteerr  ::  55  RReeppoorrttss  
RReeppoorrttss::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
 
 
 
 
 
 
 
 
 
 
 
 

  
OOppeenn  aa  rreeppoorrtt  

1. In the Database window, click Reports under Objects. 

2. Click the report you want to open. 

3. On the Database window toolbar, click the Design button to open the report in 
Design view, or click the Preview button to open the report in Print Preview.  

Tip   You can also open a report in Print Preview by dragging the report from the 
Database window to the application background. 
 
CCrreeaattee  aa  rreeppoorrtt  
Create a report by using AutoReport. With AutoReport, you select one record source 
and either columnar or tabular layout; AutoReport uses all the fields from the record 
source and applies the last autoformat you used to the report. 
Create a report with a wizard. The wizard asks you detailed questions about the record 
sources, fields, layout, and format you want and creates a report based on your 
answers. 
Create a report on my own 
 
CCrreeaattee  aa  rreeppoorrtt  uussiinngg  AAuuttooRReeppoorrtt  
AutoReport creates a report that displays all fields and records in the underlying table or 
query.  

1. In the Database window, click Reports under Objects. 



 

 
 

2. Click the New button on the Database window toolbar. 

3. In the New Report dialog box, click one of the following wizards:  
o AutoReport: Columnar. Each field appears on a separate line with a 

label to its left. 

o AutoReport: Tabular. The fields in each record appear on one line, and 
the labels print once at the top of each page.  

4. Click the table or query that contains the data you want to base your report on. 

5. Click OK.  

Microsoft Access applies the last autoformat you used to the report. If you 
haven't created a report with a wizard before or haven't used the AutoFormat 
command on the Format menu, it uses the Standard autoformat.  

Tip   You can also create a single-column report based on the open table or query or on 
the table or query selected in the Database window. Click AutoReport on the Insert 
menu, or click the arrow next to the New Object button on the toolbar, and then click 
AutoReport. Reports created with this method don't have a report header and footer or 
a page header and footer. 
 
CCrreeaattee  aa  rreeppoorrtt  wwiitthh  aa  wwiizzaarrdd  

1. In the Database window, click Reports under Objects. 

2. Click the New button on the Database window toolbar. 

3. In the New Report dialog box, click the wizard that you want to use. A 
description of the wizard appears in the left side of the dialog box. 

4. Click the table or query that contains the data you want to base your report on.  

Note   Microsoft Access uses this table or query as the default record source for 
the report. However, you can change the record source in the wizard and select 
fields from other tables and queries.  

5. Click OK. 

6. If you clicked Report Wizard, Chart Wizard, or Label Wizard in step 3, follow 
the directions in the wizard dialog boxes. If you click AutoReport: Tabular or 
AutoReport: Columnar, Microsoft Access automatically creates your report.  

If the resulting report doesn't look the way you want, you can change it in Design 
view.  



 

 
 

CCrreeaattee  aa  rreeppoorrtt  oonn  yyoouurr  oowwnn  
You can use the steps in this topic to guide you through creating a report from start to 
finish. You'll use many of the steps to create every report. The others you'll use when 
you create a particular kind of report — for example, one that requires grouping records 
by categories or calculating totals. You need to use only the steps that are relevant to 
the type of report that you're creating. For other tasks related to creating reports, ask the 
Answer Wizard. 
CCrreeaattee  aa  ffoorrmm  oorr  rreeppoorrtt  ffrroomm  ffiilltteerreedd  rreeccoorrddss  

1. With the filtered records displayed, click the arrow next to the New Object button 
on the toolbar.  

o To use the AutoForm or AutoReport Wizard, click AutoForm or 
AutoReport. 

o To specify the type of form or report you want to create, click Form or 
Report, and then make your selection.  

The new object uses as its record source the table or query in which the 
filter was created, and it inherits the filter.  

2. Complete the design or make any other changes you want to the form or report, 
and then save it.  

Notes  

• If a sort order was specified in the underlying table or query, the new form or 
report will use it. 

• If you subsequently change the filter in a table or query, it has no effect on a form 
or report that was based on a filter you created previously in that table or query.  

 
SSeeccttiioonnss  ooff  aa  rreeppoorrtt  

The information in a report can be divided into sections. Each section has a specific 
purpose and prints in a predictable order on the page and in the report. 

 
 
 
 
 
 
 
 
 
 
 



 

 
 

 
 

  
  
FFoorrmm  aanndd  rreeppoorrtt  tteemmppllaatteess  
When you create a form or report without using a wizard, Microsoft Access uses a 
template to define the default characteristics of the form or report. 
The template determines which sections a form or report will have and defines each 
section's dimensions. The template also contains all the default property settings for the 
form or report and its sections and controls. 
The default templates for forms and reports are called Normal. However, you can use 
any existing form or report as a template. You can also create a form or report to use 
only as a template. For information on specifying a new template, click  
Notes  

• Changing the template doesn't have any effect on existing forms or reports. 

• A template doesn't create controls on a new form or report. 

• Microsoft Access saves the settings for the Form Template and Report 
Template options in your Microsoft Access workgroup information file, not in your 
Microsoft Access database (the .mdb file) or Microsoft Access project (the .adp 
file). When you change an option setting, the change applies to any database or 
Access project you open or create. To see the name of the template that is 
currently used for new forms or reports, click Options on the Tools menu, and 
then click the Forms/Reports tab. 

• To use your templates in other databases or Access projects, copy or export the 
templates to them. If your templates are not in a database or Access project, 
Microsoft Access uses the Normal template for any new forms and reports you 
create. However, the names of your templates appear in the Form Template and 
Report Template options in every database or Access project in your database 
system, even if the templates are not in every database or Access project.  

 
SSeett  ppaaggee  sseettuupp  ooppttiioonnss  ffoorr  aa  ttaabbllee,,  qquueerryy,,  ffoorrmm,,  oorr  rreeppoorrtt  

1. Open the database object in one of the following views:  
o Open a table or query in Datasheet view or Print Preview. 

o Open a form or report in any view (or from the Database window).  



 

 
 

Note   Page setup options aren't available for macros or modules.  

2. On the File menu, click Page Setup. 

3. Click the following tabs for the options you want to set:  
o Margins. To set margins and whether to print data only (for forms and 

reports) or to print headings (for tables or queries). 

o Page. To set orientation, paper size, and printer. 

o Columns. To set number, size, and layout of columns (for forms and 
reports).  

4. Click OK.  

Microsoft Access stores the settings for page setup options with a form or report, 
so you set these options only once for each form or report. For tables, queries, 
and modules, you must set page setup options every time you print.  

PPrriinntt  aa  rreeppoorrtt  
Before you print a report for the first time, you might want to check the margins, page 
orientation, and other page setup options. Select the report in the Database window, or 
open the report in Design view, Print Preview, or Layout Preview. 

1. On the File menu, click Print. 

2. Enter the settings you want in the Print dialog box.  
o Under Printer, specify a printer. 

o Under Print Range, specify all pages or a range of pages. 

o Under Copies, specify the number of copies and whether they should be 
collated.  

3. Click OK.  

Tip   To print a report without bringing up the dialog box, click Print on the toolbar. 
 
FFoorrmmaatt  aa  ffoorrmm,,  rreeppoorrtt,,  oorr  ccoonnttrrooll  bbyy  uussiinngg  pprreeddeeffiinneedd  ffoorrmmaattss  

1. Open a form in Design view or a report in Design view. 

2. Do one of the following:  
o If you want to format the entire form or report, click the form selector or the 

report selector. 

o If you want to format an individual section, click the section selector. 

o If you want to format one or more controls, select the controls.  



 

 
 

3. Click AutoFormat on the toolbar. 

4. Click one of the formats in the list. 

5. If you want to specify which attributes to apply (font, color, or border), click 
Options.  

Note   You must select the entire form or report to apply a background picture. 
 
CCuussttoommiizzee  aann  aauuttooffoorrmmaatt  ffoorr  aa  ffoorrmm  oorr  rreeppoorrtt  

1. Open an existing form in Design view or report in Design view. 

2. On the Format menu, click AutoFormat. 

3. In the AutoFormat dialog box, click an autoformat in the list. 

4. Click the Options button, and then make sure the attributes you want to modify 
are selected. 

5. Click the Customize button, and then click a customization option. You can do 
one of the following:  

o Create a new autoformat based on the open form or report. 

o Update the selected autoformat based on the open form or report. 

o Delete the selected autoformat from the list.  
6. Click OK twice to close the dialog boxes.  

AAdddd  aa  bbaacckkggrroouunndd  ppiiccttuurree  ttoo  aa  rreeppoorrtt  
By adding a background picture to a report, you can simulate a watermark. A 
background picture in a report applies to the entire page.  

1. Open the report in Design view. 

2. Double-click the report selector to open the property sheet. 

3. Set the Picture property to a .bmp, .ico, .wmf, .dib, or .emf file. If you've installed 
graphics filters for other applications, you can use any file supported by those 

filters. If you're not sure of the path or file name, click the Build button . 

4. In the PictureType property box, specify whether you want the picture to be 
embedded or linked. When you embed a picture, it's stored in the database file. If 
you embed the same picture in another form or report, it's added to the database 
file again. When you link a picture, you don't store it in the database file, but you 
must keep a copy of it on your hard disk. If you want to use your hard disk space 
efficiently, specify the Linked setting. 



 

 
 

5. You can determine the proportions of the picture by setting the PictureSizeMode 
property. This property has three settings:  

o Clip. Displays the picture at actual size. If the picture is larger than the 
area within the margins, the image is cut off. 

o Stretch. Sizes the picture to fit the area within the margins. This setting 
may distort the image. 

o Zoom. Sizes the picture to fill either the height or width of the area within 
the margins. This setting won't clip the picture or distort its proportions.  

6. You can specify the position of the picture on the page by setting the 
PictureAlignment property. Microsoft Access aligns the picture within the 
margins of the report. The available settings are Top Left, Top Right, Center, 
Bottom Left, and Bottom Right. 

7. You can repeat the picture across the page by setting the PictureTiling property 
to Yes. Tiling starts at the position specified in the PictureAlignment property.  

Note   Background pictures look best tiled when the PictureSizeMode property 
is set to Clip.  

8. You can determine which pages of the report the picture will appear on by setting 
the PicturePages property. The available settings are All Pages, First Page, 
and No Pages.  

Notes  

• If the colors in the background picture don't look the same as the original colors, 
you can specify that Microsoft Access use the colors from the application you 
used to create the graphic. 

• If you're creating your own background pictures and you have access to a 
graphics program that creates metafiles, you may want to use a metafile as a 
background picture rather than a bitmap. For more information, click  

• The Employee Sales by Country report in the Northwind sample database has an 
example of a background picture. To view this report, open the Northwind 
database in your Office folder's Samples folder, and then open the Employee 
Sales by Country report in Design view. For information on opening Northwind, 
click  

AAdddd  aa  ppaaggee  bbrreeaakk  ttoo  aa  rreeppoorrtt  
In reports, you use a page break control to mark where you want to start a new page 
within a section. For example, if you want a report's title page and introductory message 
printed on separate pages, place a page break in the report header after the controls 
that you want to appear on the title page and before the controls for the second page.  



 

 
 

1. Open the report in Design view. 

2. Click the Page Break tool in the toolbox. 

3. Click the report where you want to place the page break. Place the page break 
above or below a control to avoid splitting data in that control.  

Microsoft Access marks the page break with a short dotted line on the left edge 
of the report.  

If you want each group or record in a report to start on a new page, set the 
ForceNewPage property of the group header, group footer, or detail section.  

Note   The Catalog report in the Northwind sample database has an example of using a 
page break in the report header. To view this report, open the Northwind database in 
your Office folder's Samples folder, and then open the Catalog report in Design view.  
 
AAdddd  ppaaggee  nnuummbbeerrss  ttoo  aa  ffoorrmm  oorr  rreeppoorrtt  

1. Open the form in Design view or the report in Design view. 

2. Click Page Numbers on the Insert menu. 

3. In the Page Numbers dialog box, select the format, position, and alignment for 
the page number. For alignment, the following options are available:  

o Left. Adds a text box at the left margin. 

o Center. Adds a text box centered between the left and right margins. 

o Right. Adds a text box at the right margin. 

o Inside. Adds text boxes at the left and right margins. Odd page numbers 
print on the left, and even page numbers print on the right. 

o Outside. Adds text boxes at the left and right margins. Even page 
numbers print on the left and odd page numbers print on the right.  

4. To show a number on the first page, select the Show Number On First Page 
check box.  

Microsoft Access uses an expression to create the page numbers. For examples of 

other page number expressions, click . 
 
AAdddd  tthhee  ccuurrrreenntt  ddaattee  aanndd  ttiimmee  ttoo  aa  ffoorrmm  oorr  rreeppoorrtt  

1. Open the form in Design view or the report in Design view. 



 

 
 

2. Click Date And Time on the Insert menu. 

3. To include a date, select the Include Date check box, and then click a date 
format. 

4. To include the time, select the Include Time check box, and then click a time 
format.  

Microsoft Access adds a text box to the form or report and sets its ControlSource 
property to an expression. If there is a form or report header, Microsoft Access adds the 
text box to that section. Otherwise, it adds the text box to the detail section. 
 
EExxaammpplleess  ooff  eexxpprreessssiioonnss  ffoorr  ppaaggee  nnuummbbeerrss  
The following table lists examples of page number expressions you can use in form or 
report Design view and the results that you see in other views. 

Expression Result 

=[Page] 1, 2, 3 

="Page " & [Page] Page 1, Page 2, Page 3 

="Page " & [Page] & " of " & [Pages] Page 1 of 3, Page 2 of 3, Page 3 of 
3 

=[Page] & " of " & [Pages] & " Pages" 1 of 3 Pages, 2 of 3 Pages, 3 of 3 
Pages 

=[Page] & "/"& [Pages] & " Pages" 1/3 Pages, 2/3 Pages, 3/3 Pages 

=[Country] & " - " & [Page] UK - 1, UK - 2, UK - 3 

=Format([Page], "000") 001, 002, 003 

 
 
AAdddd  oorr  rreemmoovvee  aa  rreeppoorrtt  hheeaaddeerr  aanndd  ffooootteerr  oorr  aa  ppaaggee  hheeaaddeerr  aanndd  ffooootteerr  

1. Open the report in Design view.  

2. Click Report Header/Footer or Page Header/Footer on the View menu.  

Notes  

• You can add a header and footer only as a pair. If you don't want both a header 
and a footer, set the Visible property to No for the section you don't want. Or 
remove all controls from the section, and then size the section to zero height or 
set its Height property to 0.  



 

 
 

• If you remove a header and footer, Microsoft Access also removes the controls in 
the header and footer. 

• See an example of using different types of sections in reports.  

 
OOmmiitt  tthhee  ppaaggee  hheeaaddeerr  oorr  ffooootteerr  oonn  ppaaggeess  wwiitthh  tthhee  rreeppoorrtt  hheeaaddeerr  oorr  
ffooootteerr  

1. Open the report in Design view. 

2. Double-click the report selector to open the property sheet. 

3. Set the PageHeader or PageFooter property to one of the following settings:  
o All Pages. (Default) Prints the page header or footer on all pages. 

o Not With Rpt Hdr. Doesn't print the page header or footer on the page 
that has the report header. 

o Not With Rpt Ftr. Doesn't print the page header or footer on the page that 
has the report footer. 

o Not With Rpt Hdr/Ftr. Doesn't print the page header or footer on a page 
that has either a report header or footer.  

Note   When you set the PageHeader property to Not With Rpt Ftr or Not With Rpt 
Hdr/Ftr, Microsoft Access prints the report footer on a new page. 
 
CCrreeaattee  mmaaiilliinngg  aanndd  ootthheerr  ttyyppeess  ooff  llaabbeellss  

1. In the Database window, click Reports . 

2. Click the New button on the Database window toolbar. 

3. In the New Report dialog box, click Label Wizard. 

4. Click the table or query that contains the data for the labels, and then click OK.  

5. Follow the directions in the wizard dialog boxes.  

If the resulting label report doesn't look the way you want, you can delete the 
report and run the Label Wizard again.  

Notes  



 

 
 

• The Customer Labels report in the Northwind sample database shows three-
across mailing labels. To view this report, open the Northwind database in the 
Samples subfolder of your Office folder, and then open the Customer Labels 

report in Design view. For information on opening Northwind, click .  

 
CCrreeaattee  mmaaiilliinngg  aanndd  ootthheerr  ttyyppeess  ooff  llaabbeellss  ffoorr  aa  ddoott--mmaattrriixx  pprriinntteerr  
Creating labels that print on a dot-matrix or tractor-feed printer usually requires some 
adjustment to the user-defined page size. Before you create a label report for this type 
of printer, you must first set the default printer and paper size in Microsoft Windows 
Control Panel. 
SSeett  tthhee  ddeeffaauulltt  pprriinntteerr  aanndd  ppaappeerr  ssiizzee  

1. Click the Windows Start button, point to Settings, and then click Control Panel. 

2. Double-click Printers, click the icon for the dot-matrix printer, and then click Set 
As Default on the File menu. 

3. On the File menu, click Properties, and then click the Paper tab. 

4. Under Paper Size, click the Custom icon. 

5. In the User Defined Size dialog box, select the unit of measurement, and then 
type the width and the length of a label.  

To determine the width, measure from the left edge of the leftmost label to the 
right edge of the rightmost label. To determine the length, measure from the top 
of the first label to the top of the second. For example, if you use two-across 
labels that measure 3-by-5 inches, with 0.25 inch between them, set Unit to 0.01 
inch, and set Width to 625 and Length to 525.  

6. Click OK to save the settings in the User Defined Size dialog box. 

7. Click OK to save the settings in the printer's Properties dialog box.  

Once you set the printer and paper size, you can create a label report for a dot-matrix 
printer with the Label Wizard or without a wizard in report Design view. For information 
on using the Label Wizard, click  
 
CCrreeaattee  aa  llaabbeell  rreeppoorrtt  wwiitthhoouutt  aa  wwiizzaarrdd  

1. Create a blank report bound to the table or query that contains the data you want 
to use.  

2. In report Design view, click Page Header/Footer on the View menu to remove 
the page header and footer. (You need only the detail section for this report.) 



 

 
 

3. Adjust the height and width of the detail section to match the height and width of 
one label.  

4. Add text boxes to the detail section, making sure that they don't overlap. (To 
create margins for the labels, place the text boxes at least 0.2 inch from all edges 
of the detail section.)  

5. On the File menu, click Page Setup. 

6. Set the following values in the Page Setup dialog box:  
o On the Page tab, if the dot-matrix printer isn't the default printer, click Use 

Specific Printer. Then click the Printer button, and click the dot-matrix 
printer in the list. 

o On the Page tab, under Paper, set Size to User-Defined Size, and set 
Source to Tractor. 

o On the Margins tab, set all the margins to 0.0 inches. 

o On the Columns tab, under Column Size, select the Same As Detail 
check box.  

If there is more than one label across the page, you must also set the 
following items under Grid Setting on the Columns tab:  

o In the Number Of Columns box, type the number of labels across. 

o In the Row Spacing box, type the amount of space between the bottom of 
one label and the top of the next. 

o In the Column Spacing box, type the amount of space between the right 
edge of one label and the left edge of the next.  

Note   When a dot-matrix printer is the default in Microsoft Windows Control Panel and 
you have Paper Size set to User-Defined Size, Microsoft Access uses that paper size. 
If you want to create or print a label or report on a page of a different size, change the 
user-defined page size in Microsoft Windows Control Panel before you create or print it. 
 
SSoorrtt  rreeccoorrddss  iinn  aa  rreeppoorrtt  
You can sort on up to 10 fields or expressions in a report.  

1. Open the report in Design view. 

2. Click Sorting And Grouping on the toolbar to display the Sorting And 
Grouping box. 

3. In the first row of the Field/Expression column, select a field name, or type an 
expression.  



 

 
 

The field or expression in the first row is the first sorting level (the largest set). 
The second row is the second sorting level, and so on.  

When you fill in the Field/Expression column, Microsoft Access sets the Sort 
Order to Ascending. Ascending order sorts from A to Z or 0 to 9.  

4. To change the sort order, select Descending from the Sort Order list. 
Descending order sorts from Z to A or 9 to 0.  

Note   The Customer Labels report in the Northwind sample database sorts records by 
the values in three fields. To view this report, open the Northwind database in the 
Samples subfolder of your Office folder, and then open the Customer Labels report in 
Design view.  
 
GGrroouupp  rreeccoorrddss  iinn  aa  rreeppoorrtt  
You can group on up to 10 fields or expressions in a report. To see an example of 
grouped records, click  

1. Open the report in Design view. 

2. Click Sorting And Grouping on the toolbar to display the Sorting And 
Grouping box. 

3. Set the sort order for the data in the report.  
4. Click the field or expression whose group properties you want to set. 

5. Set the group properties in the following list. You must set either GroupHeader 
or GroupFooter to Yes in order to create a group level and set the other 
grouping properties.  

o GroupHeader. Adds or removes a group header for the field or 
expression. 

o GroupFooter. Adds or removes a group footer for the field or expression. 

o GroupOn. Specifies how you want the values grouped. The options you 
see depend on the data type of the field on which you're grouping. If you 
group on an expression, you see all the options for all data types. 

o GroupInterval. Specifies any interval that is valid for the values in the field 
or expression you're grouping on. 

o KeepTogether. Specifies whether Microsoft Access prints all or only part 
of a group on the same page.  

Note   The Employee Sales by Country report in the Northwind sample database has 
two group levels. To view this report, open the Northwind database in the Samples 



 

 
 

subfolder of your Office folder, and then open the Employee Sales by Country report in 
Design view. 
 
KKeeeepp  tthhee  ddaattaa  iinn  aa  ggrroouupp  ttooggeetthheerr  oonn  aa  ppaaggee  oorr  iinn  aa  ccoolluummnn  iinn  aa  rreeppoorrtt  

1. Open the report in Design view. 

2. Click Sorting And Grouping on the toolbar to display the Sorting And 
Grouping box. 

3. Set the group levels for the report.  
4. Click the field or expression for the group level that you want to keep together. 

5. In the group properties section of the Sorting And Grouping box, set the 
KeepTogether property to one of the following settings:  

o Whole Group. The group header, all detail records, and the group footer 
are printed on the same page or in the same column. 

o With First Detail. The group header is printed on a page or in a column 
only if it can also print the first detail record.  

6. Display the property sheet for the report.  
7. Set the GrpKeepTogether property to one of the following settings:  

o Per Page. Keeps the group together on the page. 

o Per Column/Row. Keeps the group together in the column or row.  

Notes  

• If you want to keep the data in one section together, for example, a record in the 
detail section, set the KeepTogether property for that section to Yes.  

• The Alphabetical List of Products report in the Northwind sample database keeps 
the products for each letter together as a group. To view this report, open the 
Northwind database in the Samples subfolder of your Office folder, and then 
open the Alphabetical List of Products report in Design view.  

SSttaarrtt  eeaacchh  ggrroouupp  iinn  aa  rreeppoorrtt  iinn  aa  nneeww  rrooww  oorr  ccoolluummnn  

1. Create a multiple-column report that has at least one group level.  
2. In report Design view, click Page Setup on the File menu. 

3. Click the Columns tab. Under Grid Settings, make sure Number of Columns is 
set to a value greater than 1. 

4. Under Column Layout, do one of the following:  
o To start each group in a new column, click the Down, Then Across option. 

o To start each group in a new row, click the Across, Then Down option.  



 

 
 

5. Click OK. 

6. Double-click the section selector for the group header or footer to display its 
property sheet. 

7. Set the NewRowOrCol property to one of the following settings.  

Setting Description 

None (Default) The row or column breaks are determined by 
the setting in the Page Setup dialog box and by the 
available space on the page. 

Before Section Microsoft Access starts printing the current section (the 
section for which you're setting the property, such as the 
group header) in a new row or column. It starts printing 
the next section, for example, the detail section, in the 
same row or column. 

After Section Microsoft Access starts printing the current section, such 
as the group header, in the current row or column. It 
starts printing the next section, such as a detail section, 
in the next row or column. 

Before & After Microsoft Access starts printing the current section, such 
as the group header, in a new row or column. It starts 
printing the next section, such as the detail section, in the 
next row or column. 

Notes    

• To see an example of a report that starts each group in a new column and an 

example that starts each group in a new row, click . 

• The Products by Category report in the Northwind sample database starts each 
group in a new column. To view this report, open the Northwind database in the 
Samples subfolder of your Office folder, and then open the Products by Category 
report in Design view.  

RReesseett  ppaaggee  nnuummbbeerrss  ffoorr  eeaacchh  ggrroouupp  iinn  aa  rreeppoorrtt  
CCrreeaattee  aa  mmaaccrroo  tthhaatt  rreesseettss  ppaaggee  nnuummbbeerrss  

1. Create a macro that uses the SetValue action to change the Page property to 1.  

Decide if the page number will appear in the page header or footer, and then use 
the following values for the SetValue action arguments.  



 

 
 

Location of page number SetValue arguments 

Page header Item: [Page]  

Expression: 0 

Page footer Item: [Page]  

Expression: 1 

2. Save and close the macro.  

MMooddiiffyy  tthhee  rreeppoorrtt  

1. Open the report in Design view. 

2. Create a text box for the page number in the page header or footer if you haven't 
already done so.  

3. For the first-level group header and footer, set the following properties, 
depending on where the page number appears.  

If the page number appears in the page header, set the following properties.  

Section Property Setting Purpose 

Group 
header 

ForceNewPage Before Section Starts each group on 
a new page. 

Group 
footer 

OnFormat Name of macro you 
created in the first 
procedure 

Resets the page 
number to 1 for the 
new group. 

 

If the page number appears in the page footer, set the following properties.  

Section Property Setting Purpose 

Group 
header 

OnFormat Name of macro you 
created in the first 
procedure 

Resets the page 
number to 1 for the 
new group. 

Group 
footer 

ForceNewPage After Section Starts each group on 
a new page. 



 

 
 

Note   The Employee Sales by Country report in the Northwind sample database uses 
an event procedure in the OnFormat property to reset the page number for each 
country. To view this report, open the Northwind database in the Samples subfolder of 
your Office folder, and then open the Employee Sales by Country report in Design view.  
 
 
CCaallccuullaattee  aa  ttoottaall  ffoorr  oonnee  rreeccoorrdd  iinn  aa  rreeppoorrtt  

1. Open the report in Design view. 

2. Add a calculated text box to the detail section.  
3. To display the property sheet, make sure the text box is selected, and then click 

Properties on the toolbar. 

4. In the ControlSource property box, type an appropriate expression.  

Tip   In a Microsoft Access database (.mdb), you can click the Build button 
to use the Expression Builder to create the expression.  

Notes    

• If a report is based on a query, you can put the expression in the report's 
underlying query. It may improve the report's performance, and if you are going 
to calculate totals for groups of records, it's easier to use the name of a 
calculated field in an aggregate function.  

 
CCaallccuullaattee  aa  rruunnnniinngg  ssuumm  iinn  aa  rreeppoorrtt  

1. Open the report in Design view. 

2. Add a text box to one or more of the following sections.  
o To calculate a running sum that increases for each record, add a bound 

text box or a calculated text box to the detail section. 

o To calculate a running sum that increases for each group of records, add 
a bound text box or a calculated text box to the group header or footer.  

3. To display the property sheet, make sure the text box is selected, and then click 
Properties on the toolbar. 

4. Set the RunningSum property according to the type of running total you want:  
o Over Group. Resets to 0 at the beginning of each higher group level. 

o Over All. Accumulates until the end of the report.  

Notes    

 



 

 
 

• When you set the RunningSum property to Over All, you can repeat the grand 
total in the report footer. Create a text box in the report footer and set its 
ControlSource property to the name of the text box that calculates the running 
sum; for example, =[OrderAmount].  

 
CCaallccuullaattee  ppeerrcceennttaaggeess  iinn  aa  rreeppoorrtt  

1. Open the report in Design view. 

2. Add the text boxes that calculate the record total, the group total, and the grand 
total.  

3. To the appropriate section, add the text box that calculates the percentage.  

To calculate what percentage of a group total or the grand total each item is, 
place the control in the detail section.  

To calculate what percentage of the grand total a group of items is, place the text 
box in the group header or footer.  

If your report includes multiple group levels, place the text box in the header or 
footer of the level for which you want Microsoft Access to calculate a percentage.  

4. To display the property sheet, make sure the text box is selected, and then click 
Properties on the toolbar. 

5. In the ControlSource property box, type an expression that divides the smaller 
total by the larger total of which the smaller total is a part. For example, divide the 
value of the DailyTotal control by the value of the GrandTotal control.  

Tip   In a Microsoft Access database (.mdb), you can click the Build button 
to use the Expression Builder to create the expression.  

6. Set the Format property of the text box to Percent.  

 

Notes    

• The Employee Sales by Country report in the Northwind sample database has an 
example of percentages. To view this report, open the Northwind database in the 
Samples subfolder of the Office folder, and then open the Employee Sales by 
Country report in Design view.  

 

 



 

 
 

AAbboouutt  ccoommppuuttiinngg  aa  ttoottaall  ffoorr  aa  ccaallccuullaatteedd  ccoonnttrrooll  oonn  aa  ffoorrmm  oorr  rreeppoorrtt  
When computing a total with an aggregate function such as Sum or a domain 
aggregate function such as DSum, you can't use the name of a calculated control in the 
Sum function. You must repeat the expression in the calculated control. For example: 
=Sum([Quantity]*[UnitPrice]) 
However, if you have a calculated field in an underlying query, for example, 
=ExtendedPrice: [Quantity]*[UnitPrice] 
you can use the name of that field in the Sum function, as shown here: 
=Sum([ExtendedPrice]) 
 
 
CCoommbbiinnee  tteexxtt  vvaalluueess  ffrroomm  mmuullttiippllee  ffiieellddss  oonn  aa  ffoorrmm,,  rreeppoorrtt,,  oorr  ddaattaa  
aacccceessss  ppaaggee  

1. Open the form in Design view, the report in Design view, or the data access page 
in Design view. 

2. Add a calculated text box for the fields that you want to combine.  

Tip   On a data access page, you can use a bound HTML control instead.  

3. To display the property sheet, make sure the text box is selected, and then click 
Properties on the toolbar. 

4. In the ControlSource property box, type an expression that concatenates the 
values from the appropriate fields.  

For example, to return an address like  

507 20th Ave. E., Seattle WA 98122  

type this expression:  

=[Address] & ", " & [City] & " " & [Region] & " " & [PostalCode]  

Tip   In a form or report in a Microsoft Access database (.mdb), you can also 
click the Build button to use the Expression Builder to create the expression.  

• The Employee Sales by Country and Customer Labels reports in the Northwind 
sample database have examples of combining text values. To view one of these 
reports, open the Northwind database in the Samples subfolder of the Office 
folder, and then open that desired report in Design view.  

 



 

 
 

AAbboouutt  ccoommbbiinniinngg  tteexxtt  vvaalluueess  ffrroomm  ffiieellddss  wwhheenn  ssoommee  ffiieellddss  ccoonnttaaiinn  nnoo  
ddaattaa  
When you combine text values from several fields, some records might contain empty 
fields, resulting in output that might not be what you want. For example, the output 
might include extra spaces. 
 
To compensate for records that don't have values in certain fields, you can use the IIf 
function. You use the IIf function when you want the value (or absence of a value) in 
one field to determine which one of two possible results you want returned. 
For example, if you know that not every record will have a value in the Region field, use 
the following expression: 
 
=[Address] & ", " & [City] & IIf(IsNull([Region]),"", " " & [Region]) & " " & [PostalCode] 
If the Region field is empty, Microsoft Access returns an empty string, as specified by 
the argument "". If the Region field contains a value, Microsoft Access returns a space 
and the region, as specified by the argument " " & [Region]. 
Notes    

• The Invoice report in the Northwind sample database has an example of 
combining values from text fields by using the IIf function. To view this report, 
open the Northwind database in the Samples subfolder of your Office folder, and 
then open the Invoice report in Design view.  

 
 
PPrriinntt  tthhee  ffiirrsstt  ffeeww  cchhaarraacctteerrss  ooff  aa  vvaalluuee  aass  aa  ggrroouupp  hheeaaddeerr  iinn  aa  rreeppoorrtt  
oorr  ddaattaa  aacccceessss  ppaaggee  

1. Open the report in Design view, or the data access page in Design view. 

2. Click Sorting And Grouping on the toolbar, and make sure that the 
properties in the Sorting And Grouping box are set as follows:  

Property Setting Applies to 

Field/Expression (Select a field or type 
an expression) 

Reports 

GroupRecordSource (Set when you click 
Promote or Group 
By Table on the 
toolbar) 

Data access pages 

GroupHeader Yes Reports, pages 



 

 
 

GroupFooter Yes or No Reports, pages 

GroupOn Prefix Characters Reports, pages 

GroupInterval (Type the number of 
characters) 

Reports, pages 

KeepTogether (Select an option) Reports 

DefaultSort (Type the name(s) of 
the field(s) you want 
to sort on.)  

Data access pages 

3. Add a calculated text box to the group header.  

Note   On a data access page, you can use a bound HTML control instead of a 
text box.  

4. To display the property sheet, make sure that the text box or bound HTML 
control is selected, and then click Properties on the toolbar. 

5. In the ControlSource property box, type the expression (by using the Left or 
Right function) that will extract the appropriate characters.  

For example, if you're tracking office equipment and furniture, and the asset 
number includes an alphabetic code for distinguishing one type of asset from 
another (for example, FR100 for furniture), you could use an expression similar 
to the ones in the following table.  

This expression Returns 

=Left([AssetCode], 2) FR 

=Right([AssetCode], 3) 100 

Build button to use the Expression Builder to create the expression.  

Notes    

• The Alphabetical List of Products report in the Northwind sample database has 
an example of printing the first letter of each group of products in the group 
header. To view this report, open the Northwind database in the Samples 
subfolder of your Office folder, and then open the Alphabetical List of Products 
report in Design view.  



 

 
 

CChhaapptteerr  ::  66  DDaattaa  AAcccceessss  PPaaggeess  
DDaattaa  aacccceessss  ppaaggeess::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
A data access page is a special type of Web page designed for viewing and working 
with data from an Internet or intranet — data that is stored in a Microsoft Access 
database or a Microsoft SQL Server database. The data access page may also include 
data from other sources, such as Microsoft Excel.  
 
This topic provides reference information about: 
Designing different types of data access pages 
Using data access pages in Internet Explorer 
Using data access pages in Microsoft Access 
DDeessiiggnniinngg  ddiiffffeerreenntt  ttyyppeess  ooff  ddaattaa  aacccceessss  ppaaggeess  
You design data access pages in page Design view in Microsoft Access. The page is a 
separate file that is stored outside Microsoft Access; however, when you create the file, 
Microsoft Access automatically adds a shortcut to the file in the Database window. 
Designing a data access page is similar to designing forms and reports — you use a 
field list, the toolbox, controls, the Sorting and Grouping dialog box, and so on. 
However, there are some significant differences in the way that you design and interact 
with data access pages as opposed to forms and reports. How you design the page 
depends on what it will be used for:  

• Interactive reporting   This type of data access page is often used to 
consolidate and group information that is stored in the database, and then 
publish summaries of the data. For example, a page might publish the sales 
performance for each region in which you do business. Using expand indicators, 
you can go from a general summary of the information, such as a list of all the 
regions and their combined sales total, to specific details on individual sales 
within each region. While the data access page may also provide toolbar buttons 
for sorting and filtering the data, you can't edit data on this type of page. See an 
example and learn more about data access pages that group records for 
interactive reporting.  

• Data entry   This type of data access page is used to view, add, and edit 
records. Learn more about data access pages used for data entry. 

• Data analysis   This type of data access page may include a PivotTable list, 
similar to a Microsoft Access PivotTable form or Microsoft Excel PivotTable 
report, that lets you reorganize the data to analyze it in different ways. The page 
might contain a chart that you can use to analyze trends, detect patterns, and 
compare data in your database. Or the page might contain a spreadsheet in 
which you can enter and edit data, and use formulas to calculate as you do in 
Microsoft Excel. See an example of a data access page used for data analysis.  



 

 
 

UUssiinngg  ddaattaa  aacccceessss  ppaaggeess  iinn  IInntteerrnneett  EExxpplloorreerr  
A data access page is connected directly to a database. When users display the data 
access page in Microsoft Internet Explorer, they are viewing their own copy of the page. 
That means any filtering, sorting, and other changes they make to the way the data is 
displayed  — including changes they make within a PivotTable list or spreadsheet  — 
affect only their copy of the data access page. However, changes that they make to the 
data itself  — such as modifying values, and adding or deleting data — are stored in the 
underlying database, and therefore are available to everyone viewing the data access 
page. 
 
Users get Help on how to work with the page in Internet Explorer by clicking the Help 
button on the record navigation toolbar. The Help file that displays is automatically 
included with any data access page that's published with a record navigation toolbar. If 
you delete the record navigation toolbar or if you disable the Help button on it, you 
should provide instructions for those who will use the page. 
 
Note   To view and work with the data access page on the Internet or an intranet, users 
need Microsoft Internet Explorer 5 and a Microsoft Office 2000 license.  
  
UUssiinngg  ddaattaa  aacccceessss  ppaaggeess  iinn  MMiiccrroossoofftt  AAcccceessss  
You can also work with a data access page in Page view in Microsoft Access. Data 
access pages can supplement the forms and reports that you use in your database 
application. When deciding whether to design a data access page, form, or report, 
consider the tasks that you want to perform. 
 
You get Help on how to work with the page in Page view by clicking the Help button on 
the Page View toolbar to display Access Help. Clicking the Help button on a record 
navigation toolbar on the page displays Help for working with the page in Internet 
Explorer. As mentioned previously, this Help file is automatically included with any data 
access page that's published with a record navigation toolbar. You can delete the Help 
button on pages that are used only within Access, or you can modify the button to 
provide custom Help. 
 
CCrreeaattee  aa  ddaattaa  aacccceessss  ppaaggee  bbyy  uussiinngg  AAuuttooPPaaggee  
AutoPage creates a data access page that contains all fields (except fields that store 
pictures) and records in the underlying table, query, or view.  

1. In the Database window, click Pages under Objects. 

2. Click the New button on the Database window toolbar. 

3. In the New Data Access Page dialog box, click AutoPage: Columnar. In the 
finished data access page, each field will appear on a separate line with a label 
to its left. 



 

 
 

4. Click the table, query, or view that contains the data you want to base your page 
on. 

5. Click OK.  

If the resulting page doesn't look the way you want, you can modify the page in 
Design view.  

Notes    

• Microsoft Access applies the default theme to the page. If you haven't set a 
default theme, then Access uses the Straight Edge theme. 

• When you create a page by using AutoPage, Microsoft Access automatically 
saves the page as an HTML file in the current folder, and adds a shortcut to the 
page in the Database window. Rest the pointer over the shortcut in the Database 
window to display the path to the file.  

CCrreeaattee  aa  ddaattaa  aacccceessss  ppaaggee  bbyy  uussiinngg  aa  wwiizzaarrdd  

1. In the Database window, click Pages under Objects. 

2. Click the New button on the Database window toolbar. 

3. In the New Data Access Page dialog box, click Page Wizard. 

4. Click the name of the table, query, or view that includes the data that you want to 
base your data access page on.  

Note   You don't need to do this step now — you can specify the record sources 
for the page in the wizard.  

5. Click OK. 

6. Follow the directions in the wizard dialog boxes.  

If the resulting page doesn't look the way you want, you can modify the page in 
Design view.  

Note When you create a page by using a wizard, Microsoft Access automatically saves 
the page as an HTML file in the current folder and adds a shortcut to the page in the 
Database window. Place the mouse pointer over the shortcut in the Database window to 
display the path to the file. 
 
MMaakkee  aann  eexxiissttiinngg  WWeebb  ppaaggee  iinnttoo  aa  ddaattaa  aacccceessss  ppaaggee  

1. In the Database window, click Pages under Objects. 



 

 
 

2. Click the New button on the Database window toolbar. 

3. In the New Data Access Page dialog box, click Existing Web page. 

4. Click OK. 

5. In the Locate Web Page dialog box, find the Web page or HTML file that you 
want to open. 

6. Click Open.  

Microsoft Access displays the page in Design view, where you can modify the page.  
Notes    

• When you save a Web page in Microsoft Access, Access creates a shortcut to 
the HTML file in the Database window. 

• You can find a Web page by using the Search the Web button in the Locate 
Web Page dialog box. Save a copy of the page by using the Save As command 
on the File menu in Internet Explorer and then begin this procedure again to 
open the page in Design view.  

SShhoouulldd  II  uussee  aa  ffoorrmm,,  rreeppoorrtt,,  rreeppoorrtt  ssnnaappsshhoott,,  oorr  ddaattaa  aacccceessss  ppaaggee??  
Each Microsoft Access database object is designed for a particular purpose. In the 
following table, Yes identifies the objects that are best at performing a particular task, 
Possible identifies objects that can perform the task, though less optimally, and No 
identifies objects that don't perform the task at all. 
 

Task/Purpose Form Report Report 
snapshot 

Data access 
page 

Enter, edit, and interact with data 
within a Microsoft Access 
database or Microsoft Access 
project 

Yes  No No Yes 

Enter, edit, and interact with live 
data via the Internet or an intranet 
outside an Access database or 
Access project; users must have 
a Microsoft Office 2000 license 
but don't have to have Office 
installed 

No No No Yes 

Print data for distribution Possible Yes Yes Possible 

Distribute data by e-mail No No Yes (static Yes (live data) 



 

 
 

data) 

 
SSttrraatteeggiieess  ffoorr  ccrreeaattiinngg  ddaattaa  aacccceessss  ppaaggeess  
What do you want to accomplish with your data access page? There are many features 
that you can use to create effective data access pages. This topic helps you identify the 
right features and layout to use for each type of page. There are four types of data 
access pages, which you can use to: 
Analyze data 
Enter and edit data 
Make projections 
Review data 
AAnnaallyyzzee  ddaattaa  
You can use a PivotTable list to analyze data because it allows you to reorganize the 
data in different ways. You can bind a PivotTable list to data in the database or use data 
from a Microsoft Excel worksheet. You can use the PivotTable list as the only control on 
a data access page or use it with other controls.  

• When using a PivotTable list on an ungrouped page, place the PivotTable list 
control and other controls either in the body or in the section. 

• When using a PivotTable list on a grouped data access page:  
o Place the PivotTable list and bound controls in the section. 

o Make sure the PivotTable list is in the lowest group level.  

o If the PivotTable list is the only control in a section, delete or hide the 
navigation section for the group level that the PivotTable list is in. 

o Make sure the DataPageSize property in the Sorting And Grouping box 
is set to 1.  

EEnntteerr  aanndd  eeddiitt  ddaattaa  
You can create a data access page on which users can enter, edit, and delete data in 
the database. Key points to keep in mind when creating a page for data entry:  

• Use individual controls, such as text boxes, list boxes, drop-down list boxes, 
option groups, option buttons, and check boxes.  

• Place controls either in the body or in the section. You can delete the section if 
you don't use it.  

• Create only one group level. The Sorting And Grouping box will list only one 
group record source. 

• Make sure the DataPageSize property in the Sorting And Grouping box is set 
to 1. 



 

 
 

• Use the Spreadsheet Component to create a spreadsheet to perform one or 
more calculations on the fields in a record. You can display the calculated values 
in the spreadsheet or hide the spreadsheet and display the calculated values in 
bound HTML controls. 

• Determine how users can use the data access page by customizing the record 
navigation bar.  

• If you want to edit data from tables that have a one-to-many relationship, create 
one page that is bound to the table on the "one" side of the relationship and 
another data access page that is bound to the "many" side. Then, you can use 
the Insert Hyperlink dialog box to create a link between the two data access 
pages. To display the data from both pages on one page, you can use an HTML 
editor (for example, Microsoft FrontPage) to create frames.  

MMaakkee  pprroojjeeccttiioonnss  
You can use the Chart Component to create a chart to analyze trends, show patterns, 
and make comparisons on the data in your database, or use a spreadsheet control, in 
which you can enter and edit data and use formulas to perform some of the same 
calculations you can do in Excel.  

• When using a spreadsheet control on an ungrouped data access page, place the 
spreadsheet control and other controls either in the body or in the section.  

• When using a spreadsheet control on a grouped data access page, place the 
spreadsheet control and other controls bound to fields in the database in the 
section. You can use a spreadsheet control in any group level. 

• Make sure the DataPageSize property in the Sorting And Grouping box is set 
to 1 for the section that contains the spreadsheet control.  

RReevviieeww  ddaattaa  
Data access pages give you a way to interact with large amounts of data in a selective 
way. By expanding and collapsing groups of records, users can focus only on the data 
that they want to see. Keep the following points in mind when you create a grouped 
page:  

• Place bound controls in the section. 

• In the lowest group level, use individual controls or a PivotTable list to display 
detail records. 

• Remove unneeded buttons from the record navigation bar. 

• To make loading the data access page in Microsoft Internet Explorer faster:  
o Use bound HTML controls instead of text boxes. 



 

 
 

o Set the ExpandedByDefault property to No for all group levels. 

o Set the DataPageSize property in the Sorting And Grouping box, which 
determines the number of records displayed in a group on a page, to a low 
rather than a high number or to All. The lower the number, the faster the 
records are displayed.  

AAbboouutt  ddaattaa  aacccceessss  ppaaggeess  tthhaatt  aarree  uusseedd  ffoorr  ddaattaa  eennttrryy  
 
This topic provides reference information about: 
Using a data access page for data entry 
A data entry page in Design view 
A data entry page in Page view or Internet Explorer 
UUssiinngg  aa  ddaattaa  aacccceessss  ppaaggee  ffoorr  ddaattaa  eennttrryy  
Using a data access page for data entry is similar to using a data entry form: You can 
enter, edit, and delete data in a database. However, you can use a page outside a 
Microsoft Access database, so users who have a Microsoft Office 2000 license can 
update data over the Internet or an intranet. 
The following illustration shows how the Product data access page, which is used for 
entering and updating product information, looks in Page view or in Microsoft Internet 
Explorer 5 or later. 
  
AA  ddaattaa  eennttrryy  ppaaggee  iinn  DDeessiiggnn  vviieeww  
The body   The body is the basic design surface of a data access page. On a data 
entry page, you can use it to display informational text, controls bound to data, and 
sections. By default, the position of text, sections, and other elements in the body are 
relative. That is, elements flow one after the other in the same order as they appear in 
the HTML source. The position of an element in the body is determined by the 
preceding content. When viewed in Page view or Internet Explorer, the content in the 
body adjusts itself to fit the size of the Web browser. 
 
Sections   You use sections to display text, data from a database, and toolbars. The 
position of controls and other elements within a section is absolute by default. That is, 
the position of each control or element is fixed relative to the top and left coordinates of 
the section. Controls that have an absolute position within a section keep the same 
position even when you resize the browser. 
 
There are two types of sections that are typically used on data entry pages: group 
header and record navigation sections. On a data entry page, you can use just one 
group level; so the group footer section isn't available, but you can use a caption 
section.  

• Group header   Used to display data and calculate values.  



 

 
 

• Record navigation   Used to display the record navigation control for the group 
level. A record navigation section for a group appears after the group header 
section. You can't place bound controls in a record navigation section. 

• Caption   Used to display captions for text boxes and other controls. It appears 
immediately before the group header. You can't place bound controls in a caption 
section.  

Each group level in a data access page has a record source. The name of the record 
source is displayed on the section bar for each section used for a group level. The 
following illustration shows the Products data access page in Design view.  
 
A data entry page in Page view or Internet Explorer 
The following illustration shows how the sections look on the Products data access 
page when it's open in Page view or in Internet Explorer. You can enter and edit data on 
pages where there is only one group level and where only one record is displayed on 
the data access page. To display one record, you set the group level's DataPageSize 
property in the Sorting And Grouping box to 1 in page Design view.  
 
AAbboouutt  ggrroouuppiinngg  rreeccoorrddss  oonn  aa  ddaattaa  aacccceessss  ppaaggee  
This topic provides reference information about: 
Benefits of grouped data access pages 
A grouped data access page in Design view 
A grouped data access page in Page view or Internet Explorer 
BBeenneeffiittss  ooff  ggrroouuppeedd  ddaattaa  aacccceessss  ppaaggeess  
Grouping records on a data access page is similar to grouping records on a report: You 
can create a hierarchy that groups records from general categories to specific details. 
However, data access pages have some advantages over printed reports.  

• Pages bound to database data display current data because they are connected 
to a database. 

• Pages are interactive. Users can filter, sort, and view just the records that they 
want. 

• Pages can be distributed electronically by using e-mail. Recipients will see 
current data each time they open the message.  

The following illustration shows how the sample data access page, Orders by Date, 
which shows order totals grouped by date, looks in Page view or Microsoft Internet 
Explorer 5 or later. 
 
AA  ggrroouuppeedd  ddaattaa  aacccceessss  ppaaggee  iinn  DDeessiiggnn  vviieeww  
The body   The body is the basic design surface of a data access page. On a grouped 
page, you can use the body to display informational text and sections. By default, the 
position of text, sections, and other elements in the body are relative. That is, elements 



 

 
 

flow one after the other in the same order as they appear in the HTML source. The 
position of an element in the body is determined by the preceding content. When 
viewed in Page view or Internet Explorer, the content in the body adjusts itself to fit the 
size of the Web browser. 
 
Sections   You use sections to display text, data from a database, and toolbars. The 
position of controls and other elements within a section is absolute by default. That is, 
the position of each control or element is fixed relative to the top and left coordinates of 
the section. Controls that have an absolute position within a section keep the same 
position even when you resize the browser. 
 
There are four types of sections available on a grouped data access page: group 
header, group footer, caption, and record navigation sections. You can use just the 
sections you need for a group level.  

• Group header   Used primarily to display data and calculate totals. To group 
data, you must have at least two group levels. The group header at the lowest 
group level is like the detail section of a report: It repeats until all the records are 
printed for the current group.  

• Group footer   Used primarily to calculate totals. It appears before the record 
navigation section for the group level. A group footer is not available for the 
lowest group level on a data access page. 

• Caption   Used to display captions for columns of data. It appears immediately 
before the group header. This section is displayed only when the next-higher 
group level is expanded. You can't place bound controls in a caption section. 

• Record navigation   Used to display the record navigation control for the group 
level. A record navigation section for a group appears after the group header 
section if there is no footer for the group level and appears after the footer if there 
is a footer for the group level. You can't place bound controls in a record 
navigation section.  

Each group level has a record source. The name of the record source is displayed on 
the section bar for each section used for a group level. The following illustration shows 
the Orders by Date data access page in Design view. 
  
AA  ggrroouuppeedd  ddaattaa  aacccceessss  ppaaggee  iinn  PPaaggee  vviieeww  oorr  IInntteerrnneett  EExxpplloorreerr  
The following illustration shows how the sections look on the same data access page 
when it's open in Page view or in Internet Explorer 5 or later. You can specify how many 
records you want displayed on the page for each group level by setting the 
DataPageSize property in the Sorting And Grouping box in page Design view. In the 
example page, DataPageSize is set to 2 for the OrderTotals-OrderDate group level and 
to All for the OrderTotals group level. 
 



 

 
 

 
CCoonnnneecctt  aa  ddaattaa  aacccceessss  ppaaggee  oorr  ootthheerr  WWeebb  ppaaggee  ttoo  aa  ddaattaabbaassee  
If no database is open when you create a data access page or when you open in 
Microsoft Access a Web page created outside of Access, Access prompts you for 
connection information. If you don't specify the connection information when prompted, 
you'll need to specify it after you've opened the page; otherwise, you won't be able to 
bind database data to the page. In addition, if you change the location of a database 
after creating a data access page that stores the original location in its 
ConnectionString property, you'll need to change the connection information for the 
page.  

1. In Design view of a data access page, display the field list. 

2. Right-click the database icon at the top of the list. 

3. On the shortcut menu, click Connection. 

4. Specify the connection information for the database you want to use for the data 
access page.  

For information about the Connection dialog box, click the Help button at the 
bottom of the dialog box.  

Notes  

• If you already have a Microsoft Access database or Microsoft Access project 
open when you create a data access page or open a Web page created outside 
of Microsoft Access, the page is automatically connected to the open database 
and stores that connection information in its ConnectionString property.  

• You can also change the ConnectionString property in the data access page 
property sheet directly. 

• A PivotTable list on the data access page may have a separate connection string 
if it displays data from an external data source. You can modify the connection 
information for the PivotTable list from within Access by using the Connection 
Editor in the Data Sources section of the PivotTable Property Toolbox.  

WWhheerree  aa  ddaattaa  aacccceessss  ppaaggee  ggeettss  iittss  ddaattaa  
This topic provides reference information about: 
Types of data sources for a data access page 
Types of data sources for Microsoft Office Web Components on a data access page 
 
TTyyppeess  ooff  ddaattaa  ssoouurrcceess  ffoorr  aa  ddaattaa  aacccceessss  ppaaggee  
A data access page gets its data from a Microsoft Access database, or a Microsoft SQL 
Server database version 6.5 or later. To design a page using data from one of these 
databases, the page must be connected to the database. If you have already opened a 



 

 
 

Microsoft Access database, or a Microsoft Access project that’s connected to a 
Microsoft SQL Server database, the data access page you create automatically 
connects to the current database and stores that path in the ConnectionString 
property of the data access page. When a user browses to the page in Internet Explorer 
5 or displays the page in Page view, it displays current data from the underlying 
database by using the path defined in the ConnectionString property. If you design the 
data access page while the database is on a local drive, Microsoft Access will use the 
local path, which means the data won’t be accessible to others. For this reason, it’s 
important that you move or copy the database to a network location that’s accessible to 
those you want to use the page. Once it's on the network share, open the database 
using the UNC address. If you move or copy the database after you’ve already 
designed the page, you’ll have to update the path in the ConnectionString property to 
point to the new location.  
 
When the data access page is connected to a database, the Database tab in the field 
list displays folders containing all of the tables or queries available in the database. You 
add data to the data access page from these record sources. If the database icon has a 
red X on it and you don’t see any folders underneath, you need to connect the data 
access page to a database to continue designing the page. 
  
TTyyppeess  ooff  ddaattaa  ssoouurrcceess  ffoorr  MMiiccrroossoofftt  OOffffiiccee  WWeebb  CCoommppoonneennttss  oonn  aa  
ddaattaa  aacccceessss  ppaaggee  
Although the data access page gets its data from a Microsoft Access or Microsoft SQL 
Server database, Microsoft Office Web Component controls on the page can display 
data from either of these databases or from other sources. For example, the page may 
contain a PivotTable list, spreadsheet, or chart with data from a Microsoft Excel 
worksheet or a database other than Microsoft Access or Microsoft SQL Server. 
Depending on the data source, the data in these controls may be a snapshot of the 
original data or it may be live data displayed through a separate connection that the 
control has with its data source.  
To create a Web component with data from a source other than the current database, 
you may have to use a program other than Microsoft Access to first publish the data to a 
Web page. For example, to create a PivotTable list that contains data from a Microsoft 
Excel worksheet, you have to publish the data from Microsoft Excel. Then, in Microsoft 
Access, you can open the Web page and turn it into a data access page by adding 
controls that are bound to a Microsoft Access or Microsoft SQL Server database. You 
can further customize the page by adding labels, pictures, or other features to enhance 
the page's appearance. From within Microsoft Access, you can create a PivotTable list 
control that uses data from an external source other than Microsoft Excel. You do this 
by specifying connection information in the Data Source section of the PivotTable 
Property Toolbox when you create the control. 
 
AAbboouutt  aaddddiinngg  ddaattaa  ttoo  aa  ddaattaa  aacccceessss  ppaaggee  bbyy  uussiinngg  tthhee  ffiieelldd  lliisstt  
When you use the field list to add data to your data access page, Microsoft Access 
automatically creates controls that are bound to the fields you add, just like it does with 
the form and report field list. However, the form and report field list and the data access 



 

 
 

page field list are not the same. Before you can add bound controls to a form or report, 
you must first bind the form or report to a specific record source. Once you do that, only 
the fields from that record source are displayed in the field list. A data access page, on 
the other hand, isn't bound until you add controls to it, and then it can be bound to more 
than one record source at a time. Therefore, the field list for a data access page 
displays all the fields you can choose from in the database to add to the page. 
This topic provides reference information about what you need to do to use the field list 
and what the field list contains, what Access does for you when you use the field list, 
and how you add fields to the data access page. Before you begin, familiarize yourself 
with the strategies for creating a data access page. 
You connect to a database 
Access identifies related fields 
You can add individual controls for each field 
You can add a PivotTable control with multiple fields 
Access builds the SQL query for the data access page 
Access builds the data access page's data definition 
  
YYoouu  ccoonnnneecctt  ttoo  aa  ddaattaabbaassee  
Before you can add data to a data access page, you must be connected to a Microsoft 
Access database or Microsoft SQL Server database. When the page is connected to 
one of these databases, the Database tab in the field list displays folders containing all 
of the tables or queries available in the database. If the database icon in the field list 
has a red X on it and you don’t see any folders underneath it, you need to connect the 
data access page to a database to continue designing the page. 
  
AAcccceessss  iiddeennttiiffiieess  rreellaatteedd  ffiieellddss  
In the field list, when you click the expand indicator next to a specific table or query, 
you’ll see the list of fields for that record source. If the record source is a table, you'll see 
a Related Tables folder above the list of fields. The folder lists the tables and fields that 
are related to the table you expanded in the field list. If you hold the pointer over a table 
in the Related Tables folder, you'll see the field through which the tables are related. If 
you add fields directly from tables that are related, or if you add fields from queries that 
use related tables, Microsoft Access automatically uses the existing relationships as you 
design the data access page. If you add fields to the page from tables that aren't related 
or from tables that have multiple relationships to tables already used on the page, 
Microsoft Access will prompt you each time to define a new relationship. Relationships 
you define in this way are only used for the current data access page; they are not 
added to the database. 
 
Note   If you're working in a multiuser environment, you may want to refresh the field list 
occasionally in case others have added tables or queries since you began designing the 
data access page. 



 

 
 

  
YYoouu  ccaann  aadddd  iinnddiivviidduuaall  ccoonnttrroollss  ffoorr  eeaacchh  ffiieelldd  
You can drag fields one at a time to the data access page to create a control bound to 
that field. Or you can drag an entire table or other record source from the field list to add 

all of its fields at one time. If the Control Wizards tool in the toolbox is selected, 
when you drag an entire table to a section, Microsoft Access displays the Layout 
Wizard, which asks whether you want to add fields as individual controls or as a 
PivotTable list. If you want users to be able to edit the data in the fields, or if you want to 
arrange the controls in a free-form custom layout, use individual controls. With a few 
exceptions, Microsoft Access automatically creates the appropriate kind of individual 
control based on the type of data stored in the field. You can also choose the kind of 
individual control you want it to create before you drag the field to the data access page. 
  
YYoouu  ccaann  aadddd  aa  PPiivvoottTTaabbllee  ccoonnttrrooll  wwiitthh  mmuullttiippllee  ffiieellddss  
Add fields as part of a PivotTable control if you want to display data that you can 
rearrange, summarize, and otherwise analyze in different ways, but not add or change 
the actual values. Learn more about what a PivotTable list is and what it can do before 
you decide. Or you can use PivotTable lists just to display data in a grid, such as detail 
records in a grouped data access page. When you use a PivotTable control in this way, 
you can set properties that hide the pivoting functionality. If you create a PivotTable list 
by dragging a table or other record source from the field list and then choosing 
PivotTable list, some of these properties are already set to hide certain PivotTable list 
features, such as the title bar, toolbar, and column and row drop areas. Use the 
PivotTable Property Toolbox to change these and other properties of the control and 
its content.  
 
Note   A PivotTable list control has its own field list separate from the field list for the 
data access page. The PivotTable field list shows all of the fields you added from the 
data access page's field list to the PivotTable control. It does not list all of the fields and 
record sources available in the database. If you remove a field from the PivotTable list 
control, the field remains in the PivotTable's field list so you can add it at a later time. 
Unlike the data access page's field list, the PivotTable field list is also available in the 
browser so others using the page can add fields to the PivotTable list as they're 
analyzing data. 
  
AAcccceessss  bbuuiillddss  tthhee  SSQQLL  qquueerryy  ffoorr  tthhee  ddaattaa  aacccceessss  ppaaggee  
As you drag fields and record sources to the data access page and add grouping levels, 
sort orders, and so on, Microsoft Access constructs a query behind the scenes that 
translates what you've laid out on the screen and otherwise specified for the design into 
Structured Query Language (SQL) that the database understands. Using the existing 
relationships that are defined between record sources, Microsoft Access creates a 
query that retrieves the data you selected and presents it the way you've specified. If 
you add fields from record sources that have no relationship, Microsoft Access displays 
the New Relationship dialog box so you can define the relationship yourself. 



 

 
 

  
AAcccceessss  bbuuiillddss  tthhee  ddaattaa  aacccceessss  ppaaggee''ss  ddaattaa  ddeeffiinniittiioonn  
When you add a field to the data access page, Access also adds the field to the page's 
data definition, which is the collection of data you've added to the page. The data 
definition, represented on the Page tab in the field list, shows which record sources are 
used for the page, how the data is related, and what the grouping levels are. 
 

  



 

 
 

CChhaapptteerr  ::  77  MMaaccrrooss  
MMaaccrrooss::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
WWhhaatt  iiss  aa  mmaaccrroo??  
A macro is a set of one or more actions that each perform a particular operation, such 
as opening a form or printing a report. Macros can help you to automate common tasks. 
For example, you can run a macro that prints a report when a user clicks a command 
button. 
 
A macro can be one macro composed of a sequence of actions, or it can be a macro 
group. You can also use a conditional expression to determine whether in some cases 
an action will be carried out when a macro runs. 
 
AA  sseeqquueennccee  ooff  aaccttiioonnss  
The following macro is composed of a series of actions. Microsoft Access carries out 
these actions each time the macro runs. To run this macro, you refer to the macro name 
Review Products. 
 
AA  mmaaccrroo  ggrroouupp  
If you have numerous macros, grouping related macros in macro groups can help you 
to manage your database more easily. To display the names of macros for a macro 
group, click Macro Names on the View menu in the Macro window. 
 
For example, the following macro group, named Buttons, is made up of three related 
macros: Employees, Products, and Reps. Each macro carries out the OpenForm action, 
and the Products macro also carries out the MoveSize action. 
 
The name in the Macro Name column identifies each macro. When you run a macro in 
a macro group, Access carries out the action in the action column and any actions that 
immediately follow whose Macro Name column is blank. 
 
To run a macro in a macro group, you use the macro group name followed by a period 
and then the macro name. In the preceding example, to refer to the Employees macro 
in the Buttons macro group, you would type Buttons.Employees. 
 
CCoonnddiittiioonnaall  aaccttiioonnss  
To display the Condition column, you click Conditions on the View menu in the Macro 
window. The following macro runs the MsgBox and the StopMacro actions only when 
the expression in the Condition column is true (when there is a Null value in the 
SupplierID field). 
CCrreeaattee  aa  mmaaccrroo  

1. In the Database window, click Macros under Objects. 



 

 
 

2. Click the New button on the Database window toolbar. 

3. In the Action column, click in the first cell and then click the arrow to display the 
action list. 

4. Click the action you want to use. 

5. Type a comment for the action. Comments are optional, but make your macro 
easier to understand and maintain. 

6. In the lower part of the window, specify arguments for the action, if any are 

required. For tips on setting action arguments, click . 

7. To add more actions to the macro, move to another action row, and repeat steps 
3 through 6. Microsoft Access carries out the actions in the order you list them.  

Tip   To quickly create a macro that carries out an action on a specific database object, 
drag the object from the Database window to an action row in the Macro window. For 
example, you can create a macro that opens a form by dragging the form to an action 
row. To do this, click Tile Vertically on the Windows menu to position the Macro 
window and Database window so that they're side by side on your screen; in the 
Database window under Objects, click the object type you want, click the object, and 
then drag it to an action row. Dragging a macro or stored procedure adds an action that 
runs the macro or procedure, while dragging other database objects adds an action that 
opens the object. 
 
AAdddd  aann  aaccttiioonn  ttoo  aa  mmaaccrroo  

1. In the Macro window, click the first empty row in the Action column. If you want 
to insert an action between two action rows, click the selector for the action row 
just below the row where you want to insert the new action, and then click Insert 
Row on the toolbar. 

2. In the Action column, click the arrow to display the action list. 

3. Click the action you want to use. 

4. Type a comment for the action. Comments are optional. 

5. In the lower part of the window, specify arguments for the action, if any are 

required. For tips on setting action arguments, click .  

Tip   For action arguments whose settings are a database object name, you can set the 
argument by dragging the object from the Database window to the action's Object 
Name argument box. For example, you can set the SelectObject action's Object Name 
argument to the name of a form by dragging the form to the argument box. To do this, 



 

 
 

click Tile Vertically on the Windows menu to position the Macro window and Database 
window so that they're side by side on your screen; in the Database window under 
Objects, click the object type you want, click the object, and then drag it to the 
argument box. Dragging the object also sets the Object Type argument. 
 
MMaaccrroo  aaccttiioonnss  tthhaatt  ddoonn''tt  hhaavvee  ccoorrrreessppoonnddiinngg  DDooCCmmdd  mmeetthhooddss  
Action Visual Basic equivalent 

AddMenu No equivalent 

MsgBox MsgBox function 

RunApp Shell function 

RunCode Procedure call (Call statement) 

SendKeys SendKeys statement 

SetValue Assignment statement (Let statement) 

StopAllMacros Stop or End statements 

StopMacro Exit Sub or Exit Function statements 

 
 
WWhhyy  uussee  aa  mmaaccrroo  oorr  aann  eevveenntt  pprroocceedduurree  ffoorr  ddaattaa  vvaalliiddaattiioonn??  
In most cases, you can verify that data is entered correctly into a control on a form by 
setting the ValidationRule property for the control, or by setting record or field 
validation rules in the underlying table to which the control is bound. Macros and event 
procedures provide additional power and flexibility for more complex validation. 
Use a macro or an event procedure for data validation if:  

• Your validation rule involves conditions for more than one value on the form. For 
example, you might want to verify that any two of three fields are filled in before 
saving a record. 

• You want to display different error messages for different types of errors in the 
field. For example, if the value entered is greater than the acceptable range, you 
can display one message, and if it's less than the acceptable range, you can 
display a different message. 

• You want the user to be able to override your validation rule. In this case, you 
can display a warning message asking the user to confirm the data. 

• The validation involves references to controls on other forms or contains a 
function. 



 

 
 

• You have a validation rule that you can use for more than one form, and you 
want the convenience of defining the rule once and then referring to it in each 
form.  

RRuunn  aa  mmaaccrroo  
When you run a macro, Microsoft Access starts at the beginning of the macro and 
carries out all the actions in the macro until it reaches either another macro (if the macro 
is in a macro group) or the end of the macro. 
 
You can run a macro directly, from another macro or an event procedure, or in response 
to an event that occurs on a form or report, or a control on a form or report. For 
example, you can attach a macro to a command button on a form so that the macro 
runs when a user clicks the button. You can also create a custom menu command or 
toolbar button that runs a macro, assign a macro to a key combination, or run a macro 
automatically when you open a database. 



 

 
 

CChhaapptteerr  ::  88  MMoodduulleess  
MMoodduulleess::  WWhhaatt  tthheeyy  aarree  aanndd  hhooww  tthheeyy  wwoorrkk  
WWhhaatt  iiss  aa  mmoodduullee??  
A module is a collection of Visual Basic for Applications declarations and procedures 
that are stored together as a unit. 
 
There are two basic types of modules: class modules and standard modules. Each 
procedure in a module can be a Function procedure or a Sub procedure. 
 
CCllaassss  mmoodduulleess  
 
Form and report modules are class modules that are associated with a particular form 
or report. Form and report modules often contain event procedures that run in response 
to an event on the form or report. You can use event procedures to control the behavior 
of your forms and reports, and their response to user actions, such as clicking the 
mouse on a command button. 
When you create the first event procedure for a form or report, Microsoft Access 
automatically creates an associated form or report module. To see the module for a 
form or report, click Code on the toolbar in form or report Design view. 
 
Procedures in your form and report modules can call procedures you have added to 
standard modules.  
 
In Access 95, class modules exist in association only with a form or report. In Access 97 
or later, class modules can also exist independent of a form or report, and this type of 
class module is listed in Modules under Objects on the Database window. You can use 
a class module in Modules to create a definition for a custom object.  
 
SSttaannddaarrdd  mmoodduulleess  
Standard modules contain general procedures that aren't associated with any other 
object and frequently used procedures that can be run from anywhere within your 
database.  
 
You can view the list of standard modules in your database by clicking Modules under 
Objects in the Database window. Form, report, and standard modules are also listed in 
the Object Browser. 
 
 
MMoodduullee  PPrrooppeerrttyy  
                   
You can use the Module property to specify a form module or report module. 
Setting 

 



 

 
 

The Module property is available only by using Visual Basic and is read-only in all 
views. 
 
Note   The Module property also returns a reference to a specified Module object. 
 
Remarks 
Use the Module property to access the properties and methods of a Module object 
associated with a Form or Report object. 
 
The setting of the HasModule property of a form or report determines whether it has an 
associated module. If the HasModule property is False, the form or report does not 
have an associated module. When you refer to the Module property of that form or 
report while in design view, Microsoft Access creates the associated module and sets 
the HasModule property to True. If you refer to the Module property of a form or report 
at run-time and the object has its HasModule property set to False, an error will occur. 
 
You could use this property with any of the properties and methods of the module 
object. 

Module Property Example 

The following example uses the Module property to insert the Beep method in a form's 
Open event. 

Dim strFormOpenCode As String 
Dim mdl As Module 
 
Set mdl = Forms!MyForm.Module 
strFormOpenCode = "Sub Form_Open(Cancel As Integer)" _ 
    & vbCrLf & "Beep" & vbCrLf & "End Sub" 
    With mdl 
        .InsertText strFormOpenCode 
    End With 
 



 

 
 

CChhaapptteerr  ::  99  DDaattaabbaassee  SSeeccuurriittyy  

AAbboouutt  pprrootteeccttiinngg  aa  MMiiccrroossoofftt  AAcccceessss  ddaattaabbaassee  
SSeeccuurriinngg  aa  MMiiccrroossoofftt  AAcccceessss  ddaattaabbaassee  ffiillee  
The simplest method of protection is to set a password for opening a Microsoft Access 
database (.mdb). Once a password is set, a dialog box that requests the password will 
be displayed whenever the database is opened. Only users who type the correct 
password will be allowed to open the database. This method is secure (Microsoft 
Access encrypts the password so that it can't be accessed by reading the database file 
directly), but it only applies to opening a database. Once a database is open, all its 
objects are available to the user (unless other types of security have already been 
defined, as described later in this topic). For a database that is shared among a small 
group of users or on a single computer, setting a password is often all that is required. 
 
Caution   Do not use a database password if you will be replicating a database. 
Replicated databases can't be synchronized if database passwords are defined. 
 
To further protect the database, you can encrypt it. Encrypting a database compacts the 
database file and makes it indecipherable by a utility program or word processor. 
Decrypting a database reverses the encryption. 
  
SSeeccuurriinngg  ddaattaabbaassee  oobbjjeeccttss  wwiitthh  uusseerr--lleevveell  sseeccuurriittyy  
The most flexible and extensive method of securing a database is called user-level 
security. This form of security is similar to methods used in most network systems. The 
two main reasons to use user-level security are to:  

• Prevent users from inadvertently breaking an application by changing tables, 
queries, forms, reports, and macros on which the application depends. 

• Protect sensitive data in the database.  

Under user-level security, users are required to identify themselves by an id, and then 
type a password when they start Microsoft Access. Within the workgroup information 
file, they are identified as members of a group. Microsoft Access provides two default 
groups: administrators (named the Admins group) and users (named the Users group), 
but you can define additional groups. 
 
Although setting up user-level security on most databases can be a daunting task, the 
User-Level Security Wizard makes it easy to quickly secure your Access database in a 
one-step process. Furthermore by implementing common security schemes, the User-
Level Security Wizard minimizes and even eliminates the need to use the Security 
command from the Tools menu. 
 



 

 
 

After running the User-Level Security Wizard, you can assign or remove permissions for 
user and group accounts in your workgroup for a database and its existing tables, 
queries, forms, reports, and macros. You can also set the default permissions that 
Microsoft Access assigns for any new tables, queries, forms, reports, and macros that 
are created in a database. 
 
Permissions are granted to groups and users to regulate how they are allowed to work 
with each table, query, form, report, and macro in a database. For example, members of 
the Users group might be allowed to view, enter, or modify data in a Customers table 
but not to change the design of that table. While the Users group might be allowed to 
only view data in a table containing order data, they might be totally denied any access 
to a Payroll table. Members of the Admins group have full permissions on all of a 
database's tables, queries, forms, reports, and macros . You can set up more fine-
grained control by creating your own group accounts, assigning appropriate permissions 
to those groups, and then adding users to those groups. 
 
If you only need an administrators group and users group for your security purposes, 
you don't need to create additional groups; you can use the default Admins and Users 
groups. In this case, you only need to assign the appropriate permissions to the default 
Users group, and add any additional administrators to the default Admins group. Any 
new users you add are automatically added to the Users group. Typical permissions for 
the Users group might include Read Data and Update Data for tables and queries, and 
Open/Run for forms and reports.  
 
If you need more fine-grained control of different groups of users, you can create your 
own groups, assign different sets of permissions to those groups, and then add users to 
the appropriate groups. To simplify the management of permissions, it is recommended 
that you only assign permissions to groups (not users), and then add users to the 
appropriate groups.  
 
SSeeccuurriinngg  VViissuuaall  BBaassiicc  ffoorr  AApppplliiccaattiioonnss  ((VVBBAA))  CCooddee  
You can protect Microsoft Visual Basic for Applications (VBA) code in modules and 
modules behind forms and reports with a password, which you enter once per session. 
The password prevents unauthorized users from editing, cutting, pasting, copying, 
exporting, and deleting VBA code. 
To protect the intellectual property of your code, you can remove editable VBA code 
from your database, and prevent modifications to the design of forms, reports, and 
modules by saving it as an MDE file. 
  
SSeeccuurriinngg  ddaattaa  aacccceessss  ppaaggeess  
To protect a data access page and the data it accesses, do the following:  

• Protect the Access database containing the shortcut to the data access page and 
its corresponding HTML file by using the file system security of the computer 
where you have stored these files. 



 

 
 

• Protect the database connected to the data access page by securing the 
database against unauthorized users, controlling the level of access once a user 
logs in, and not saving the database password with the data access page. 

• Prevent unauthorized access from a malicious Visual Basic script by using 
Microsoft Internet Explorer security options and using three-tier data access.  

SSeeccuurriinngg  aann  aapppplliiccaattiioonn  
Finally, you can prevent curious or malicious end users from accidentally or intentionally 
damaging your application by hiding database objects from the database window and 
setting several startup options to control the applications appearance and behavior and 
protect menus and command bars. 
  
SSeeccuurriittyy  iinn  aa  mmuullttiiuusseerr  eennvviirroonnmmeenntt  
In many situations, you will want to prevent users from replicating a database. 
Replicating a database allows a user to make a copy of a shared database and also 
adds fields and makes other changes to the current database. You will probably want to 
prevent users from setting a database password, too. If a user sets a database 
password for a shared database, no other user will be able open the database without 
providing that password. You might also want to keep users from changing startup 
properties that specify features such as custom menus, custom toolbars, or the startup 
form. 
If a shared database doesn't have user-level security defined, you can't prevent a user 
from making any of these changes. Running the User-Level Security Wizard on a 
database defines user-level security, which allows you to control access to certain 
features and determines how database objects can be used. When user-level security is 
defined, a user or group must have Administer permission for the database to replicate 
a database, set a database password, or change its startup properties. After running the 
User-Level Security Wizard, only members of the Admins group of the current 
workgroup have Administer permission. 
If user-level security is already defined and a user or group currently has Administer 
permission for a database, removing that permission will prevent the user or group from 
making any of these changes. If you need to allow a user or group to perform any of 
these tasks, you can assign the Administer permission to that user or group. You can't 
control access to these three tasks independently. 
PPrrootteeccttiinngg  aa  ddaattaa  aacccceessss  ppaaggee  sshhoorrttccuutt  aanndd  iittss  ccoorrrreessppoonnddiinngg  HHTTMMLL  
ffiillee  
A data access page is the combination of a shortcut stored in the Microsoft Access 
database (.mdb) or Microsoft Access project (.adp) file and a corresponding Hypertext 
Markup Language (HTML) file located in your computer's file system. To protect a 
page's shortcut and its corresponding HTML file from being renamed, deleted, or 
changed, use the file system's security of the computer where you have stored these 
files. For example, on your computer, you can make the Access database or Access 
project file that contains the page's shortcut read-only. Or on the Web server where the 
page's corresponding HTML file is located (after you have published the page), make 



 

 
 

the file and the folder where the HTML file is located read-only. For more information 
about file and folder security, see Microsoft Windows Help. 
  
PPrrootteeccttiinngg  aanndd  ccoonnttrroolllliinngg  ddaattaabbaassee  aacccceessss  ffrroomm  aa  ddaattaa  aacccceessss  ppaaggee  
Consider the following when you want to ensure secure access to the Access database 
or Microsoft SQL Server database that the page is connected to: 
 
Protect the database   You can connect a page to either an Access database or SQL 
Server database. You should provide adequate security to either database as a 
foundation for protecting access to the database through a page. As with any 
application, you need to prevent unauthorized users from accessing the database, and 
control the level of access once a user has logged in.  

• For an Access database, if it is protected with user-level security and you want to 
enable user-level security through a page, you need to make sure that the 
connection information for a page specifies the correct workgroup information file 
and that this file is in a public network share accessible to all users. Modify the 
connection to the page in the Data Link Properties dialog box by clicking the All 
tab, double-clicking Jet OLEDB:System database, and then specifying the UNC 
path to the correct workgroup information file in the Property Value box. Learn 
about protecting an Access database.  

If you have set a database password on an Access database that is connected to 
a page, you will be prompted for the password the first time you view the page.  

• For an SQL Server database, if you want to use Windows NT integrated security 
to connect from a page, modify the connection to the page in the Data Link 
Properties dialog box by clicking Connection, and then clicking Use Windows 
NT Integrated security. Learn about protecting an SQL Server database.  

Don't save the user name and password with the page   If the username and 
password to the database are saved with the page, any user can log in to the database. 
If you want the page to prompt the user to log in to the database, modify the connection 
to the page in the Data Link Properties dialog box by clicking the Connection tab, and 
then clearing the Allow saving of password check box.  
 
Return records based on a user name   You might want to create a page that doesn't 
require entering a username and password through a page but can automatically detect 
who the user is, and display records based on that user. For example, you could create 
a page that allows users to change their personnel file. The general steps for doing this 
are:  

• Create a page in an Access project connected to an SQL Server database 
protected by Microsoft Windows NT integrated security. 



 

 
 

• Add a column to the employee table that has each employee's Windows NT log 
in user name. 

• Create a view that uses the suser_sname() function to detect the current user 
logged in, and make that view the page's record source.  

PPrreevveennttiinngg  uunnaauutthhoorriizzeedd  aacccceessss  ffrroomm  aa  mmaalliicciioouuss  ssccrriipptt  
A page uses the Microsoft Office Data Source Control (MSODSC) to connect to its data 
source. When a user opens a page, the MSODSC on the page may use the user name 
of the user to log on to the database. A malicious page author could exploit this by using 
Microsoft Visual Basic, Scripting Edition or JScript running against the MSODSC to 
attempt access to databases on servers accessible to the user, but not the page author. 
The mode of data access used by the MSODSC determines whether a page is 
considered inherently safe, or if cross-domain data access is possible from the page. 
You can configure the MSODSC to use two modes of data access: two-tier or three-tier 
data access. 
 
Two-tier data access is a direct connection to a data source in a traditional client/server 
fashion — the client (first tier) makes a direct connection to the database server (second 
tier). To perform two-tier data access, the MSODSC makes a direct connection to its 
data source through an OLE DB provider that is registered on the user’s computer. For 
an Access database, two-tier data access uses the local computer’s Microsoft Jet 4.0 
OLE DB provider to connect to an .mdb file located on a network share. For an SQL 
Server database, two-tier data access uses the local computer’s Microsoft OLE DB 
provider for SQL Server to connect to a database server available on your local 
network. 
 
Three-tier data access refers to using a third, remote component between the client and 
database components. Three-tier data access is typically used to access data across 
the Internet. For three-tier data access that uses the MSODSC, this third component is 
the ActiveX Data Objects (ADO) Remote Data Service (RDS) component (also called 
Data Factory) running on Microsoft Internet Information Server (IIS).  
 
Any page that uses two-tier data access is considered by Microsoft Internet Explorer to 
be making a cross-domain access attempt. Depending on the security settings in 
Internet Explorer, when a user opens a page by using two-tier data access, one of three 
things occurs: the page is automatically disabled, the user is asked whether to allow 
data access, or the page is automatically enabled. 
 
Internet Explorer security settings also define different security zones. If a page is on a 
Web server in a trusted zone, the cross-domain attempt can be enabled automatically. 
In a controlled environment, such as a corporate intranet, your pages will perform better 
if you use two-tier data access, and make sure that they are published from a server 
located in a trusted security zone. This is the simplest way to provide security against 
unauthorized access from malicious scripts. For more information about security 
settings, see Internet Explorer Help. 



 

 
 

 
A page that uses three-tier data access to connect to a database is considered to be 
inherently safe regardless of what Internet Explorer security zone it is published from, 
and will not warn the user about cross-domain data access attempts when it is opened if 
authentication settings have been left to their default configuration.  
 
WWhhaatt  iiss  aa  MMiiccrroossoofftt  AAcccceessss  wwoorrkkggrroouupp??  
A Microsoft Access workgroup is a group of users in a multiuser environment who share 
data. If user-level security is defined, the members of a workgroup are recorded in user 
and group accounts that are stored in a Microsoft Access workgroup information file. 
Users' passwords are also stored in the workgroup information file. These security 
accounts can then be assigned permissions for databases and their tables, queries, 
forms, reports, and macros. The permissions themselves are stored in the secure 
database. 
 
In Microsoft Access 2000, user preferences are stored in the Windows Registry in the 
\Hkey_Current_User\Software\Microsoft\Office\9.0\Access\Settings key. In versions 
prior to Microsoft Access 97, user preferences are defined in the Options dialog box 
are recorded in the workgroup information file. 
 
Your default workgroup is defined by the workgroup information file that the Setup 
program automatically creates in the language folder. Unless you specify another 
workgroup information file using the Workgroup Administrator utility, Microsoft Access 
uses the default workgroup information file each time you start Microsoft Access. You 
can also use the Workgroup Administrator to create a new Microsoft Access workgroup 
information file. 
Before you create security accounts, you should choose a Microsoft Access workgroup 
information file where those accounts will be stored. You can use the default workgroup 
information file, specify an existing file, or create a new file. If you need to make sure 
that your workgroup and its permissions can't be duplicated, don't use the default 
workgroup information file; you must make sure the workgroup information file you 
choose has been created with a unique workgroup ID (WID). If such a workgroup 
information file doesn't exist, you should create one using the Workgroup Administrator. 
 
WWaayyss  ttoo  mmaakkee  aa  sseeccuurree  aapppplliiccaattiioonn  aanndd  wwoorrkkggrroouupp  aavvaaiillaabbllee  ttoo  uusseerrss  
A secure application depends on users having access to both an application database 
where permissions are stored, and a workgroup where user and group accounts and 
passwords are stored. Depending on how the application is to be used, you can make 
the application and workgroup available to users in a variety of ways. 
 
CCooppyy  tthhee  aapppplliiccaattiioonn  ffiilleess  aanndd  tthhee  wwoorrkkggrroouupp  iinnffoorrmmaattiioonn  ffiillee  tthhaatt  
ddeeffiinneess  tthhee  wwoorrkkggrroouupp  ttoo  aa  nneettwwoorrkk  sseerrvveerr  llooccaattiioonn  
Using the Workgroup Administrator, users can join the workgroup by specifying the 
network server path to the workgroup information file, and then run the application 
directly from the server location. You might want to prevent users from opening the 



 

 
 

application with exclusive access by removing Open Exclusive permissions for the 
database from the Users group. 
 
GGiivvee  eeaacchh  uusseerr  aa  ccooppyy  ooff  tthhee  aapppplliiccaattiioonn  ffiilleess  aanndd  tthhee  wwoorrkkggrroouupp  
iinnffoorrmmaattiioonn  ffiillee  tthhaatt  ddeeffiinneess  tthhee  wwoorrkkggrroouupp  
Using the Workgroup Administrator, users can join the workgroup by specifying the path 
to the workgroup information file on their computer, and then running their copies of the 
application on their computers. However, if you have to update the application, its data, 
or the workgroup information file, you'll have to give each user copies of all updated 
files. 
 
As an alternative, you might want to split the application into a data database placed on 
a network server and an application database containing all other database objects 
placed on each user's computer. Typically in this configuration, you want to keep the 
workgroup information file on the server as well. Then if you have to update the 
application, you only have to give users updated versions of the application database 
file.  
 
GGiivvee  uusseerrss  iinn  ddiiffffeerreenntt  MMiiccrroossoofftt  AAcccceessss  wwoorrkkggrroouuppss  aacccceessss  ttoo  tthhee  
aapppplliiccaattiioonn  bbyy  ccrreeaattiinngg  tthhee  ssaammee  ggrroouupp  iinn  eeaacchh  wwoorrkkggrroouupp  
You can create a group account in each workgroup with the identical name and 
personal ID (PID), and then add users in each workgroup to that group. For example, a 
user working on a network on a Microsoft Access workgroup in Honolulu can use an 
application created for a Microsoft Access workgroup in Melbourne if that user is a 
member of a group account that was created with an identical name and PID on both 
workgroups. 
 
To run the application, each user must have a copy of Microsoft Access. To create a 
Microsoft Access application that doesn't require a copy of Microsoft Access, you must 
use Microsoft Office 2000 Developer (MOD). 
 
HHooww  ttoo  oorrggaanniizzee  sseeccuurriittyy  aaccccoouunnttss  
A Microsoft Access workgroup information file contains the following predefined 
accounts. 

Account Function 

Admin The default user account. This account is exactly the same for every 
copy of Microsoft Access and other applications that can use the 
Microsoft Jet database engine, such as Microsoft Visual Basic for 
Applications and Microsoft Excel. 

Admins The administrator's group account. This account is unique to each 
workgroup information file. By default, the Admin user is in the Admins 
group. There must be at least one user in the Admins group at all 
times. 



 

 
 

Users The group account comprising all user accounts. Microsoft Access 
automatically adds user accounts to the Users group when a member 
of the Admins group creates them. This account is the same for any 
workgroup information file, but it contains only user accounts created 
by members of the Admins group of that workgroup. By default, this 
account has full permissions on all newly-created objects. The only way 
to remove a user account from the Users group is for a member of the 
Admins group to delete that user. 

 
In effect, security in Microsoft Access is always "on." Until you activate the logon 
procedure for a workgroup, Microsoft Access invisibly logs on all users at startup by 
using the default Admin user account with a blank password. Behind the scenes, 
Microsoft Access uses the Admin account as the administrator account for the 
workgroup, as well as the owner of any databases and tables, queries, forms, reports, 
and macros created. 
 
Administrators and owners are important because they have permissions that can't be 
taken away:  

• Administrators (members of the Admins group) can always get full permissions 
for objects created in the workgroup. 

• An account that owns a table, query, form, report, or macro can always get full 
permissions for that object. 

• An account that owns a database can always open the database.  

Because the Admin user account is exactly the same for every copy of Microsoft 
Access, the first steps in securing your database are to define administrator and owner 
user accounts (or use a single user account as both the administrator and owner 
account), and then to remove the Admin user account from the Admins group. 
Otherwise, anyone with a copy of Microsoft Access can log on to your workgroup by 
using the Admin account and have full permissions for the workgroup's tables, queries, 
forms, reports, and macros. 
 
For example, to secure a database named Orders, you could create your own 
OrdersAdmin and OrdersOwner user accounts, and then add passwords to these 
accounts. 
 
You can assign as many user accounts as you want to the Admins group, but only one 
user account can own the database itself — the user account that is active when the 
database is created, or when ownership is transferred by creating a new database and 
importing all of a database's objects into it. However, group accounts can own tables, 
queries, forms, reports, and macros within a database. 
Important    



 

 
 

• The accounts that you create for users of the database must be stored in the 
workgroup information file that those users will join when they use the database. 
If you're using a different file to create the database, change the file before 
creating the accounts. 

• Make sure to create a unique password for your administrator and user accounts. 
A user who can log on by using the administrator account can always get full 
permissions for any tables, queries, forms, reports, and macros created in the 
workgroup. A user who can log on using an owner account can always get full 
permissions for those objects owned by that user.  

Organizing users in groups makes it easier to manage a secure database. With this 
strategy, rather than assign permissions to each user for each table, query, form, report, 
and macro in your database, you assign permissions to a few groups, and then add 
users to the appropriate group. When users log on to Microsoft Access, they inherit the 
permissions from any groups they belong to. Only user accounts can log on to Microsoft 
Access; you can't log on by using a group account. 
 
For example, you could secure an Orders database by creating a Managers group for 
managers, a Sales Reps group for sales representatives, and a Staff group for staff 
employees. You can assign the least restrictive set of permissions to the Managers 
group, a more restrictive set of permissions to the Sales Reps group, and the most 
restrictive set of permissions to the Staff group. When you create a user account for a 
new employee, you add that account to the appropriate group. The employee then has 
the permissions associated with that group. 
 
After you create user and group accounts, you can view the relationships between them 
by clicking User And Group Accounts on the Security submenu (Tools menu), and 
then clicking the Print Users And Groups button. Microsoft Access prints a report of 
the accounts in the workgroup, showing the groups to which each user belongs and the 
users that belong to each group. 
 
HHooww  ppeerrmmiissssiioonnss  wwoorrkk  aanndd  wwhhoo  ccaann  aassssiiggnn  tthheemm  
There are two types of permissions: explicit and implicit. Explicit permissions are those 
permissions that are granted directly to a user account; no other users are affected. 
Implicit permissions are those permissions that are granted to a group account. Adding 
a user to that group grants the group's permissions to that user; removing a user from 
the group takes away the group's permissions from that user. 
When a user attempts to perform an operation on a secured database object, that user's 
set of permissions are based on the intersection of that user's explicit and implicit 
permissions. A user's security level is always the least restrictive of that user's explicit 
permissions and the permissions of any and all groups to which that user belongs. For 
this reason, the least complicated way to administer a workgroup is to create new 
groups and assign permissions to the groups, rather than to individual users. Then you 
can change individual users' permissions by adding or removing them from groups. 



 

 
 

Also, if you need to grant new permissions, you can grant them to all members of a 
group in a single operation. 
 
Permissions can be changed for a database object by:  

• Members of the Admins group of the workgroup information file in use when the 
database was created. 

• The owner of the object. 

• Any user who has Administer permission for the object.  

Even though users might not be able to currently perform an action, they might be able 
to grant themselves permissions to perform the action. This is true if a user is a member 
of the Admins group, or if a user is the owner of an object. 
 
The user who creates a table, query, form, report, or macro is the owner of that object. 
The same group of users that can change permissions can change the ownership of 
these objects by using the User And Group Permissions command on the Security 
submenu (Tools menu), or they can re-create these objects. To re-create these objects, 
you do not have to start from scratch. You can make a copy of the object, or import it or 
export it to another database. If you want to secure an entire database, this is the 
easiest way to transfer the ownership of all of these objects, including the database . 
The best way to secure an entire database is by using the User-Level Security Wizard, 
which creates a new database and imports all objects into it. 
 
Note   Copying, importing, or exporting doesn't change the ownership of queries that 
has its RunPermissions property set to Owner's. You can change ownership of a 
query only if its RunPermissions property is set to User's. 
 
TTyyppeess  ooff  ppeerrmmiissssiioonnss  
The following table summarizes the permissions that you can assign. 

Permission Permits a user to Applies to 

Open/Run Open a database, form, or 
report, or run a macro. 

Databases, forms, reports, 
and macros 

Open Exclusive Open a database with exclusive 
access. 

Databases 

Read Design View objects in Design view Tables, queries, forms, 
reports, and macros 

Modify Design View and change the design of 
objects, or delete them. 

Tables, queries, forms, 
reports, and macros 

Administer For databases set database Databases tables queries



 

 
 

password, replicate a database, 
and change startup properties. 
For tables, queries, forms, 
reports, and macros, have full 
access to these objects and 
data, including ability to assign 
permissions. 

forms, reports, and macros 

Read Data View data. Tables and queries 

Update Data View and modify but not insert or 
delete data. 

Tables and queries 

Insert Data View and insert but not modify or 
delete data. 

Tables and queries 

Delete Data View and delete but not modify 
or insert data. 

Tables and queries 

 
Note    

• Some permissions automatically imply the selection of others. For example, the 
Update Data permission for a table automatically implies the Read Data and 
Read Design permissions because you need these to modify the data in a table. 
Modify Design and Read Data imply Read Design. For macros, Read Design 
implies Open/Run. 

• To design forms, reports, macros, modules in a multiuser environment, you must 
open a Microsoft Access database exclusively, which means you must have 
Open Exclusive permission on the Access database. Learn about saving design 
changes to a shared Access database. 

• In general, for users to access a linked table, grant Read Data and Read Design 
permissions on the table in the back-end database, and Modify Design 
permission on the table link defined in the front-end database so that users can 
conveniently re-link the table. If you want to restrict all access to the back-end 
table but still allow users to view the data and re-link the tables, remove all 
permissions on the back-end table and use queries in the front-end database 
with their RunPermissions property set to Owner's.  

 
AAbboouutt  ccrreeaattiinngg  aanndd  cchhaannggiinngg  ppaasssswwoorrddss  
This topic provides reference information about: 
Database passwords 
Security account passwords  
Visual Basic for Applications (VBA) passwords 



 

 
 

DDaattaabbaassee  ppaasssswwoorrddss  
The first kind of password is called a "database password." If you set a database 
password, all users must enter that password before they are allowed to open the 
database. Adding a database password is an easy way to prevent unwanted users from 
opening your database; however, once a database is open, no other security measures 
are provided unless user-level security has been defined as well. If you have user-level 
security defined for your database, you can prevent users from setting a database 
password. 
  
SSeeccuurriittyy  aaccccoouunntt  ppaasssswwoorrddss  
The second kind of password is called a "security account password" and is only used 
when user-level security has been defined for a workgroup. A security account 
password is created to make sure that no other user can log on using that user name. 
By default, Microsoft Access assigns a blank password to the default Admin user 
account and to any new user accounts that you create in your workgroup. As part of 
securing a database, it's important to add a password to:  

• The Admin user account (to activate the Logon dialog box). 

• The user account that owns the database and its tables, queries, forms, reports, 
and macros. 

• Any user accounts that you add to the Admins group.  

In addition, you might want to add passwords to the accounts you create for users, or 
instruct users to add their own passwords. 
Users can create or change their own user account passwords; however, only an 
administrator account can clear a password if a user forgets the password. 
  
VViissuuaall  BBaassiicc  ffoorr  AApppplliiccaattiioonnss  ((VVBBAA))  ppaasssswwoorrddss  
The third kind of password is called a Visual Basic for Applications (VBA) password. 
You use this password once per session to protect VBA code in modules and modules 
behind forms and reports. This password prevents unauthorized users from editing, 
cutting, pasting, copying, exporting, and deleting VBA code. 
 
AAbboouutt  uussiinngg  aa  ddaattaabbaassee  ppaasssswwoorrdd  aanndd  uusseerr--lleevveell  sseeccuurriittyy  wwiitthh  aa  
MMiiccrroossoofftt  AAcccceessss  ddaattaabbaassee  tthhaatt  iiss  ssaavveedd  aass  aann  MMDDEE  ffiillee  
Creating an MDE file secures the forms, reports, and Microsoft Visual Basic code in 
your Microsoft Access database, without requiring users to log on or requiring you to 
create and manage the user accounts and permissions that are needed for user-level 
security. However, if you define a database password or user-level security before 
saving an Access database as an MDE file, those features will still apply to an MDE file 
created from that database. If your Access database has a database password or user-
level security defined and you want to remove these features, you must do so before 
saving it as an MDE file.  
 



 

 
 

To save an Access database that was secured with user-level security as an MDE file, 
you must meet the following requirements before you can proceed:  

• You must join the workgroup information file that defines the user accounts used 
to access the database, or that were in use when the database was created. 

• Your user account must have Open/Run and Open Exclusive permissions for the 
database. 

• Your user account must have Modify Design or Administer permissions for any 
tables in the database, or you must be the owner of any tables in the database. 

• Your user account must have Read Design permissions for all objects in the 
database.  

PPrrootteecctt  aa  ddaattaabbaassee  bbyy  aaddddiinngg  aa  ddaattaabbaassee  ppaasssswwoorrdd  

1. Close the database. If the database is shared on a network, make sure all other 
users have closed the database. 

2. Make a backup copy of the database, and store it in a secure place. 

3. On the File menu, click Open. 

4. Click the arrow to the right of the Open button, and then click Open Exclusive. 

5. On the Tools menu, point to Security, and then click Set Database Password. 

6. In the Password box, type your password. Passwords are case-sensitive. 

7. In the Verify box, confirm your password by typing the password again, and then 
click OK.  

The password is now set. The next time you or any other user opens the 
database, a dialog box will be displayed that requests a password.  

Caution  

• If you lose or forget your password, it can't be recovered, and you won't be able 
to open your database. 

• Do not use a database password if you will be replicating a database. Replicated 
databases can't be synchronized if database passwords are defined.  

Notes  



 

 
 

• A database password is stored with the database and not with the workgroup 
information file. 

• You can't set a database password if user-level security has been defined for 
your database and you don't have Administer permission for the database. Also, 
a database password is defined in addition to user-level security. If user-level 
security has been defined, any restrictions based on user-level security 
permissions remain in effect. 

• If a table from a password-protected database is linked, the password is cached 
(saved) in the database it is linked to when the link is established. This may have 
unforeseen consequences.  

 
RReemmoovvee  aa  ddaattaabbaassee  ppaasssswwoorrdd  

1. On the File menu, click Open. 

2. Click the arrow to the right of the Open button, click Open Exclusive, and then 
open the database. 

3. In the Password Required dialog box, type the database password, and then 
click OK. Passwords are case-sensitive. 

4. On the Tools menu, point to Security, and then click Unset Database 
Password. This command is only available if a database password was set 
previously. 

5. In the Unset Database Password dialog box, type your current password.  

6. Click OK.  

 
AAbboouutt  lliinnkkiinngg  ttaabblleess  ffrroomm  aa  ppaasssswwoorrdd--pprrootteecctteedd  ddaattaabbaassee  
To link a table from a Microsoft Access database that is password-protected, you must 
supply the correct password. If you supply the correct password, Microsoft Access 
stores the database password with the information that defines the link to the table. 
After the link has been defined, any user who can open the database that the table is 
linked to can open the linked table. When a user opens the linked table, Microsoft 
Access uses the stored password to open the database where the table is stored. If the 
password is changed for the database where the table is stored, the next time the linked 
table is opened, the new password must be supplied before Microsoft Access will open 
it. 
 
Microsoft Access stores the database password in an unencrypted form. If this will 
compromise the security of the password-protected database, you should not use a 



 

 
 

database password to protect the database. Instead, you should define user-level 
security to control access to sensitive data in that database.  
 
EEnnccrryypptt  oorr  ddeeccrryypptt  aa  ddaattaabbaassee  
Encrypting a database compacts the database file, and makes it indecipherable by a 
utility program or word processor. Decrypting a database reverses the encryption.  

1. Start Microsoft Access without opening a database.  

Important   You can't encrypt or decrypt a database when it is open. In a 
multiuser environment, the encrypt or decrypt operation fails if another user has 
the database open.  

2. On the Tools menu, point to Security, and then click Encrypt/Decrypt 
Database. 

3. Specify the database you want to encrypt or decrypt, and then click OK. 

4. Specify a name, drive, and folder for the encrypted or decrypted database; and 
then click OK.  

If you use the same name, drive, and folder as the original database, and the 
database is encrypted or decrypted successfully, Microsoft Access automatically 
replaces the original file with the encrypted or decrypted version. If an error 
occurs, Microsoft Access doesn't delete the original file.  

Notes  

• If user-level security has been defined, to encrypt or decrypt a database, you 
must either be the owner of the database or a member of the Admins group and 
have Open Exclusive permission on the database. Otherwise, the encrypt or 
decrypt operation fails. 

• If an object in a version 1.x database includes the backquote character (`) in its 
object name, you won't be able to encrypt the database. Use Microsoft Access 
version 1.x to rename it, and then change the references to that object in your 
queries, forms, reports, macros, and Access Basic code. 

• Encrypting a database doesn't restrict access to objects. For more information on 

other security methods, click .  

• The encrypt or decrypt operation fails if you don't have enough storage space on 
your disk for both the original and encrypted or decrypted versions of the 
database.  

 



 

 
 

SSeeccuurree  aa  ddaattaabbaassee  uussiinngg  tthhee  UUsseerr--LLeevveell  SSeeccuurriittyy  WWiizzaarrdd  
By using the User-Level Security Wizard, you can apply user-level security with a 
commonly-used security scheme and encrypt your Microsoft Access database.  

1. Open the database that you want to secure. 

2. On the Tools menu, click Security, and then click User-Level Security Wizard. 

3. Follow the directions in the wizard dialog boxes.  

Notes  

• The User-Level Security Wizard creates a back-up copy of the current Access 
database with the same name and a .bak extension, and then secures the 
selected objects in the current database. 

• If your current Access database protects Visual Basic for Applications (VBA) 
code with a password, the wizard prompts you for the password, which you must 
enter or the wizard doesn't complete successfully. 

• Any passwords that you create though the wizard are printed in the User-Level 
Security Wizard report when you finish using the wizard. You should keep this 
report in a secure location. You can also use this report to re-create your 
workgroup file.  

 
SSeeccuurree  aa  ddaattaabbaassee  wwiitthhoouutt  rreeqquuiirriinngg  uusseerrss  ttoo  lloogg  oonn  

1. Secure your database by using the User-Level Security Wizard.  
2. For each table, query, form, report, and macro you want to be available to users, 

grant the appropriate permissions to the Admin user account.  
3. Turn off the Logon dialog box.  

When users start Microsoft Access and open a database without logging on, Microsoft 
Access automatically logs them on under the Admin user account. As a result, they will 
have only the permissions granted in step 2. This works for any workgroup, because the 
Admin account is the same in every workgroup information file. Only the administrator 
user account and any other members of the Admins group of the workgroup information 
file that was current when you ran the wizard in step 1 will have full permissions on your 
database's tables, queries, forms, reports, and macros. 
 
To perform administrative functions, you can either reactivate the logon procedure and 
log on as a member of the Admins group, or you can use the /pwd and /user 
command-line options to specify your password and user name when starting Microsoft 
Access.  
 



 

 
 

RReemmoovvee  uusseerr--lleevveell  sseeccuurriittyy  
This procedure requires a two-stage process. First, you log on as a workgroup 
administrator and give the Users group permissions on all tables, queries, forms, 
reports, and macros. Next you return ownership of the database and these objects to 
the default Admin user by exiting and logging on as Admin, creating a blank database, 
and then importing all of the objects from the original database into the new database.  

1. Start Microsoft Access. 

2. Open the database. 

3. Log on as a workgroup administrator (a member of the Admins group). 

4. Give the Users group full permissions on all tables, queries, forms, reports, and 
macros in the database.  

5. Exit and restart Microsoft Access, open a database, and then log on as Admin. 

6. Create a new blank database, and leave it open. 

7. Import all the objects from the original database into the new database.  
8. If users will be using the current workgroup information file when opening the 

database, you need to clear the password for Admin to turn off the Logon dialog 
box for the current workgroup. This is not necessary if users will be using the 
default workgroup information file created when installing Microsoft Access.  

The new database is now completely unsecured. Anyone who can open the new 
database has full permissions on all the tables, queries, forms, reports, and macros in it. 
These permissions work for any workgroup because the Admin account is the same in 
every workgroup information file. The workgroup information file that was current when 
the new database was created in step 6 defines the Admins group for the new 
database. 
 



 

 
 

SShhoorrttccuutt  KKeeyyss  
GGeenneerraall  sshhoorrttccuutt  kkeeyyss  
UUssee  gglloobbaall  MMiiccrroossoofftt  AAcccceessss  sshhoorrttccuutt  kkeeyyss  

Press Displaying Help 

F1 To display the Office Assistant and Microsoft Access Help; context-
sensitive Help about the selected property, control, macro action, or 

Visual Basic keyword; or alerts with a Help button 

SHIFT+F1 To display ScreenTips; after pressing SHIFT+F1, move the pointer 
to the menu command, toolbar button, or screen region, and then 

click the mouse 

SHIFT+F1 To display ScreenTips in a dialog box, after selecting the option by 
using the keyboard 

 

Press Opening databases 

CTRL+N To open a new database 

CTRL+O To open an existing database 

 

Press Printing and saving 

CTRL+P To print the current or selected object 

CTRL+S or SHIFT+F12 or 
ALT+SHIFT+F2 

To save a database object 

F12 or ALT+F2 To open the Save As dialog box 

 

Press Using a combo box or list box 

F4 or ALT+DOWN ARROW To open a combo box 

F9 To refresh the contents of a Lookup field list box or combo 
box 

DOWN ARROW To move down one line 

PAGE DOWN To move down one page 



 

 
 

UP ARROW To move up one line 

PAGE UP To move up one page 

TAB To exit the combo box or list box 

 

Press Finding and replacing text or data 

CTRL+F To open the Find tab in the Find and Replace dialog box 
(Datasheet view and Form view only) 

CTRL+H To open the Replace tab in the Find and Replace dialog box 
(Datasheet view and Form view only) 

SHIFT+F4 To find the next occurrence of the text specified in the Find and 
Replace dialog box when the dialog box is closed (Datasheet view 

and Form view only) 

 

Press Working in Design view 

F2 To switch between Edit mode (with insertion point displayed) and 
Navigation mode 

F5 To switch to Form view from form Design view 

F6 To switch between the upper and lower portions of a window 
(Design view of tables, macros, and queries and the Advanced 

Filter/Sort window only) 

 

Press Editing controls in form and report Design view 

SHIFT+ENTER To add a control to a section 

How to place a text box or another control on a form or 
report by using the keyboard 

How to copy a text box or another control on a form or report 
by using the keyboard 

CTRL+C To copy the selected control to the Clipboard 

CTRL+X To cut the selected control and copy it to the Clipboard 

CTRL+V To paste the contents of the Clipboard in the upper-left 
corner of the selected section 



 

 
 

CTRL+RIGHT ARROW To move the selected control to the right 

CTRL+LEFT ARROW To move the selected control to the left 

CTRL+UP ARROW To move the selected control up 

CTRL+DOWN ARROW To move the selected control down 

SHIFT+DOWN ARROW To increase the height of the selected control 

SHIFT+RIGHT ARROW To increase the width of the selected control 

SHIFT+UP ARROW To reduce the height of the selected control 

SHIFT+LEFT ARROW To reduce the width of the selected control 

 

Press Window operations 

F11 or ALT+F1 To bring the Database window to the front 

CTRL+F6 To cycle between open windows 

ENTER To restore the selected minimized window when all windows 
are minimized 

CTRL+F8 To turn on Resize mode for the active window when it’s not 
maximized; press the arrow keys to resize the window 

ALT+SPACEBAR To display the Control menu 

SHIFT+F10 To display the shortcut menu 

CTRL+W or CTRL+F4 To close the active window 

ALT+F11 To switch between the Visual Basic Editor and the previous 
active window 

ALT+SHIFT+F11 To switch between the Microsoft Script Editor and the 
previous active window 

 

Press Miscellaneous 

F2 To display the complete hyperlink address for a selected 
hyperlink 

F7 To check spelling 

SHIFT+F2 To open the Zoom box to conveniently enter expressions



 

 
 

and other text in small input areas 

ALT+ENTER To display a property sheet in Design view 

ALT+F4 To quit Microsoft Access, close a dialog box, or close a 
property sheet 

CTRL+F2 To invoke a Builder 

CTRL+F11 To toggle between a custom menu bar and a built-in menu 
bar 

 
 

UUssee  sshhoorrttccuutt  kkeeyyss  iinn  tthhee  DDaattaabbaassee  wwiinnddooww  
Press Editing and navigating the Object list 

F2 To rename a selected object 

DOWN ARROW To move down one line 

PAGE DOWN To move down one window 

END To move to the last object 

UP ARROW To move up one line 

PAGE UP To move up one window 

HOME To move to the first object 

 

Press Navigating and opening objects 

CTRL+TAB To cycle through the Objects bar top to bottom 

SHIFT+CTRL+TAB To cycle through the Objects bar bottom to top 

ENTER or ALT+O To open the selected table or query in Datasheet 
view, or form in Form view 

ENTER To open the selected report in Print Preview 

ENTER To open the selected data access page in Page 
view 

ENTER To run the selected macro 

CTRL+ENTER or ALT+D To open the selected table, query, form, report, data 
access page, macro, or module in Design view 



 

 
 

ALT+N To create a new table, query, form, report, data 
access page, macro, or module 

F5 To refresh the Database window 

CTRL+G To display the Immediate window in the Visual Basic 
Editor 

 
 

  UUssee  sshhoorrttccuutt  kkeeyyss  ttoo  sseelleecctt  tteexxtt  oorr  ddaattaa  
Press Selecting text in a field 

SHIFT+RIGHT ARROW To extend one character to the right 

CTRL+SHIFT+RIGHT 
ARROW 

To extend one word to the right 

SHIFT+LEFT ARROW To extend one character to the left 

CTRL+SHIFT+LEFT 
ARROW 

To extend one word to the left 

 
Note   To cancel a selection, use the opposite arrow key. 

Press Selecting a field or record 

TAB To select the next field 

F2 To switch between Edit mode (with insertion 
point displayed) and Navigation mode 

SHIFT+SPACEBAR To switch between selecting the current record 
and the first field of the current record, in 

Navigation mode 

SHIFT+UP ARROW To extend selection to the previous record, if the 
current record is selected 

SHIFT+DOWN ARROW To extend selection to the next record, if the 
current record is selected 

CTRL+A or 
CTRL+SHIFT+SPACEBAR 

To select all records 

 

Press Extending a selection 

F8 To turn on Extend mode (EXT appears in the



 

 
 

lower-right corner of the window); pressing F8 
repeatedly extends the selection to the word, the 
field, the record (in Datasheet view only), and all 

records 

LEFT ARROW or RIGHT ARROW To extend a selection to adjacent fields in the 
same row in Datasheet view 

UP ARROW or DOWN ARROW To extend a selection to adjacent rows in 
Datasheet view 

SHIFT+F8 To undo the previous extension 

ESC To cancel Extend mode 

 

Press Selecting and moving a column in Datasheet view 

CTRL+SPACEBAR To select the current column or cancel the column selection, in 
Navigation mode only 

SHIFT+RIGHT 
ARROW 

To select the column to the right, if the current column is 
selected 

SHIFT+LEFT ARROW To select the column to the left, if the current column is 
selected 

CTRL+SHIFT+F8 To turn on Move mode; then press the RIGHT ARROW or 
LEFT ARROW key to move selected column(s) to the right or 

left 

Learn about rearranging columns 

 
 

  UUssee  sshhoorrttccuutt  kkeeyyss  ttoo  eeddiitt  tteexxtt  oorr  ddaattaa  
Note   If the insertion point isn't visible, press F2 to display it. 

Press Moving the insertion point in a field 

RIGHT ARROW To move it one character to the right 

CTRL+RIGHT 
ARROW 

To move it one word to the right 

LEFT ARROW To move it one character to the left 

CTRL+LEFT ARROW To move it one word to the left 

END To move it to the end of the field, in single-line fields 



 

 
 

CTRL+END To move it to the end of the field, in multiple-line fields 

HOME To move it to the beginning of the field, in single-line fields 

CTRL+HOME To move it to the beginning of the field, in multiple-line fields 

 

Press Copying, moving, or deleting text 

CTRL+C To copy the selection to the Clipboard 

CTRL+X To cut the selection and copy it to the Clipboard 

CTRL+V To paste the contents of the Clipboard at the insertion point 

BACKSPACE To delete the selection or the character to the left of the 
insertion point 

DELETE To delete the selection or the character to the right of the 
insertion point 

CTRL+DELETE To delete all characters to the right of the insertion point 

 

Press Undoing changes 

CTRL+Z or 
ALT+BACKSPACE 

To undo typing 

ESC To undo changes in the current field or current record; if 
both have been changed, press ESC twice to undo 

changes, first in the current field and then in the current 
record 

 

Press Entering data in Datasheet or Form view 

CTRL+SEMICOLON (;) To insert the current date 

CTRL+COLON (:) To insert the current time 

CTRL+ALT+SPACEBAR To insert the default value for a field 

CTRL+APOSTROPHE (') To insert the value from the same field in the previous 
record 

CTRL+PLUS SIGN (+) To add a new record 

CTRL+MINUS SIGN (-) To delete the current record 



 

 
 

SHIFT+ENTER To save changes to the current record 

SPACEBAR To switch between the values in a check box or option 
button 

CTRL+ENTER To insert a new line 

 

Press Refreshing fields with current data 

F9 To recalculate the fields in the window 

SHIFT+F9 To requery the underlying tables; in a subform, this requeries 
the underlying table for the subform only 

F9 Refresh the contents of a Lookup field list box or combo box 

 
UUssee  sshhoorrttccuutt  kkeeyyss  ttoo  nnaavviiggaattee  iinn  DDaattaasshheeeett  vviieeww  

Press Going to a specific record 

F5 To move to the record number box; then type the record 
number and press ENTER 

 

Press Navigating between fields and records 

TAB or RIGHT ARROW To move to the next field 

END To move to the last field in the current record, in 
Navigation mode 

SHIFT+TAB, or LEFT 
ARROW 

To move to the previous field 

HOME To move to the first field in the current record, in 
Navigation mode 

DOWN ARROW To move to the current field in the next record 

CTRL+DOWN ARROW To move to the current field in the last record, in 
Navigation mode 

CTRL+END To move to the last field in the last record, in Navigation 
mode 

UP ARROW To move to the current field in the previous record 

CTRL+UP ARROW To move to the current field in the first record in

 



 

 
 

Navigation mode 

CTRL+HOME To move to the first field in the first record, in Navigation 
mode 

 

Press Navigating to another screen of data 

PAGE DOWN To go down one screen 

PAGE UP To go up one screen 

CTRL+PAGE DOWN To go right one screen 

CTRL+PAGE UP To go left one screen 

 
  UUssee  sshhoorrttccuutt  kkeeyyss  ttoo  nnaavviiggaattee  iinn  FFoorrmm  vviieeww  

Press Going to a specific record 

F5 To move to the record number box; then type the record number 
and press ENTER 

 

Press Navigating between fields and records 

TAB To move to the next field 

SHIFT+TAB To move to the previous field 

END To move to the last field in the current record, in 
Navigation mode 

CTRL+END To move to the last field in the last record, in Navigation 
mode 

HOME To move to the first field in the current record, in 
Navigation mode 

CTRL+HOME To move to the first field in the first record, in Navigation 
mode 

CTRL+PAGE DOWN To move to the current field in the next record 

CTRL+PAGE UP To move to the current field in the previous record 

 

Press Navigating in forms with more than one page 



 

 
 

PAGE DOWN To go down one page; at the end of the record, moves to 
the equivalent page on the next record 

PAGE UP To go up one page; at the end of the record, moves to 
the equivalent page on the previous record 

 

Press Navigating between the main form and subform 

TAB To enter the subform from the preceding field in the main 
form 

SHIFT+TAB To enter the subform from the following field in the main 
form 

CTRL+TAB To exit the subform and move to the next field in the 
master form or next record 

CTRL+SHIFT+TAB To exit the subform and move to the previous field in the 
main form or previous record 

 
 

  UUssee  sshhoorrttccuutt  kkeeyyss  iinn  PPrriinntt  PPrreevviieeww  aanndd  LLaayyoouutt  PPrreevviieeww  
Press Dialog box and window operations 

P or CTRL+P To open the Print dialog box 

S To open the Page Setup dialog box 

Z To zoom in or out on a part of the page 

C or ESC To cancel Print Preview or Layout Preview 

 

Press Viewing different pages 

F5 To move to the page number box; then type the page 
number and press ENTER 

PAGE DOWN or DOWN 
ARROW 

To view the next page (when Fit To Window is 
selected) 

PAGE UP or UP ARROW To view the previous page (when Fit To Window is 
selected) 

 

Press Navigating in Print and Layout Preview 



 

 
 

DOWN ARROW To scroll down in small increments 

PAGE DOWN To scroll down one full screen 

CTRL+DOWN ARROW To move to the bottom of the page 

UP ARROW To scroll up in small increments 

PAGE UP To scroll up one full screen 

CTRL+UP ARROW To move to the top of the page 

RIGHT ARROW To scroll to the right in small increments 

END or CTRL+RIGHT ARROW To move to the right edge of the page 

CTRL+END To move to the lower-right corner of the page 

LEFT ARROW To scroll to the left in small increments 

HOME or CTRL+LEFT ARROW To move to the left edge of the page 

CTRL+HOME To move to the upper-left corner of the page 

 
 

  NNaavviiggaattiinngg  iinn  tthhee  QQuueerryy  DDeessiiggnneerr  
You can work in the Query Designer using the keyboard or the mouse. Refer to the 
following tables for specific methods. 

AAnnyy  PPaannee  
To Press Click 

Move among the Query 
Designer panes 

F6, SHIFT+F6 Anywhere in the target pane 

 
DDiiaaggrraamm  PPaannee  

To Press Click 

Move between input source 
windows (and to join lines, if 

available) 

TAB, 
SHIFT+TAB 

The input source window or join 
line to move to 

Move between columns in an 
input source window 

Arrow keys The column to go to 

Choose the selected data 
column for output 

SPACEBAR1 or 
PLUS key 

The check box next to the name of 
the column 



 

 
 

Remove the selected data 
column from the query output 

SPACEBAR1 or 
MINUS key 

The check box next to the name of 
the column 

Remove the selected input 
source or join line from the 

query 

DELETE Right-click, and then choose 
Remove 

 
1If multiple items are selected, pressing this key affects all selected items. Select 
multiple items by holding down the SHIFT key while clicking them. Toggle the selected 
state of a single item by holding down CTRL while clicking it. 

GGrriidd  PPaannee  
To Press Click 

Move among cells Arrow keys or TAB 
or SHIFT+TAB 

The target cell 

Move to the last row in the 
current column 

CTRL+DOWN 
ARROW 

 

Move to the first row in the 
current column 

CTRL+UP 
ARROW 

 

Move to the first position in 
the current cell or the first 
column in the input source 

window 

CTRL+HOME  

Move to the last position in 
the current cell or the last 
column in the input source 

window 

CTRL+END  

Move in a drop-down list UP ARROW or 
DOWN ARROW 

The button in the cell 

Select an entire grid column CTRL+SPACEBAR The column header 

Select an entire grid row  The button to the left of the row 

Toggle between edit mode 
and cell selection mode 

F2  

Copy selected text in cell to 
the Clipboard (in edit mode) 

CTRL+C  

Cut selected text in cell and 
place it on the Clipboard (in

CTRL+X  



 

 
 

edit mode) 

Paste text from the Clipboard 
(in edit mode) 

CTRL+V  

Toggle between insert and 
overstrike mode while editing 

in a cell 

INS  

Toggle the check box in the 
Output column 

SPACEBAR1 The check box 

Clear the selected contents of 
a cell 

DELETE  

Remove row containing 
selected data column from 

the query 

DELETE1  

Clear all values for a selected 
grid column 

DELETE  

Insert row between existing 
rows 

INS after you 
select grid row 

 

Add an Or … column INS after you 
select any Or ... 

column 

 

 
1If multiple items are selected, pressing this key affects all selected items. 

SSQQLL  PPaannee  
You can use the standard Windows editing keys when working in the SQL pane, such 
as CTRL+Arrow keys to move between words, and the Cut, Copy, and Paste 
commands on the Edit menu. 
Note   You can only insert text; there is no overstrike mode. 
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